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System Maintenance

This guide tells administrators how to manage hosts and services in the network, maintain and monitor

the network, run jobs, and tune performance after initial network setup.

The following diagram shows the different system maintenance tasks available to you.

Monitor Manage NW Review Maintain
Review best health of NW queries used Configure Change Host
practices Platform host for FIPS Support |IP Addresses
system investigation

Platform system and
updates service logs

The following topics describe these tasks:

« Review Best Practices

o Monitor Health and Wellness using NetWitness Platform Ul

« Manage NetWitness Platform Updates

o Reissue Certificates

» Display System and Service Logs

o Maintain Queries Using URL Integration

o Configure FIPS Support

o Manage the deploy admin Account
o Change Host IP Addresses
o DISA STIG

o Troubleshoot NetWitness Platform

o Troubleshooting Cert-Reissue Command

Troubleshoot
NW Platform

Configure
DISA STIG
Hardening

system issues
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Review Best Practices

Review the following best practices to maintain your NetWitness Platform deployment.

Safeguarding Assets with RSA Supplied Policies

The purpose of the RSA core policies delivered with NetWitness Platform are for safeguarding your
NetWitness Platform domain assets immediately (before you configure rules specific to your
environment and your security policy).

RSA recommends that you set up email notifications to the appropriate asset owners for these policies
as soon as possible. This will notify them when performance and capacity thresholds are crossed so they
can take action immediately.

RSA also recommends that you evaluate the core policies and disable a policy or change its service and
group assignments according to your specific monitoring requirements.

Safeguarding Assets with Policies Based on Your

Environment
RSA core policies are generic and may not provide sufficient monitoring coverage for your environment.

RSA recommends that you gather issues over a period of time, that are not identified by the RSA core
policies, and configure rules to help you prevent these issues.

Creating Rules and Notifications Judiciously
RSA recommends that you make sure that each rule and policy is necessary before you implement it, if

possible. RSA also recommends that you review implemented policies on a regular basis for their
validity. Invalid alarms and email notifications can adversely affect the focus of the asset owners.

Troubleshooting Issues

RSA recommends that you review Troubleshooting Health & Wellness and Troubleshoot NetWitness
Platform when you receive error messages in the user interface and log files from hosts and services.

13 Review Best Practices



Monitor NetWitness Platform Health

Y ou can monitor the Health andWellness of NetWitness Platform using either of the following

procedures:

o Monitor Health and Wellness using NetWitness Platform Ul

o Monitor Health and Wellness using Kibana (BETA)

14
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Monitor Health and Wellness using NetWitness Platform Ul

The Health & Wellness module of NetWitness Platform enables you to:

o View the current health of all the hosts, all services running on the hosts, and various aspects of the
health of your hosts.

o Monitor the hosts and services in your network environment.
o View details of various event sources configured with NetWitness Platform.

o View system stats for the selected hosts by filtering the views as required.

You can also configure Archiver and Warehouse Connector monitoring, monitor host statistics, and work
with system logs to monitor NetWitness Platform.

Note: All users have permission to view the entire Health and Wellness interface by default. The
Administrator and the Operator roles are the only roles that can manage the Policies view by default.
Refer to the "Role Permissions" topic in the Security User Management Guide for a complete list of
the default permissions for the NetWitness Platform Interface.

The following figure displays the Health & Wellness module of the NetWitness Platform user interface.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN L:\:Dadmin v

Event Sources Endpoint Sources  Health & Wellness e Security

Alarms Monitoring Policies System Stats Browser  Event Source Monitoring Settings

2018-02-01 06:01:20 PM Active @ High Communication Failure Between Master NetWitn...  Host 11154 10.25.66.54 MessageBus/Communication Link Status wit

O 1ime State Severity | Rule Name Service Hostname 1P Address St E
[0 2019-02-01 05:45 Active @ Critical  Respond Server in Critical State Respond Server 1154 10.25.66.54 Processinfo/Overall Proces 3
O 2019-02:01 01 Active @ Critical  Log Decoder Log Capture Pool Depleted Log Decoder 113601 10.25.66.46 Pool/Packet Capture Queue E
O 2013-02:01 01 Active @ Critical  Log Decoder Capture Rate Zero Log Decoder 113EP1 10.25.66.46 Capture/Capture Packet Rate [current) =
O 2019-02:01 01 Active @ Criticel  Log Decoder Capture Not Started Log Decoder 113€P1 10.25.66.46 Capture/Capture Status

O 2019-02:01 01 Active @ Critical  Concentrator Meta Rate Zero Concentrator 113601 10.25.66.46 Concentrator/Meta Rate (current]

0 2019-02:01 01 Actve @ Cruical  Cancentrator Aggregation Stapped Concentrator 113EP1 10.25.66.46 Concentrator/Status

1 2019-01-31 08 Active @ Critical  Concentrator Aggregation Stopped Concentrator 111Conc 10.25.66.3¢ Concentrator/Status

O 2015-01-31 07:04:57 Active @ Critical  Decoder Capture Rate Zero Decoder 111Decoder 10.25.66.32 Capture/Capture Packet Rate [current)

[0 2019-01-31 07:04:07 Active @ Critical  Decader Capture Not Started Decoder 111Decoder 10.2566.32 Capture/Capture Status

O 2019-01-31 07: Active @ Critical  Decoder Packet Capture Pool Depleted Decoder 111Decoder 10.25.66.32 Pool/Packet Capture Queue \

O 2015-01-31 07: Active @ Critical  Broker Aggregation Stopped Broker 11154 10.25.66.54 Broker/Status

[0 2019-01-31 07: Active @ Criticsl  Concentrator Meta Rate Zero Concentrator 111CoreHybr 10.25.66.44 Concentrator/Meta Rate (current)

O 2019-01-31 07 Active @ Critical  Concentrator Aggregation Stopped Concentrator 111CoreHybr 10.25.66.44 Concentrator/Status

[1 20190131 07:03:58 PM  Active @ Critical  Concentrator Meta Rate Zero Cancentrater 111Conc 10.2566.34 Concentrator/Meta Rate (current]

O 20190131 06:20:45PM  Active @ Critical  Log Decoder Capture Rate Zero Log Decoder 111CoreHybr 10.25.66.44 Capture/Capture Packet Rate [current)

[0 2013-01-31 06:20:45PM  Active @ Critical  Log Decoder Capture Not Started Log Decoder 111CoreHybr 10.25.66.44 Capture/Capture Status

[0 20190131 06:20:45PM  Active @ Critical  Log Decoder Log Capture Pool Depleted Log Decoder 111CoreHybr 10.25.66.44 Poal/Packet Capture Queue

O

»

| Page 1 of2 | 3 M| C ™ autoRrefresh Items 1-50 of 55
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Manage Policies

Policies are either user-defined or supplied by RSA. A policy defines:
o Services and hosts to which the policy applies.

o Rules that specify statistical thresholds that govern alarms.

« When to suppress the policy.

o Who to notify when an alarm triggers and when to notify them.

For related reference topics, see NetWitness Platform Out-of-the-Box Policies

Note: You can now configure a policy to notify Public Key Infrastructure (PKI) certificate
expiration status.

Add a Policy
1. Goto ADMIN > Health & Wellness.
2. Click the Policies tab.

The Policies view is displayed.

RSA RESPOND  INVESTIGATE MONITOR CONFIGURE ADMIN

Hosts S e Event Sources  Endpoint Sources  Health lIn Security

Marms  Monitoring IS System Stats Browser  Event Source Monitoring  Settings

Policies Admin Server: Admin Server Monitoring Policy save
+ ZB® 3y Rules and suppression schedules of Out-of the-box policies cannot be directly madified. Duplicate the policy if you wish to S modify them
[ Enable Last Modified: 2017-02-20 12:00:00 AM
45 Admin Server 5 -
Admin Server Monitoring Policy Services
» D Archiver o Choose the hosts, services, and groups that your health policy apalies to.
» [ Broker [ +
» [] Cloud Gateway Server [} Name ~ Sroup Type
o o 3
» [ Concentrator o Al Group
» [ Config Server ] Rules
» [ Content Server [} Define the cenditions Under WNIch you wank 5o trigger an alarm far the NesWitness Platiarm health preblems (definition includes severfty, Statstic the alarm 2pplies to, thresnald, and tnreshald at wnich tne alarm clears).
After you define the alarm rule, enable or dissble the slarm
» [ Contexthub Server ]
» [ Decoder o .
[ Enable  Name ~ Severity category Statistic Threshold
» [ EsA Correlation
o o Admin Server in Critl...  Critical Processinfo Alarm = ERROR for 2 MINUTES
» [ Entity Behavi - -
[ entity Behavi (] Adm rinUnn..  High Processinfa Alarm = PARTIALLY_WORKING for 2 MINUTES
» [ Event Stream Analysis (1] o Admin Server Stopped  Critical Processinfo Alarm |= started for 0 MINUTES -
° Policy Suppression
Define the time periads to suppress policies
» [ Log Collector )
o Days Time Range
» [ Log Decoder
o - Policy suppression is not allowed ..

[RS/\ NETWITNESS" PLATFORM 11300

3. Click + - in the Policies panel.
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A list of your hosts and services displays for which you can create health policies.

4. Select a host or service (for example, Concentrator).
For a PKI policy, you must select a host (for example, Host).
The host or service is displayed in the Policies panel with a blank Policy Detail panel.
Policies
+o =21 ® X
» CJ Archiver Q
¥ [JEroker (1)
4 {3 Concentrator o
@ 5A Concentrator Monitoring Policy
ol
5. Enter a name for the Policy (for example, Concentrator Policy Status) in the Policies panel.
Policies
+o -1 ® X
b [ Archiver (1]
» [ Eroker (1)
4 Concentrator o
@ 54 Concentrater Monitoring Policy
O|Concentrator Policy Status|
The name (for example, Concentrator Policy Status) is now displayed as the policy name in
Policy Detail panel.
6. Create a Policy in the Policy Detail panel:
a. Select the Enable checkbox.
b. Add relevant services (in this example, any relevant Concentrator services) that you want to
monitor for health statistics.
For a PKI policy, you must select the LOCALHOST to monitor for health statistics.
c. Add rule conditions to configure the policy.
d. Suppress enforcement of the policy for the time periods you want.
e. Add any email notifications you want for the policy.
f. Click Save in the Policy Detail panel.
The Policy is added.
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Add Policy Example

Below is a high-level example of configuring a PKI policy:
1. Add a new PKI policy.

RSA RESPOND  INVESTIGATE MONITOR CONFIGURE ADMIN

Hosts Services EwventSources Endpoint Sources Health & Wellness  System  Security

Alarms  Monitoring [JEEGIISEONE  System Stats Browser  Event Source Monitoring  Settings

Policies Host: SA PKI

7 B <z ™ Enable st Modifi -05-04 03:51:
o -Z I B Y [ Enable Last Modified: 2016-05-0403:51:14 PM
» [ Archiver © | | Hoste
» g Broker © | Choose the hosts, services, and groups that your health policy applies to
» [ Cancentrator o +-
» [ Context Hub ©® O name~ Group Type
» (D Decoder () O LOcALHOST Host
» D bvencsuh Analysis o
Rules
4G Host 2]

Define the conditi
the alarm rule,

inder which yo
or disable the

/ant to trigger an alarm for the Netwitness Platform health problems (definition includes severity, statistic the alarm applies to, threshold, and threshold at which the alarm clears). After you define

» [ Warehouse Cannector
Click on + to add suppression to policy

SA PKI + -
» [71PD8 Extractor © & Enavie| Name Severity Category Statistic Threshold
» [T Incident Manageman: 0 ¥ Alert When a CRL Expi... Critical PKI SA Server PKI CRL Expiration Alarm <= 0 for 0 MINUTES
» [Log Collector ()
Policy Suppression
» [ Log Decoder () v Supp
Define the time periods to suppress policies.
» O] Malware Analysis )
+ TimeZone: | UTC (GMT+00:00) v
» [ Reporting Engine o
O oays Time Range
o
o

» O3 Workbench

Notification

2. Add a Rule with Statistics:

o For CA Expiration

Add Rule

Enable ™

Name Trusted CA Certificate Expiry Time

Description

Severity High v

PKI ~ | | SA Server PKI Certificate Expiration ~ | TRUSTED_CA ~

== w2400 For |0 £ Minutes

> v 2400 For Minutes

Time Zone: UTC {GMT+00:00)

Click on + to add suppression to rule

Cancel Save

o For CRL Expiration

Monitor NetWitness Platform Health 18



System Maintenance Guide

Add Rule

4
CRL Expiration Based On Time

Description

Severity High v

PKI ~ | | 5A Server PKI CRL Expiration v
<= w2400 For |0 £ Minutes
= w0 For |1 < Minutes L\\:

Time Zone: UTC {GMT+00:00)

Time Range

Click on + to add suppression to rule

Cancel Save

o For CRL Status

Add Rule

™~
CRL Status
Description
Severity High v
PKI ~ | | 5A Server PKI CRL Status b
= ~  Walid For |0 £ Minutes
= ~  Walid For |1 & Minutes

Time Zone: UTC {GMT+00:00)

Click on + to add suppression to rule

Cancel Save

o For Server Certificate Expiration
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Add Rule

¥
me |Se|‘ver|Cer‘ti"'cate Expiry Time |
Description
Severity High v

PKI ~ | SA Server PKI Certificate Expiration ~ | SERVER_CERT ~

o= w2400 For [0 £ Minutes

= w2400 For |1 < Minutes

Time Zone: UTC (GMT+00:00)

Click on + to add suppression to rule

Cancel Save

Edit a Policy

1. Goto ADMIN > Health & Wellness.
2. Click the Policies tab.
The Policies view is displayed.
3. Select a policy (for example, Concentrator Policy Status) under a host or service.

The Policy Detail is displayed.

4. Click Z

The policy name (for example, Admin Server Monitoring Policy) and policy detail
panel become editable.
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RSA RESPOND

Hosts

Services

Aarms  Monitoring [

Policies Admin Server: Admin Server Monitoring Policy Save
+ Z18 3 Rules and suppression schedules of Qui-of-the-box policies cannot be directly medified. Duplicate the policy if you wish to so modify them
& Enable st Modified: 2017-02-20 12:00:00 AM
DSy ° E Last Modified:
Admin Server Monitoring Policy Services

INVESTIGATE

System Stats Browser  Event Source Monitoring

MONITOR

Event Sources

CONFIGURE  ADMIN

Health liness

Endpoint Sources

Security

Settings

» [ archiver o Choose the hosts, services, and groups that your health policy eppiies to.
» [ Broker [ +
* [] Cloud Gateway Server [1] Name Group Type
» [ Concentrator o Al i Group
» [ Config Server o Rules
» [ Content Server [ Define the conditions und trigger an alerm for the NetWitness Platform health problems (definition includes severity, statisic the alarm applies o, threshold, and threshold at which the alerm clears).
After you define the olarm < the alarm
» [ Contextnub Server (1]
» [ Decoder (1]
O engble | Name~ severity category Statistie Threshold
» [ ESA Correlation
o =} Admin Server inCriti..  Critical Processinfo Alarm = ERROR for 2 MINUTES
» DI vior Analytics - -
[ Eneiy Behavi Iyt 1] rinUnn..  High Processinfo Alarm = PARTIALLY WORKING for 2 MINUTES
» DY Bvent Scresm Analysis (1] =} Admin Server Stopped  Critical Processinfo Alarm l= started for 0 MINUTES -
» [ Host ]
Nar Policy Suppression
ntes
o Define the time pericds to suppress policies
» [JInvestigate Server ]
» [ Log Collector o
o Days Time Range
» [ Log Decoder
o - Policy suppression is not allowed <

5. Make the required changes and click Save in the Policy Detail panel. You can:
« Edit the policy name.
o Enable or disable the policy.
o Add or delete hosts and services in the policy.
o Add, delete or modify rules in the policy.
o Add, edit, or delete suppressions in the policy.

o Add, edit, or delete notifications in the policy.

Note: Save applies the policy rules based on the selection of enable or disable. It also resets the
rule condition timers for changed rules, and the entire policy.

Duplicate a Policy

1. Goto ADMIN > Health & Wellness.
2. Click the Policies tab.

3. Select a policy (for example, Concentrator Monitoring Policy) under a host or service.

4. Click & .NetWitness Platform copies the policy and lists it with (1) appended to the original
policy name.
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RSA| RESPOND  INVESTIGATE MONITOR CONFIGURE ADMIN () admin

Hosts  Sel Event Sources  Endpoint Sources  Healt Vellness  System  Security

Marms  Monitoring [CIUEECNN System Stats Browser  Event Source Monitoring  Settings

Policies Concentrator: Concentrator Monitoring Policy(1)
+o =183 O Enable Last Modified: 2019-03-06 10:24:10 PM
> Eygmin server o services

¥ [ Archiver [1] Choose the hosts, services, and groups that your health policy applies ta.

» Dasoer ol |+

» [ Cloud Gateway Server o = £y TyRe

B - ) Click on + to add assignment to policy

Con

Rules

Concentrator Menitoring Polic... Sefine the conditions under wh

ich you want to trigger an slarm for the NetWitness Platform health problems {definition includes severity, statistic the alarm spplies to, threshold, and threshold at which the slarm clears).

» [ Config Server o After you define the alarm rule, enable or dissble the alarm
» [ Content Server o +
» [ Contexthub Sarver ) [ nable Name ~ Severity Category Statlstic Threshold
» [ Decoer ° o Concentrator »5Pen...  Medium Concentrator Queries Pending Alarm
a - Medium Devices Sessions Benind Alarm >
» [ EsA Correlation [1]
o High Devices Sessions Benind Alarm
» [ Enity Behar -
Y L] . Crical Devices Sessions Benind Aarm >
o o Critical Aarm l=
[1] o . Crical Alarm i=
) o High Rule Error Count Harm >
) a Critical Concentrater Meta Rate (current) Alarm =
o High Devices Aarm l=
» [ Log Collector ) &
. |O ator Service... Crical Processinfo Service State Aarm 1= ‘started’ rezdy for 0 MINUTES .
NN -
R'S/\ NETWITNESS PLATFORM 11300

—

5. Click Iilﬁ and rename the Policy [for example, rename Concentrator Monitoring Policy(1)] to
New Concentrator Policy.

Note: A duplicated policy is disabled by default and the host and service assignments are
not duplicated. Assign any relevant hosts and services to the duplicated policy before you
use it to monitor health and wellness of the NetWitness Platform infrastructure.

Assign Services or Groups
To assign hosts or services to a policy:
1. Goto ADMIN > Health & Wellness.
2. Click the Policies tab.
The Policies view is displayed.
3. Select a policy (for example, First Policy) under a host or service.

The Policy Detail view is displayed.

4. Click + in the Services and Groups list toolbar.
5. Choose one of the following actions:
o For hosts, select Groups or Hosts from the selection menu.

o For services, select Groups or Services from the selection menu.

6. Depending on whether you are assigning services or groups, perform one of the following
actions:
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o Groups, the Groups dialog is displayed from which you can select predefined groups of hosts
or services.

Add Groups
Groups Services
Mame Filter *
0 & Name Host Type
Concentratar NWAPPLIAMNCEZZ2655 Concentrator

Cancel Select

o Services, the Services dialog is displayed from which you can select individual services.

Add Service
Groups Services
Mame Filter *
= Name Host Type
[l Concentrater MNWAPPLIANCEZ2655 Caoncentrator

Cancel Select
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7. Select the checkbox next to the groups or services you want to assign to the policy, click Select

in the dialog, and click Save in the Policy Detail panel.

Note: Services are filtered for selection based on the type of policies. For example, you can only
select Concentrator services for a Concentrator type of policy.

Remove Services or Groups

To remove a host or service from a policy:

1.
2.

Go to ADMIN > Health & Wellness.
Click the Policies tab.

The Policies view is displayed.

Select a policy under a service.

The Policy Detail view is displayed.
Select a host or service.

Click ~— .

The host or service is removed from the policy.

Add or Edit a Rule

To add a rule to a policy:

1.
2.

Go to ADMIN > Health & Wellness.
Click the Policies tab.

The Policies view is displayed.

. Select a policy (for example, Checkpoint) under a host or service.

The Policy Detail view is displayed.

Depending on whether you are adding or editing rule, do the following:

o To add a rule, click + in the Rules list toolbar.

o To edit a rule, select a rule from the Rules list and click d

Complete the dialog to define or update the rule.

Add a description as shown in the following example.

Monitor NetWitness Platform Health
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Add Rule

Enable “ R
Name Check Point
Description Trigger alarm when Check Point Log Collection stops

Medium v

Checkpoint Collection ~ | | Collection State v

= v | stopped For |1 $| Minutes
= v started For |1 < Minutes

Time Zone: UTC {GMT+00:00)

Time Range
™ sun Maon Tue Wed Thur Fri Sat 00:00 To 00:15

7. Click OK.
The rule is added (or updated) to the policy.

Hide or Show Rule Conditions Columns

To hide or show rule conditions columns in the Rules panel:
1. Goto ADMIN > Health & Wellness.
2. Click Policies tab.
The Policies view is displayed.
3. Select a policy under a service.
The Policy Detail view is displayed.
4. Go to the Rules panel.
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Rules
Define the conditions under which you want to trigger an alarm for the NetWitness Platform health problems (definition includes
severity, statistic the alarm applies to, threshold, and threshold at which the alarm clears). After you define the alarm rule, enable or
disable the alarm.
Enable | Name ~ Severi Categol Statistic Threshold
L] Enable ty gory ~ Swtisic  Threshold
O [ ] Concentrator...  Medium Concentrator Queries Pending Alarm >=5 for 10 MINUTES
O ® Cancentrator...  Medium Devices Sessions Behind Alarm == 100000 for 30 MINUTES
O [ ] Concentrator...  High Devices Seszions Behind Alarm == 1000000 for 30 MINUTES
O ® Concentrator...  Critical Devices Sessions Behind Alarm == 50000000 for 30 MINUTES
O ® Cancentrator...  Critical Cancentrator Status Alarm = 'started' for 0 MINUTES
O [ ] Concentrator...  Critical Database Status Alarm !="opened’ for 0 MINUTES
O [ ] Concentrator..  High Concentrator Rule Error Count Alarm =0 for 0 MINUTES
— - i x, i 1 i x, L PR = =1 Al =10 £, D RABINITOC

5. Click v to the right of Category , set Columns, and clear the Static and Threshold rule
conditions.

You can set or clear any Rules column to show or hide it.
The Rules panel displays without the rule conditions.

Delete a Rule
To remove a host or service from a policy:
1. Goto ADMIN > Health & Wellness.

2. Click the Policies tab.
The Policies view is displayed.

3. Select a policy under a service.
The Policy Detail view is displayed.

4. Select a rule from the Rules list (for example, Checkpoint).

5. Click =.
The rule is removed from the policy.

Suppress a Rule
1. Click the Policies tab.
The Policies view is displayed.

2. Select a policy under a service.
The Policy Detail view is displayed. You can specify rule suppressions time ranges when you
initially add it or you can edit the rule and specify suppression time ranges.

3. Add or edit a rule.

4. In the Rules Suppression panel of the Add or Edit Rule dialog, specify the days and time
ranges during which you want the rule suppressed.
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Suppress a Policy

1. Add or edit a policy.
The Policies view is displayed.

2. In the Policy Suppression panel:
a. Select a time zone from the Time Zone drop-down list.
This time zone applies to the entire policy (both policy suppression and rule suppression).

b. Click + in the toolbar.

c. Specify the days and time ranges during which you want the policy suppressed.

Add an Email Notification

To add an email notification to a policy:

1. Add or edit a policy.
The Policies view is displayed.

2. In the Notification panel:

a. Click + in the toolbar.
A blank EMAIL notification row is displayed.

b. Select the email:

o Notification types in the Recipient column (see "Configure Notification Outputs" in the
NetWitness Platform System Configuration Guide for the source of the values in this drop-
down list).

o Notification server in the Notification Server column (see 'Configure Notification
Servers" in the NetWitness Platform System Configuration Guide for the source of the
values in this drop-down list).

o Template server in the Template column (see "Configure Notification Templates" in
the NetWitness Platform System Configuration Guidefor the source of the values in this
drop-down list).

Note: Refer to Include the Default Email Subject Line if you want to include the
default Email subject line from the Health & Wellness template in your Health &
Wellness Email notifications for specified recipients.

Delete an Email Notification

To add an email notification to a policy:

1. Add or edit a policy.
The Policies view is displayed.
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2. In the Notification panel:
a. Select an email notification.

b. Click —.
The notification is removed.

Monitor NetWitness Platform Health
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Include the Default Email Subject Line

The emails generated by the notifications you set up for policies do not include the subject line from
the Health & Wellness Default Email Notification templates. You need to specify the subject line in
the do not include subject lines. This procedure shows you how to insert a subject line into the
templates.

For related reference topics, see Policies View and NetWitness Platform Out-of-the-Box Policies.

To include the subject line from a Health & Wellness email template in your email notification:
1. Goto ADMIN > System.
2. In the options panel, select Global Notifications.

3. Select a Health & Wellness Email Template (for example, Health & Wellness Default SMTP
Template).

RSA RESPOND  INVESTIGATE ~MONITOR CONFIGURE ADMIN @admn® ()

HOSLS SeIvices EVENT Sources ealth & Wellness Sy

e Global Notifications
Updates
Output | Servers | Templates
Licensing
Emai + ‘ & Searc
Global Notifications O Name A Template Type Description Actions
Legacy Notifications Defauks Audic CEF Templace Aud Logging Defauk Audic CEF Template &
System Logging Defautt Audit Human-Readable Format Audi Logging adable Forma i
lobal Auditing e -
SN Defaut SMITP Template Event Stream Analysis e 3
Jobs
Default SNMP Templaze Event Stream Analysis Default SNMP Templace &
Live Services
URL Integration Defaukt Script Tem, ker template for Seript notifications &
Context Menu Actions Default Syslog Templats #
Investigation
stigatio m
ESA
rce Morito &4
ESA Analytics
Whois oy *
HTTP Proxy Settings P Templa: 00 -
y
NTP Settings
Page [1 | of1 | | ¢ Pagesize 25 v Displaying 1- 12 of 12 templates

RSA NETWITNESS' PLATFORM

The Define Template dialog is displayed.

4. Click Iilg, then in the Template field, copy the Subject Line (Highlight the subject line and press
Ctrl-C) into the buffer.
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Mame * Health & Wellness Default SMTP Template

Template Type  Health Alarms

Description Health & Wellness Default SMTP Template

Template *

/f RECOMMEND: Use this line from the template as the Email Subject line
when defining Motification Type

MW Health <#if state == "ACTIVE"=%{severity?lower_case?cap_first}
Severity<#elsex${state?lower_case?cap_first}</#if> Alarm:
${ruleName!"Unknown Rule Name"} on ${hostName!"Unknown Host Name™}
—
<head=

<meta http-equiv="Content-Type" content="text/html; charset=UTF-8">

</head>
<body bgcolor="#eeeeee" leftmargin="0" topmargin="0" marginwidth="0"
marginheight="0">
<table border="0" cellpadding="0" cellspacing="0" height="100%"
width="100%" id="bodyTable">

Cancel

5. Click Cancel to close the Template.
6. Click the Output tab and select a notification (for example Health & Wellness).

7. Click z

The Define Email Notification dialog is displayed.

8. Replace the value in Subject field text box with the subject line that you have in the buffer
(highlight the existing text and press Ctl-V).
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Define Email Notification

Enable [l
Ha&W Email notification

To Email Addresses *

Subject Template Type  Health & Wellness default email subject

MW Health <#if state == "ACTIVE">${severity?lower_case?
cap_first} Severity<#else=%{state?lower_case?cap_first}</#if>
Alarm: ${ruleName!"Unknown Rule Name"} on
${hostName!"Unknown Host Name"}

9. Click Save.
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Monitor System Statistics

The System Stats Browser filters statistics by the selected host, component running on the host,
statistical category, individual statistic, or any combination of host, component, category, and
statistic. You can also choose the order in which to display this information.

To access the System Stats browser:
1. Goto ADMIN > Health & Wellness.

The Health & Wellness view is displayed with the Alarms tab open.
2. Click the System Stats Browser tab.
The System Stats Browser tab is displayed.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Hosts Services Event Sources Endpoint Sources Health & Wellness  System  Security

Alarms Monitoring Policies System Stats Browser WESUHIEGIT (NGl Settings

Host Component Category Statistic Order By

Any v Any v Any v L Clear w
[TRegex [TRegex @®ascending ODescending 2

Hast Component Category Statistic Subitem value Last Update Historical Graph E

T1ESAP Host DiskRaid Adapter Model 0 PERC H730P Mini %

TH1ESAP Host DiskRaid 0.0 Optimal

T11ESAP Host DiskRald Logical Drive State 01 Optimal

111E54P Host DiskRaid Overall Logical Drives Err 0 ]

111E54P Host DiskRaid Overall Physical D; 0 &

T11ESAP Host DiskRaid Physical Drive Pre: 0325 o ok

111ESAP Host DiskRaid Physical Drive Pre: 0322 o ok

T11ESAP Host DiskRaid Physical Drive Pre 0320 o &

111ESAP Host DiskRaid Physical Drive Pre 0321 o &

T1ESAP Host DiskRaid Physical Drive Pre 0324 o &

TH1ESAP Host DiskRaid Physical Drive Pre 0323 o &

T11ESAP Host DiskRald Physical Drive State 0321 Online, Spun Up

111E54P Host DiskRaid Physical Drive 0320 Online, Spun Up

111E54P Host DiskRaid Physical Drive S 0323 Online, Spun Up

T11ESAP Host DiskRaid Physical Drive State 0.325 Hotspare, Spun Up

111ESAP Host DiskRaid Physical Driv 0322 Online, Spun Up

T11ESAP Host DiskRaid Physical Drive State 0324 Online, Spun Up

114E8AD Uocr Eilafucsam Ercox Srare n & e

| Page |1 ofas | } NI C tems 1 - 50 of 2385
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Filter System Statistics
You can filter system statistics to monitor:
« Statistics collected for a particular host

Statistics collected for a particular component

« Statistics collected of a particular type or that belong to a certain category
« Statistics listed in an ordered way as per the selection chosen

To filter the list of system statistics:

1. Goto ADMIN > Health & Wellness.
The Health & Wellness view is displayed with the Alarms tab open.

2. Click System Stats Browser.
The System Stats Browser tab is displayed.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN @Jadmin v
Hosts ices Event Sources Endpoint Sources Health & Wellness ) Security
Alarms Monitoring Policies System Stats Browser WMSULISITGCENILTIGILT Settings

Host Component Category Statistic Order By

Any v Any v Any v Clear w
[regex [Cregex @ascending ODescending ;

Host Component Category Statistic Subitem value Last Update Historical Graph E

T11ESAP Host DiskRaid Adapter Model 0 PERC H730P Mini 2019-02-01 07:24:15 P, ;%

111E54P Host DiskRaid Logical Drive State 0.0 Optimal 2019-02-01 0

T11ESAP Host DiskRaid Logical Drive State 0.1 Optimal 2019-02-01 0

T11ESAP Host DiskRaid Overall Logical Drives Error Status o 2019-02-01 0 &

111ESAP Host DiskRaid Overall Physical Driv o 2019-02-01 0 &

T11ESAP Host DiskRaid Physical Drive Pr 0325 o 2019-02-01 07:24:15 P, &

111ESAP Host DiskRaid Physical Drive Pr 0322 o 2019-02-010° &

T1ESAP Host DiskRaid Physical Drive Pr 0320 o 2019-02-010° &

TH1ESAP Host DiskRaid Physical Drive Predict 0321 o 2019-02-01 07:24:15 P, &

T11ESAP Host DiskRaid Physical Drive Pr 0324 0 2019-02-01 07:24:15P... ol

111E54P Host DiskRaid Physical Drive Pr 0323 0 2019-02-01 0 ok

T11ESAP Host DiskRaid Physical Drive State 0.321 Online, Spun Up 2019-02-01 0

T11ESAP Host DiskRaid Physical Drive State 0.320 Online, Spun Up 2019-02-01 0 P..

111ESAP Host DiskRaid Physical Drive State 0323 Online, Spun Up 2019-02-01 0 P..

T11ESAP Host DiskRaid Physical Drive State 0325 Hotspare, Spun Up 2019-02-010 P..

111ESAP Host DiskRaid Physical Drive State 0322 Online, Spun Up 2019-02-01 0 5P..

T1ESAP Host DiskRaid Physical Drive State 0324 Online, Spun Up 2015-02-01 0 P..

114ccAn Unne EilaCuimenme Eieme Conein n AA1B A A1 ATAAAAD R e

| Page 1 of48 | » W I C Items 1 - 50 of 2385

Filter the list of system statistics in one of the following ways:

o To view system statistics for a particular host, select the host in the Host drop-down list.
The system statistics for the selected host is displayed.

o To view system statistics for a particular component, select the component in the Component
drop-down list.
The system statistics for the selected component are displayed.

o To view system statistics for a particular category, type the category name in the Category
field.
Select Regex to enable the Regex filter. It performs a regular expression search against text
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and lists the specified category. If Regex is not selected, it supports globbing pattern
matching.
The System Stats for the selected category is displayed.

o To list statistics in a preferred order, you can set the order in the OrderBy column.

o To view a particular statistic across hosts, type the statistic name in the Statistic field.
Select Regex to enable the Regex filter. It performs a regular expression search against text
and lists the specified category. If Regex is not selected it supports globbing pattern matching.
The information for the selected statistics is displayed.

The following figure shows the System Stats Browser filtered by the 111Conc host listed in
descending statistical category order.

RSA RESPOND  INVESTIGATE MONITOR CONFIGURE ADMIN @ admin
H ces Event Sources Endpoint Sources Health & Wellness tem  Security
Alarms  Monitoring  Policies [ESTENIIEISIWET  Event Source Monitoring  Settings

Host Component Category Statistic Order By

111Conc ~ | Any ~ Any v Clear v
[ [ e — =

111Conc System Manitor Collecwd MessageBusWriteModule message published 420690 i :‘%

111Conc MessageBus Mess. Unconsumed Queues Count 0 i

111Conc MessageBus M Total Mes: nacknowledged Change Rate 0 il

111Conc MessageBus M Total < Unacknowledged 0 il

111Conc MessageBus M Total s Ready Change Rate 0 il

111Conc MessageBus M Total 0 il

111Conc MessageBus M Total 0 il

111Conc MessageBus M Total 0 il

111Conc MessogeBus M Total 8665 i

111Conc MessogeBus M Node Sockets Use rabbit@b619194b-6b.., 6 t

111Conc MessogeBus M Node Memary Used rabbit@b619194b-6b...  143.98 MB t

111Conc MessogeBus M Nede Memary Limit Used Percentage rabbit@b619194b-6b.., 0% a

111Conc MessageBus M Nede Memery Limit Available rabbit@b619194b-6b...  50.12 GB At

111Conc MessageBus M e Memery Limic rabbit@b619194b-6b...  50.26 GB At

111Conc MessageBus M rabbit@b619194b-6b...  False

111Conc essegeBus M rabbit@b619194b-6b.. 33 At

111Conc geBus e rabbit@b6191 -6b... 469 il

ERPTN MameraDiin an, ladda T AR AREI010 AR Gk 28770 Y. I hd

| Page |1 ofs | » »IC Items 1 - 50 of 208
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3. To view the details for an individual statistic:

a. Select a row to select a statistic.

b. Click ~'.
The Stat Details pane is displayed.
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Stat Details
Hostname
Component |D
Component
Name

Subitem

Path

Plugin

Plugin Instance
Type

Type Instance

Description

Category
Yalue

Raw Value

Graph Data Key

pMulti Value

Last Updated Time

stat_collector_version

111Conc

messagebus

MessageBus

Mode Sockets Used
rabbit@b&191594b-6ba2-4508-55c4-42b53df02eed

messagebus_localhost

gauUge
rabbit@b&19194b-6ba2-4508-25c4-
deh53dfi2eed _sockets_used

Mumber sockets used by this message broker.
MessageBus

2018-02-01 07:31:55 PM

4]

5.0

bG19194b-6ba2-4308-95c4d-
4aph53df02ead/messagebus_localhost/zauge-
rabbit@b&1915%4b-6ba2-4508-55c4-
4ep53df0Zeed_sockets_used

b619194b-6ba2-4508-35c4-
deh33df0Zeed/meszagebus_localhost/gauge-
rabhit@b&19154b-6ba2-4508-95c4-
4ekh53df02eed_sockets_used

11.3.0.0

false

For details on various parameters in the ADMIN > Health & Wellness > System Stats
Browser view, see System Stats Browser View
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View Historical Graphs of System Statistics

The historical graph of the collected system stats gives you information about the variation of the
stats over a selected time frame.

To view a historical graph:
1. Goto ADMIN > Health & Wellness.
The Health & Wellness view is displayed with the Alarms tab open.
2. Click the System Stats Browser tab.
3. Inthe System Stats Browser tab, specify the filter criteria to display the statistics you want.
4. In the Historical Graph column, select i
The Historical graph for the selected statistic is displayed.

The figure below gives an example of the historical graph for the Memory Utilization statistic for
a host.

Historical Graph

Concentrator: Memory Utilization Time Frame | Current Day v
Zoom 1h 6h 12h 1d Al From | Feb1,2019 | To | Feb1,2019

45M
40M E
E
w

35M

30M

08:00 09:00 10:00 11:00 12:00 13:00 14:00 15:00 16:00 17:00 18:00 19:00
— |
I I -  E— 12:00 _— — 1 3:80—
m
average
Click and drag in the plot area to zoom in

The graphical view is customized to display the statistics collected for the current day and the
values are zoomed in for an interval of an hour (10.15 - 11.15 hrs). Hover over the graph to view

the details at a particular instant. For example, in the figure it displays the memory utilization at
12.00 hrs.
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Note: You can customize the graph view by selecting the Time Frame and Date range. You can
zoom in using the zoom in value, time window, or by just clicking and dragging in the plot area.
For details on the parameters to customize and zoom in functions, see Historical Graph for System
Stats. Any break or gap in the chart line indicates that the service or host was down during that

time.
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Monitor Service Statistics

NetWitness Platform provides a way to monitor the status and operations of a service. The Service
Stats view displays key statistics, service system information, and host system information for a
device. More than 80 statistics are available for viewing as gauges and in timeline charts. Only
statistics for session size, sessions, and packets are viewable in historical timeline charts.

Although different statistics are available for different types of services, certain elements are
common for any Core device.

To monitor service statistics in NetWitness Platform:

1. Goto ADMIN > Services.
The Services view is displayed.

2. Select a service, and select View > Stats in the Actions column.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Hosts Services Event Sources Endpoint Sources Health & Wellness  System  Security

& ChangeService | K decoder-Decoder |  Stats

decoder - Decoder

Key Stats Service System Info Host System Info Physical Drives
- 0 MbPS CPU 11% CPU 20 [+

24GB =

7.8GB sda

28.8 MB

65 MbPS 24GB
7.8GB
ed 2.8 Million Packets 157.4 M2

0 Packets (0% loss) v 7.8GB 7868

2.2 Million Packets

19 hours and & minutes

2016-Jun-24 06:19:03 . Ready 19 hours and 21 minutes

2019-Feb-01 00:37:46

2019-Feb-01 19:46:35

Ready
2019-Feb-01 00:25:50

2019-Feb-01 19:47:41

Gauges - Page 1 af 1

Memory Process cpu Memory Process Max

RS /\ NETWITNESS  PLATFORM

3. To customize the view, collapse or expand charts. For example, expand the Chart Stats Tray to
see available charts, and then drag a section up or down to change the sequence. Or, drag the
Gauges section to the top so that it is above the Summary Stats section.

Add Statistics to a Gauge or Chart

In the Services Stats view, you can customize the monitored statistics for individual services. The
Chart Stats Tray lists all available statistics for the service. The number of statistics varies
according to the type of service being monitored. Any statistic in the Chart Stats Tray can be
displayed in a gauge or a timeline chart. Only statistics for session size, sessions, and packets are
viewable in historical timeline charts.
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Create a Gauge for a Statistic

To create a gauge for a statistic in the Services Stats view:
1. Goto ADMIN > Services.

The Admin Services View is displayed.
2. Select a service and select View > Stats in the Actions column.

The Chart Stats Tray is displayed on the right side.

3. If the tray is collapsed, click <l to view the list of available statistics.
4. From the Chart Stats Tray, click on any statistic and drag it into the Gauges section.

A gauge is created for the statistic. If there is no space for the gauge, a new page is created in
the Gauges section and the gauge is added to the new page. In the example, the Active
CPU Time chart was added to the Gauges section by dragging it from the Chart Stats Tray.

H X CPU X Memory Process Max X Active CPU Time X
Name 4 Value .
Dis...  Memory Process Max

Path  /sys/stats/memory.process.max

Sta... Memory.process.max

0%

% W Active CPU
Process Time

Gauges - Page 1 of 1 A—+

Create a Timeline Chart for a Statistic

To create a timeline for a statistic:

From the Chart Stats Tray, click on a statistic and drag it into the Timeline Charts or the
Historical Timeline Charts section.

A timeline chart is created for the statistic. If there is no space for the chart, a new page is created
in the Timeline Chart section and the chart is added to the new page. In the example, the Assembler
Packet Pages chart was added to the Timeline Charts section by dragging it from the Chart Stats
Tray.
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Timeline Charts - Page 1 of 1
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Search for a Statistic in the Chart Stats Tray

To search for a statistic, type a search term;

for example, session, in the Search field

and press Enter. Statistics that match are displayed with the matching word highlighted.

Chart Stats Tray

Search

ses 5ior'||

Stats

Assembler Sessions
Stat Name:azsembler.sessions
Path:/decoder/stars/assembler.zessions

Session Bytes
Stat Name:session.bytes
Path:'databaselstats/session. bytes

Session Bytes Last Hour
Stat Name:session.bytes.last.hour
Path:'database/stats/session. bytes.last.hour

Session Completion Queue
Stat Name:pool.session.complets

5ession Correlation Queue
Stat Name:pool.session.correlate
Path:'decoder/stars/pool.session.correlate

Session Decrement Queue
Stat Name:pool.session.decrement
Path:'decoder/stats/pool.session.decrement

Session Export Cache Files
Stat Name:=xport.session.cache.files
Path:/decoder/stats/export.session.cache.files

of2 | } M

| Page 1

| C

Pathy'decoder/parsers/stats/pocl.session.complete

Stats 1-12 of 24
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Edit Properties of Statistics Gauges

The Gauges section of the Service Stats view presents statistics in the form of an analog gauge. The
properties of each individual gauge are editable; all gauges have an editable title and some have
additional editable properties.

Edit Properties of a Gauge

1. Goto ADMIN > Services
The Admin Services view is displayed.

2. Select a service and select View > Stats in the Actions column.
The Service Stats view includes the Gauges section.

3. Go to the gauge for which you want to edit properties (for example, Memory Process).

Memeory Process Max LoD

3.3GB 31.4GB 5§.6GB

0.0 Memaory Process 82.8GE
Max

4. Click the Properties icon ('ﬁ}) to display the parameter names and values.

5. To highlight the value of the Display Name field, double-click on the value; for
example, Memory Process.

Note: Clicking the other two values does nothing because the properties are not editable in
the gauge.

6. Type a new value for the Display Name and click the Properties icon (ﬁ} ).
The new title replaces Memory Process.

Add Stats to the Gauges Section

You can add more gauges by dragging a statistic from the Chart Stats Tray into the Gauges
section.

1. To expand the Chart Stats Tray, click <l

2. Scroll down and select a statistic, for example, Session Rate (maximum).
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3. Drag the statistic to the Gauges section.
The new gauge is displayed in the Gauges section.

Edit Properties of Timeline Charts

Timeline charts display statistics in a running timeline. The Service Stats view includes two types of
timelines; current time and historical. You can drag any statistic available in the Chart Stats Tray to
the Timeline Charts section. Only statistics for session size, sessions, and packets are viewable in
historical timeline charts. The properties of an individual timeline chart are editable; all timeline
charts have an editable title and some have additional editable properties.

To access the charts:
1. Goto ADMIN > Services.
2. Select a service and click Stats.

The Services Stats view is displayed. The charts are in this view.

Edit Properties of a Timeline

To edit properties of a timeline chart:

1. Go to the timeline chart for which you want to edit properties (for example, Memory Process).

Timeline Charts - Page 1 of 1 ~—+
Memory Process @X CPU 10D
20—
15
10
0.5 =t
T T T T T o T T 1 T T
11:08 am 11:08 am 11:10 am 11:11am 11:13 am 11:08 am 11:08 am 11:10 am 11:11am 11:13 am
Memory Process Max &@X Assembler Packet Pages X
ares T 720
°°ﬂ ' ! - ?53
15'5.5 0:5:|

I 1 T I I
11:06 am 11:08 am 11:10 am 11:11am 11:13 am

2. Click the Properties icon ("E}) to display the parameter names and values.

3. Double-click on a value (for example, the Display Name field) to make the value editable.

Note: Clicking the other two values does nothing because the properties are not editable in the
chart.

4. Type a new value and click the Properties icon.

The timeline chart is displayed with new values.

Edit Properties of a Historical Timeline

To edit properties of a historical timeline chart:
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1. Go to Historical Timeline Charts.

2. Click the Properties icon ({E}) to display the parameter names and values.

3. Click on a value (for example, 01/27/2019 for the Begin Date field) to make the value editable.

>

Type a new value.

hd

Edit the End Date and Display Name if required.

6. Click the Properties icon ({E} ).
The historical timeline is displayed with new values.

Note: To return the properties of the historical timeline chart back to the default so that the values
dynamically update, remove the Begin Date and the End Date, place your cursor in the Begin
Date field, and refresh your browser.

Add Stats to Timeline Charts

You can add timeline charts by dragging a statistic from the Chart Stats Tray into the Timelines
section.

1. To expand the Chart Stats Tray, click <l
2. Scroll down and select a statistic; for example, Session Rate (maximum).

3. Drag the statistic to the Timelines Section.
The new timeline is displayed in the Timelines section.

Monitor Hosts and Services

NetWitness Platform provides a way to monitor the status of the hosts and services installed in your
environment. You can view the current health of all the hosts, services running on the hosts, their
CPU usage and memory consumption, and the host and service details.

To monitor hosts and services in NetWitness Platform:

1. Goto ADMIN > Health & Wellness.
The Health & Wellness view is displayed with the Alarms tab open.

2. Select the Monitoring tab.

A list of all hosts and their associated services that belong to the group All is displayed by
default.
The operational status, CPU usage, and memory usage for each host is displayed.
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RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Hosts Services Event Sources Endpoint Sources Health & Wellness tem  Security

Alarms Monitoring Policies System Stats Browser  Event Source Monitoring Settings

Groups Hosts iiter
Name Count
- Stopped Services Stopped Processing Physical Drive Problems Logical Drive Problems Full Filesystems
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@ 0 10 0 host(s) 0 hosti(s) 0 host(s)
B adminserve Status CPU: 16.75% Memary: 32.79 GB/47.17 GB
B archive Status: CPU:2.2% Memory: 2.21 GB/7.80 GB
service Health Status  Rate Name Service Type = WMemory Usage Uptime
Ready L] 0 ardl Archiver 0.6% 35.22 MB. 19 hours 46 minut
Ready 0 arc Workbench 0.4% 2634 ME 19 hours 46 minut
B broker Status: CPU: 2.18% Memeory: 2.00 GB/7.80 GB
Service Health Status  Rate Name Service Type cPU Memory Usage Uptime
Ready [ ] 0 broker - Broker Broker 07% 29.34MB 19 heurs 50 minutes 3 seconds
B concentrator Status: CPU: 1.75% Memary: 1.44 GB/7.80 GB
service Health Status  Rate Name Service Type = WMemory Usage Uptime
Ready 0 concentratar - Concentrato Concentrator 1.5% 170,57 MB 15 hours 25 minutes 41 seconds
»
| Page 1 |of2 | ) » I C Displaying 1 - 10 of 12
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A list of services installed on the host is shown below the host. If you cannot see the services,
click & to the left of a host to display the services.

The name, operating status, CPU usage, memory usage, and the time operating for each service
is displayed.

Filter Hosts and Services in the Monitoring View

You can filter hosts and services in the monitoring view in one of the following ways:
« Hosts belonging to a particular group

o A specific host and its associated services

o Hosts whose services are stopped

o Hosts whose services have stopped processing or processing has been turned off

o Hosts that have physical drive problems

o Hosts that have logical drive problems

o Hosts that have full file systems

For the related reference topic, see Monitoring View.

To filter hosts and services:
1. Goto ADMIN > Health & Wellness.

The Health & Wellness view is displayed with the Alarms tab open by default.
2. Select the Monitoring tab.

Filter the hosts and services in one of the following ways:
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o To view a list of hosts and their associated services belonging to a particular group, select the
group in the Groups panel.

All hosts and their associated services belonging to the specified group are displayed in the
Hosts panel.

Note: The grouping of hosts is derived from the groups created in the Admin Hosts
view. All groups created in the Admin Hosts view are displayed here.

For example, if you select the group LC_Group in the Groups panel, a list of all hosts that
are part of the group are displayed.

o To view a list of all services that have stopped processing, click Stopped Processing in the
Hosts panel.

A list of all the hosts that have at least one service with the status as stopped processing is
displayed.

Note: The buttons on the top display the system statistics for all of the hosts configured in
NetWitness Platform and does not change with the application of filters on the groups.

RSA| RESPOND  INVESTIGATE MONITOR CONFIGURE ADMIN @ admin © (3

Hosts  Services Ev rces Endpoint Sources Health & Wellnes:

[WELISHNEN  Policies  System Stats Browser

Groups Hosts Filter
Name Count .
Stopped Services Stopped Processing g Physical Drive Problems Logical Drive Problems Full Filesystems
Al
& ] 0 10 0 host(s) 0 host(s) 0 host(s)
8 maare Seecus CPU1.73% Memory: 7.07 GB/15.67 GB
service Type. cru Memoryussge  Uprime
Ready ° [} nalware - Broke: Broker 0.4% 2654 M8 19 hours 50 min
Ready Malware Analysis 0.2% 437GE 19 hours 50 min
s
servi
Ready ° [}
Ready ]
Resdy 0
Ready e 0
| Page 1 of1 | (e Displaying 1-7 of 7
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o Ina similar way, you can filter the list of hosts and the associated services by choosing the
appropriate filter:

o Click Stopped Services to display a list of all stopped services.
o Click Physical Drive Problems to display a list of host with physical drive problems.

o Type the host name in the Filter box to display only the required host and the services
running on the host.
Monitor Host Details

You can view the details of a host, its memory and CPU usage, system information, physical drive,
logical drive, and file system details to investigate potential problems with the host.
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To view host details:

1. Goto ADMIN > Health & Wellness > Monitoring tab.

Click a host in the Hosts panel.

The Host Details view shows important system information about the selected host, such as

memory utilization and file system usage.

RSA RESPOND INVESTIGATE MONITOR

CONFIGURE ADMIN
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HOST AND SERVICES
| Host
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You can view the details of a service, its memory and CPU usage, system information, and various

details depending on the service selected.

To view service details:

1. Goto ADMIN > Health & Wellness > Monitoring tab.

The Hosts panel shows the services running on each host.

2. In the Hosts panel, click a service name link to get more information.

The service details view shows the health status of the selected service. The Decoder service
details include capture statistics and the Concentrator and Broker details include aggregation

statistics.
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Many services, including the ESA Correlation service, have a Health Stats tab that provides
information about the health status of the service. The JVM tab shows the total memory used by
the selected service and the total memory capacity of the host. For more information, see Health
Stats Tab and JVM Tab.

For more information on the ESA Correlation service and ESA Rule memory usage, see the
Alerting with ESA Correlation Rules User Guide.
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The Malware Analysis service details view has Service information plus the Event, and JVM
tabs that show additional statistics. The Events tab shows event processing statistics.
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The Reporting Engine service details view has Service information plus the Report and JVM
tabs that show additional statistics.
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You can also view the details of other services by clicking the services listed in the options panel on

the left.

Refer to Monitoring View for a detailed description of the Details view for each service.
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Monitor Event Sources

Note: For NetWitness Platform 11.4.1, this view has been deprecated. To manage Event
Sources, use the Admin > Event Sources view. For details, see "About Event Source
Management" in the RSA NetWitness Platform Event Source Management Guide.

Monitor Alarms

You can set up alarms and monitor them in the Health and Wellness interface for the hosts and
services in your NetWitness Platform domain. Alarms display in the view as Active when the
statistical thresholds for hosts and services have been crossed. Alarms are grayed out and change to
the Cleared status when the clearing threshold has been crossed.

You set up the parameters for alarms in Manage Policies. For the related reference topic, see Health
and Wellness View - Alarms View.

To monitor alarms:
1. Goto ADMIN > Health & Wellness.
The Health & Wellness view is displayed with the Alarms tab open by default.
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2. Click on the alarm for which you want to display details in the Details Panel.
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3. Click </ (expand) to view the details for the alarm you selected.

Alarm Detalls 12
d 028-12424-0001 -
Time 2019-01-29 03:43:09 PM
State ACTIVE
Severit CRITICAL
Hostname dec
Service Host
Palicy Host Monitaring Palicy
Rule Name Critical Filesystemn Usage on Rabbitmg Message Broker
nformational Text The RabbitMQ) service filesystem at
fvar/netwitness/rabbitmg (fvar/lib/rabbitmg for 10.8.x
systems) has exceeded 75% of capacity, which is a likely
indicator that messages generated by NetWitness services
are either not being sent over the bus or aren’t being sent
quickly encugh.
The RabbitMQ service will stop transmitting messages
when it reaches 80% of its filesystem capacity, which will
cause Health & Wellness message, Event Source
Maonitoring messages, and Log Collector logs to stop
being delivered.
Possible Remediation Action:
The filesystem is soon likely to fill. Please open a case with
Customer Support as quickly as possible to avoid a
potental service outage.
Stat FileSystemi/Mounted Filesystern Disk Usage Percent
Fearflibfrabbitmg
/alue TT%
Count 1
Cleared Value
Cleared Time
Motified Time
Suppression Start Time -

Monitor Health and Wellness Using SNMP Alerts

You can monitor a NetWitness Platform component to proactively send alerts, using Simple Network
Management Protocol (SNMP) that is based on thresholds or system failures.

You can monitor the following for NetWitness Platform components:
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o CPU utilization that reaches a defined threshold
« Memory utilization that reaches a defined threshold

o Disk utilization that reaches a defined threshold

SNMP Configuration

NetWitness Servers can be configured to send out SNMPv3 threshold traps and monitor traps.
Threshold traps are sent in conjunction with node thresholds that are configured by the NetWitness
Platform Core applications. Monitor traps are sent by the SNMP daemon for the items indicated in
the SNMP configuration file. You must set up the SNMP daemon on another service to receive
SNMP traps from NetWitness Platform. You can set up SNMP on NetWitness Platform in the
configuration setting for the NetWitness Server. For more information, see "Service Configuration
Settings" in the NetWitness Platform Host and Services Getting Started Guide for a specific type of
host.

Thresholds

Thresholds can be set on any service statistics that can accept the setLimit message. You can
retrieve current thresholds using the getLimit message. To set a limit, you can pass a low and high
threshold value.

When the value of a statistic crosses either the low or high threshold, an SNMP trap is triggered,
indicating that the threshold has been crossed. The trap is not triggered if the value is below the low
and above the high value, but another trap is triggered if it crosses back into the normal range (above
the low and below the high).

You must set the threshold for the service using the Service Explorer view or the REST API.
This example shows a sample threshold for monitoring CPU usage (below 10% or above 90%):
/sys/stats/cpu setLimit low=10 high=90

This example shows how the threshold is set using REST API:

http://<log decoder>:50102/sys/stats/cpu?msg=setLimit&low=10&high=90

If the CPU usage spikes to 90% or higher, an SNMP trap is generated:

23435333 2018-Dec-16 11:08:35 Threshold warning path=/sys/stats/cpu 0ld=77%
new=91

Configure SNMPv3 for a Host

1. Goto ADMIN > Services.
The Services view is displayed.

2. Select the service.
3. Inthe Actions column, select View > Explore.

4. In the nodes list, expand the list and select a configuration folder. For example, logs > config
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5. Set the SNMPv3 configuration.

RSA| RESPOND  INVESTIGATE MONITOR CONFIGURE ADMIN (@ admin

Hosts  Services Event Sources Endpoint Sources Health & Wellness  System  Security

+ Change Service conc- Concentrator | Explore

E conc - Concentrator

concentrator=1024MB
wratar (CONCENTRATOR)
failure

10MB
x
snmpy3.engine.boots 6
S logs snmpv3.engine id
[ config snmpy3.trap.auth local.key
Clstars 2p.auth protocol none
none
[ noAuthNoPriv

Blsys

Clusers

RS\ NETWITNESS' PLATFORM 11.3.00

Set the Threshold for a Service

I. Go to ADMIN > Services.
The Services view is displayed.

Select the service.
In the Actions column, select View > Explore.
In the nodes list, expand the list and select a stat folder.

Select a stat, for example, CPU, and right-click.

N

From the drop-down menu, select Properties.

The Properties panel is displayed. The Properties panel has a drop-down list of available
messages for the parameter.

get
getlimit
help
info

setlimit

7. Select setLimit.

8. Specify the low and high values.
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SNMP Traps for System Status

The threshold mechanism can also be used to monitor string-valued stats generated by Core services.
There are two ways to monitor string-valued stats:

1. Generate a trap whenever the status value is NOT an expected value. For example, if you want
monitor the stat /broker/stats/status and generate a trap whenever the value is not
started, set the high limit on the stat to the expected value. You would use the setLimit

message on /broker/stats/status as follows:
setLimit high=started

2. Generate a trap whenever the status value matches an expected value. This is accomplished by
using the 1ow limit on the stat. For example, if you wanted generate a trap when the stat
/sys/stats/service.status has the value "Initialization Failure", you would use

the setLimit message on /sys/stats/service.status as follows:
setLimit low="Initialization Failure"

In both of these scenarios, it is possible to check for multiple values by using a comma-separated list
of values to check for.

Troubleshooting Health & Wellness

Issues Common to All Hosts and Services
You may see the wrong statistics in the Health & Wellness interface if:
o Some or all the hosts and services are not provisioned and enabled correctly.

e You have a mixed-version deployment (that is, hosts updated to different NetWitness Platform
versions).

o Supporting services are not running.

Issues Identified by Messages in the Interface or Log Files

This section provides troubleshooting information for issues identified by messages NetWitness
Platform displayed in the Health & Wellness Interface or included in the Health & Wellness log
files.

User Interface: Cannot connect to System Management Service
System Management Service (SMS) logs:

Caught an exception during connection recovery!
java.io.IOException
at com.rabbitmg.client.impl.AMQChannel.wrap

(AMQChannel.java:106) at
com.rabbitmg.client.impl.AMQChannel.wrap

(AMQChannel.java:102) at
com.rabbitmg.client.impl.AMQConnection.start (

AMQConnection.java:346) at
com.rabbitmg.client.impl.recovery.
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RecoveryAwareAMQConnectionFactory.
newConnection

(RecoveryAwareAMQConnectionFactory.java:36)
at com.rabbitmg.client.impl.recovery.

AutorecoveringConnection.
recoverConnection (AutorecoveringConnection. java:388)
at com.rabbitmg.client.impl.recovery.

AutorecoveringConnection.beginAutomaticRecovery
(AutorecoveringConnection.java:360)
at

com.rabbitmg.client.impl.recovery.AutorecoveringConnection.

access$000 (AutorecoveringConnection.java:48)
at com.rabbitmg.client.impl.recovery.

AutorecoveringConnection$1l.shutdownCompleted
(AutorecoveringConnection. java:345)
at com.rabbitmg.client.impl.ShutdownNotifierComponent.

notifyListeners (ShutdownNotifierComponent.java:75)

at com.rabbitmg.client.impl.AMQConnection$MainLoop.run
(AMQConnection.java:572)

at java.lang.Thread.run (Thread.java:745)

Caused by: com.rabbitmg.client.ShutdownSignalException:
connection error at
com.rabbitmg.utility.ValueOrException.getValue
(ValueOrException.java:67)

at com.rabbitmg.utility.BlockingValueOrException.

uninterruptibleGetValueBlockingValueOrException.java:33)
at

com.rabbitmg.client.impl.AMQChannel$BlockingRpcContinuation.

getReply
(AMQChannel.java:343)
at com.rabbitmg.client.impl.AMQConnection.start
(AMQConnection.java:292)

8 more
Caused by: java.net.SocketException: Connection reset
at java.net.SocketInputStream.read
(SocketInputStream.java:189)
at java.net.SocketInputStream.read
(SocketInputStream.java:121)
at java.io.BufferedInputStream.fill
(BufferedInputStream.java:246)
at java.io.BufferedInputStream.read
(BufferedInputStream.java:265)
at java.io.DatalnputStream.readUnsignedByte
(DataInputStream.java:288)
at com.rabbitmg.client.impl.Frame.readFrom(Frame.java:95)
at com.rabbitmg.client.impl.SocketFrameHandler.readFrame
(SocketFrameHandler.java:139)
at com.rabbitmg.client.impl.AMQConnection$MainLoop.run
(AMQConnection.java:532)

RabbitMQ service not running on the NetWitness Server.

Restart the RabbitMQ, SMS, and NetWitness Platform services using the
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following commands.

systemctl restart rabbitmg-server
systemctl restart rsa-sms
systemctl restart jetty

User Interface: Cannot connect to System Management Service

The System Management Service, RabbitMQ, or Mongo service is not running.

Run the following commands on NetWitness Server to make sure all
these services are running.
[root@nwserver ~]# systemctl status rsa-sms
RSA NetWitness SMS :: Server is not running.
[root@nwserver ~]# systemctl start rsa-sms
Starting RSA NetWitness SMS :: Server...
[root@nwserver ~]# systemctl status rsa-sms
RSA NetWitness SMS :: Server is running (5687).
[root@nwserver ~]# systemctl status mongod
mongod (pid 2779) is running...
systemctl status rabbitmg-server
Status of node nw@localhost
[{pid, 2501},
{running applications,
[{rabbitmg federation management, "RabbitMQ Federation
Management",
"3 .3.4" } ,

User Interface: Cannot connect to System Management Service

/var/lib/rabbitmg partition usage is 70% or greater.

Contact Customer Care.

User Interface: Host migration failed.

One or more NetWitness Platform services may be in a stopped state.
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Make sure that the following services are running then restart the NetWitness
Server:

Archiver, Broker, Concentrator, Decoder, Event Stream Analysis, Response
Server, IPDB Extractor, Log Collector, Log Decoder, Malware Analysis,
Reporting Engine, Warehouse Connector, Workbench.

User Interface: Server Unavailable.

One or more NetWitness Platform services may be in a stopped state.

Make sure that the following services are running then restart the NetWitness
Server: Archiver, Broker, Concentrator, Decoder, Event Stream Analysis,
Response Server, IPDB Extractor, Log Collector, Log Decoder, Malware
Analysis, Reporting Engine, Warehouse Connector, Workbench.

User Interface: Server Unavailable

System Management Service (SMS), RabbitMQ, or Mongo service is not running.

Run the following commands on NetWitness Server to make sure all these services

are running.

[root@nwserver ~]# systemctl status rsa-sms

RSA NetWitness SMS :: Server 1is not running.
[root@nwserver ~]# systemctl start rsa-sms
Starting RSA NetWitness SMS :: Server...
[root@nwserver ~]# systemctl status rsa-sms
RSA NetWitness SMS :: Server is running (5687).

[root@nwserver ~]# systemctl status mongod
mongod (pid 2779) is running...
systemctl status rabbitmg-server
Status of node nw@localhost
[{pid, 2501},
{running applications,
[{rabbitmg federation management, "RabbitMQ Federation
Management",
"3.3.4"},
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Make sure /var/1lib/rabbitmg partition is less than 75% full

Check NetWitness Server log files (var/1ib/netwitness/uax/logs/nw.1logq)
for any errors.

ContextHub stops and does not allow you to add or edit data sources and lists.

The storage is full by 95% or above.

Increase the storage by updating the YML file, located at
/etc/netwitness/contexthub-server/ contexthub-server.yml.
For example, to increase storage from 120 to 150 GB, enter a value (in bytes) by

editing the relevant parameter: rsa.contexthub.data.disk-size:
161061273600

Delete unwanted or unused large list.

Configure the TTL index for the list to automatically delete STIX and TAXI data
and to clean up storage space.

Context Hub runs on a fixed memory and 50% is reserved for cache. When cache
is 100% full, the cache response stops. For all new lookups the response will be
slow.

The cache is full by 50% or above.

By default, Context Hub cleans the cache every 30 minutes. Reduce the cache
expiration time of data sources.

Disable cache for data sources.

Increase the RAM of the CH Java process by editing the -xmx option available in
the /etc/netwitness/contexthub-server/contexthub-server.conf file. In JAVA OPTS,
search for the -Xmx option.

For example, edit the entry as follows:

-Xmx8G

where 8G represents 8GB space. Then restart the ContextHub service.

Note: The memory is less than the available system memory. Be aware that
there are many other services running on the host.
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List Data Source displays an unhealthy stats or status.

Unable to:

o access the data source

o parse or read a CSV file

e schema mismatched CSV

Unable to authenticate when accessing the data source.

Make sure to save the csv file at correct location i.e/var/lib/netwitness/contexthub-
server/data/ and verify the required read permissions.

Make sure the csv file schema specified while configuring the data source
matches. If not, then either create a new data source with the new schema or edit
the csv file to match the schema. For example, if you configure a List Data Source
with a schema with columnl, column2, and column3. And next time you update the
csv file where the number of column increase or decrease or the order of the
columns are changed. In this case there is a schema mismatch and the configured
list data source will show “Unhealthy” in Health and Wellness stats.

Make sure the password is correct. To confirm edit the data source, enter the
password and click test connection.

For more information related the above solutions, see "Configure Lists as a Data
Source" topic in the Context Hub Configuration Guide.

Issues Not Identified by the User Interface or Logs

This section provides troubleshooting information for issues that are not identified

by messages NetWitness Platform displays in the Health & Wellness Interface or includes in the
Health & Wellness log files. For example, you may see incorrect statistical information in the
Interface.

Incorrect statistics displayed in Health and Wellness interface.

SMS service is not running. SMS service must be running on the NetWitness
Server.

Restart SMS service.
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Problem

Possible

Cause

Solution

Problem

Possible
Cause

Solution

Problem

Solution

NetWitness Platform does not show the version to which you upgraded until
you restart jettysrv (jeTTy server).

When NetWitness Platform checks a connection, it polls a service every 30
seconds to see if it is active. During that 30 seconds, if the service comes back up,
it will not get the new version.

1. Manually stop the service.

2. Wait until you see that it is it offline.

3. Restart the service.
NetWitness Platform displays the correct version.

NetWitness Server does not display the Service Unavailable page.

After you upgrade to NetWitness Platform version 10.5, JDK 1.8 is not default
version and this causes the jettysrv (jeTTy server) to fail to start. Without the
jeTTy server, the NetWitness Platform server cannot display the Service
Unavailable page.

Restart jettysrv.

The SMS service is stopped and the following error is displayed in the log file:
java.lang.OutOfMemoryError: Java heap space

You can use the following solution to increase the memory according to your needs.

1. Open /opt/rsa/sms/conf/wrapper.conf

B coronsrumnce s > = =
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wrapper.java.additional.l=-Xmx1l6g

Restart the SMS service:
systemctl start rsa-sms

Replace wrapper.java.additional.l=-Xmx8192m with:
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Monitor Health and Wellness using Kibana (BETA)

RSA NetWitness Health and Wellness (BETA) is an advanced monitoring and alerting system that
provides insights on the operational state of the host and services in your deployment, and helps identify
potential issues. NetWitness Platform is prepackaged with third-party tool namely Kibana that renders
interactive dashboards and visualizations.

Health and Wellness (BETA) provides:
o Dashboards with interactive Visualization.
« Easy-to-create customized content (Visualization, Alert, Dashboard and so on).

o Alerts on your data and customize alert conditions.

RSA NetWitness Health and Wellness (BETA) provides default content, such as Dashboards,
Visualizations and Monitors to set up monitoring and alerting.

Note: This is a BETA version of this feature and it is not completely implemented in 11.4 (for
example, it does not have integrated authentication to Kibana and it cannot post alerts to output
actions).

Please direct any Health and Wellness Beta feedback to nw.health.wellness.feedback@rsa.com.

Dashboard

Dashboard is a collection of intuitive visualizations for the administrator to monitor the health of the host
and services, identify trends, track performance, and drill down to specific details.

On the installation of Health and Wellness service, the following default Dashboards are available to
begin monitoring.

o Deployment Health Overview Dashboard — This provides overall health of the NetWitness
Platform hosts and services, such as:

o Total number of active hosts
o Hosts by memory usage
o Hosts by CPU usage

o Hosts Dashboard - This provides the resource utilization and health on NetWitness hosts in your
deployment such as:

o Inbound or outbound traffic over the host interfaces like ethO or em1
o CPU, memory, and disk usage of the hosts
o Open file descriptors for the service
o Logs Dashboard - This provides the insights of NetWitness Platform logs such as:
o Capture drops percentage for Log Decoders
o Capture rate percentage for Log Decoders

o Query status for a service
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o Service status

You can drill down the log capturing and processing services like Log Decoders, Concentrators,
Brokers, Archivers, and ESA Correlation for analysis.

o Packets Overview - This provides insights on NetWitness Platform network data, such as:
o Network capture percentage for a service
o Network capture drop percentage for a service
o Query status for a service
o Service status

You can drill down the packet capturing and processing devices like Network Decoders,
Concentrators, Brokers, ESA Correlation for analysis.

You can create a new dashboard or customize existing dashboards.

Visualization

Visualization is a graphical representation of data in your deployment. You can create new
visualizations or use the existing visualization to build dashboards. Depending on the visualization you
select the data is displayed in the Dashboard.

Monitors

A monitor is a job that runs on a defined schedule, which queries the Elasticsearch to evaluate the
system health. You can define one or more triggers for a monitor and assign severity level based on the
threshold. When one or more trigger conditions are met, Health and Wellness generates an alert. that can
be viewed in the Kibana UI. You can create new monitors or customize the existing monitors based on
your requirement.

Health and Wellness System Requirement

Minimum memory for a standalone virtual host is 16 GB.

Each NetWitness platform host writes 150 MB of Health and Wellness Metrics data into Elasticsearch
data per day. For example, if you have 45 NetWitness Platform hosts then 6.6 GB of metrics data is
written to Elasticsearch.

4 cores 16 GB

Installing Health and Wellness

You must deploy the Health & Wellness Search (BETA) version on a dedicated, virtual host. It includes
Elasticsearch, Kibana, and Metrics Server and enables all hosts in your deployment to start sending
metrics to Elasticsearch. For more information on installing Health and Wellness Search (BETA)
Version for Standalone Virtual Host Only see "Deployment Optional Setup Procedures" topic in the
Deployment Guide.
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Accessing Health and Wellness

After you deploy Health and Wellness (BETA), you can access the Health and Wellness.

To access Health and Wellness:
I. Gotohttps://<Host-ipon which Next gen H&W is installed >:5601.
2. Enter the user name as admin and password as netwitness@rsa.

After you log in to Kibana, RSA recommends that you change the password. For more information, see
Changing the Kibana Password.
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Changing the Kibana Password

To change the Kibana password:

L.

SSH to the virtual host on which Health and Wellness (BETA) is deployed.

2. Go to tools folder using the command:

cd /usr/share/elasticsearch/plugins/opendistro security/tools/

3. Generate the hash for the new password using the command:

sh hash.sh -p <new password>

For example, sh hash.sh -p netwitness

$2y$125ZfxTsuQg9/ JFNcX9%e 7TTxLuWNSuhwolnjbVi5dVésCAlVkee3Lb2 v

Copy the generated hash.
Go to the securityconfig folder using the command:
cd /usr/share/elasticsearch/plugins/opendistro security/securityconfig/

Check if the internal users.yml file exists using the command:
1s

Replace the hash value in the internal users.yml file for Admin user with the generated
hash that is obtained in step 4.

Note: Make sure you replace with the correct hash to log in to Kibana UI successfully.

8. Save the file.

9. Go to tools folder using the command:
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11.
12.

13.

cd /usr/share/elasticsearch/plugins/opendistro security/tools/

Update the security configuration changes in Elasticsearch using the command:

sh securityadmin.sh -cd ../securityconfig/ -icl -nhnv -cacert
/etc/elasticsearch/elasticsearch-trusts.pem -cert
/etc/elasticsearch/elasticsearch-cert.pem -key
/etc/elasticsearch/elasticsearch-key.pem

Note: After this is done, check if you can log in to Kibana using the username and new
password.

SSH to the Admin Server.

Enter the following command:
nw-shell
The console window is displayed.

Connect to metrics-server using the following command:

connect --service metrics-server
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14. Enter the login command:
login

15. Enter the admin username and password.

16. Set the Elasticsearch password using the following commands:

a. cd /rsa/metrics/elastic/password

b. set <new password> For example, set netwitness

Note: The <new password> should be same as in step 3.

17. Set the Kibana password using the following commands:

a. cd /rsa/metrics/kibana/password

b. set <new password> For example, set netwitness

Note: The <new password> should be same as in step 3.

18. Exit from nw-shell using the command:
exit
19. SSH to the Health and Wellness (BETA) virtual host.

20. Restart the metrics server on the Health and Wellness (BETA) virtual host using the command:
service rsa-nw-metrics-server restart
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Monitoring Using Dashboards

Y ou can monitor the health of the NetWitness Platform hosts and services using the different
dashboards. The Deployment Health Overview dashboard is displayed when you log in to the Kibana
user interface. By default, last 6 hours of data is displayed in the dashboard. For more information on
the default dashboards, see Monitor Health and Wellness using Kibana (BETA).

To monitor through the dashboard:

1. Log in to Kibana UI, click .

2. Select the dashboard you want to view and click dashboard link.

3. Click the dashboard link. For example, Host Overview.
Once the dashboard view is displayed you can look at the visualizations (charts, tables, and maps
and so) to view current disk usage of hosts, incoming and outgoing traffic of the host, active
queries on a service and so on.

= Current Memory Usage vs Total Available Memory Disk Usage by Partitions

26.28GB

28.47GB

Sarvice(s) by Open File Descriptors

Current Disk Usage vs Total Available Disk

10.99GB

191.2GB

4. You can adjust the time range on the top right corner and apply filters to view the statistics.
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Monitoring Using Alerts

Y ou can monitor the health of NetWitness Platform hosts and services using the alerts.

To monitor through alerts:

1. Log in to Kibana UlI, click “

Alerts view summarizes the alerts generated over the period of time along with the trigger,
severity and state of the alert.

2. To view the monitor and trigger associated with the alert, click the Monitor name link.

Alerting

Alerts

All severity levels ~ All alerts

Alert start time . Alert end time Monitor name Trigger nama Sevarity State Time acknowledged

01/17/20 3:48 pm 01/17/20 4:18 pm Capture Not Started 1 Completed

01/17/20 3:48 pm 01/17/20 4:19 pm Capture Pool Depleted Completed

01/17/20 3:01 pm 01/17/20 3:37 pm Capture Not Started Completed

01/17/20 3:01 pm 01/17/20 3:37 pm Capture Pool Depleted Completed

01/06/20 11:57 am 01/07/20 3:29 pm Capture Not Started Completed

01/06/20 11:57 am 01/07/20 3:28 pm Capture Pool Depleted Completed

01/06/20 11:57 am
01/06/20 11:57 am
01/06/20 11:57 am

01/06/20 11:57 am

Service in Bad State

.. Aggregation Stopped
. MetaRateis 0

. Service in Bad State

Active

Active

Active

Active

For example, if an alert is generated by the monitor name Broker Aggregation Stopped, you can
view more details by clicking on the Broker Aggregation Stopped monitor link.
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Broker Aggregation Stopped

Broker Aggregation Stopped

Overview

State Monitor definition type Total active alerts Schedule
Enabled Visual graph 1 Every 2 minutes

Last updated Monitor ID Monitor version number
01/06/20 11:55 am IST 2LuHeW8BTA: v 1
Triggers

Name - Number of actions Severity

Aggregation Stopped 0 L

Aggregation Stopped

History
o 01/18/2020 12:00 AM > 01/20/2020 11:56 AM

Aggregation St
opped

IE——SSS————F

Triggered I Error I Acknowledge No alerts

Iriggered . Error . Acknowledge No alerts

Alerts
All severity levels All alerts

Alert start ti... \|-  Alert end time Monitor name Trigger name Severity Time acknowle...

01/06/20 11:57

am Aggregation ... Active

Rows per page: 20
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Customizing Dashboards and Monitors

You can create new or customize existing dashboards, monitors, apply filters and customize the time
ranges to monitor details of your interest.

Create new dashboard

You can create a new dashboard by adding one or more existing visualizations or a new
visualization that you created.

To create a new dashboard:

[—

1. Log in to Kibana, click &0 .
2. Inthe Dashboards panel, click Create new dashboard.

3. Click Add to add visualizations to the dashboard. For more information on adding visualization,
see "Visualize" topic in the Kibana 7.2.0 guide.

4. Select the visualizations that you want to add to the dashboard.

5. Click Save.

Create Monitors

Monitors are used to automatically generate an alert if one or more specified condition is met. To
generate an alert, you must create a monitor and define the triggers. Monitor is a scheduled job that
captures one or more conditions by querying Elasticsearch whereas trigger is the threshold you must
setup for the monitors which when met generates an alert.

You can create a monitor for the host and services and define a trigger.

To create monitors:

A
1. Log in to Kibana UI and click .
Click Create monitors.

In the Create Monitors section, specify the required details.
Click Create.

b N

After a monitor is created, you can add a trigger to this monitor.
5. Inthe Create Trigger view, provide the required details:
a. Trigger name - Specify the name of the trigger.

b. Severity level - Set the severity level from range 1-5. 1 is the highest severity and 5 is the
lowest severity.

c. Trigger condition - Set the trigger condition with the value. The options are IS ABOVE, IS

Monitor NetWitness Platform Health 70


https://www.elastic.co/guide/en/kibana/7.2/release-notes-7.2.0.html

System Maintenance Guide

BELOW, IS EQUAL. For example, IS ABOVE 200.
6. Click Create to save the trigger.

For more information on creating monitors, see "Alerting" topic in the Open Distro for Elasticsearch
guide.

Add trigger to an existing monitor
I. Log in to Kibana UI and click .

In the Monitor section, click monitor to which the new trigger need be added.

In the Triggers section, select Create.

o

In the Create Trigger view, provide the required details:
a. Trigger name — specify the name of the trigger.

b. Severity level - Set the severity level from range 1-5. 1 is the highest severity and 5 is the
lowest severity.

c. Trigger condition — Set the trigger condition with the value. The options are IS ABOVE, IS
BELOW, IS EQUAL. For example, IS ABOVE 200.

5. Click Create to save the trigger.
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Managing Dashboards and Alerts

You can modify the dashboard and alerts to monitor details of interest.

Modify Dashboard

You can modify the dashboard to edit visualization, delete visualization, customize the panel title, or
change the positions of visualization. You can organize the visualization in the dashboard to display
data of your interest on the top.

Note: Any changes to the visualization in a dashboard modifies the visualization content.

To modify the dashboard:

1. Log in to Kibana UT, click Hsll

2. Select the dashboard you want to modify. For example, Hosts overview.

3. Click Edit and make the necessary changes to the dashboard. For example, you can edit or
delete visualization, customize panel.

4. Click Save.

Delete Dashboard

Once the dashboard is deleted, you cannot monitor the details specific to the dashboard.

To delete the dashboard:

1. Log in to Kibana U, click Hsll.

2. Select the check box of the dashboard you want to delete and click Delete.

You can delete one or more dashboards at a time.

Delete Visualization

To delete the visualization:

l. Log in to Kibana UI and click E
2. In the Visualizations view, select the visualizations you want to delete.
3. Click Delete visualization.

You can delete one or more visualization at a time.
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Modifying Existing Trigger
To modify existing trigger:

1. Log in to Kibana UlI, click .
2. Select the monitor whose trigger is to be modified.

3. Inthe Triggers section, select the trigger you want to modify from list of Triggers and select
Edit.

4. In the Edit Trigger view, make the necessary changes. You can change the Trigger name,
severity level, Trigger condition.

5. Click Update to save the changes.

Advanced Configurations

Reset Default Content

Reset allows you to bring back all the default content such as Dashboards, Visualizations, Monitors
to its original or default state. Reset configuration overwrites any changes made to the default
content.

Note: Reset does not make any changes to the default content.

To reset the default content:
1. SSH to Admin Server and connect to nw-shell.
2. Connect to metric server using the following command:
connect metrics-server
Log in to nw-shell and enter the username and password.
4. Go to the reset option using the following command:
cd /rsa/metrics/content/reset-content
5. To invoke the method, using the following command:

invoke

Restore Default Content

This allows you to restore all the missing or deleted default content that includes Dashboards,
visualization, monitors. This does not affect the existing, modified default content or newly created
content. For example, if you have deleted any dashboard or visualization and want to retrieve the
missing content.
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To retrieve the missing default content:
1. SSH to Admin Server and connect to nw-shell.

2. Connect to metric server using the following command:
connect metrics-server

Log in to nw-shell and enter the username and password.

4. Navigate to the restore option using the following command:
cd /rsa/metrics/content/restore-content

5. To invoke the method, using the following command:

invoke

Enable Services

This is used to enable all the services to start sending metrics to the Elasticsearch. For example, if
you have disabled few services from sending to Elasticsearch and would want to enable all those
disabled services to start sending again.

1. SSH to Admin Server and connect to nw-shell.
2. Connect to metric server using the following command:
connect metrics-server
Login to nw-shell and enter username and password.
4. Navigate to the enable option using the following command:
cd /rsa/metrics/elastic/enable-all
5. Execute the following command to enable all services to start sending to Elasticsearch:

invoke

Disable Services

This is used to disable all the services to send metrics to the Elasticsearch. Once disabled, none of
the services will be sending to the Elasticsearch and the dashboards will not be updated, and alerts
will not be triggered.

1. SSH to Admin Server and connect to nw-shell.
2. Connect to metric server using the following command:
connect metrics-server
Log in to nw-shell and enter the username and password.
4. Navigate to the Elasticsearch using the following command:
cd /rsa/metrics/elastic/disable-all
5. Execute the following command to disable all services to stop writing to Elasticsearch:

invoke
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Note: This disables all services to send metrics to Elasticsearch but does not stop metric beat to
send system level metrics to Elasticsearch. You need to manually stop metric beat on all hosts if
you wish to stop using Health and Wellness.

Update Interval

You can update a common interval for all the services to send data to the Elasticsearch. For
Example, if all the services are set to different intervals and you want to configure all the services to
send data to elastic search on the same interval.

The intervals can be set in seconds, minutes and hours.
1. SSH to Admin Server and connect to nw-shell.

2. Connect to metric server using the following command:
connect metrics-server

Login to nw-shell and enter the username and password.

4. Navigate to the Elasticsearch using the following command:
cd /rsa/metrics/elastic/update-interval

5. Execute the following command to set a common interval for all the services:
invoke <interval>

For example, invoke 30seconds

Default Configuration

By default, Health and Wellness (BETA) configurations are applied once the Health and Wellness
is enabled successfully. To change the configuration of a service, you need to update the existing
configuration. Once the configuration is updated, the service is notified of the changes.

To update the configuration, perform the following:

1. SSH to Admin Server.

2. Connect to metrics-server using command:
Connect metrics-server
Log in using the username and password

4. To get configuration of a service, execute following commands:
a. cd /rsa/metrics/elastic/get-config

b. invoke <service-id>

75 Monitor NetWitness Platform Health



System Maintenance Guide

Note:
To get the service id for core services:
1) Go to ADMIN > Core service.
2) Click > View > Explore view.
3) Expand the sys/stats node list.
4) In the UUID filed, copy the value.
To get the service id for launch services:
1) Go to ADMIN > Launch service.
2) Click > View > Explore view.
3) Click the process folder.
4) In the service-id field, copy the value.
To get the service id for carlos services:
1) SSH to host in which carlos service is deployed.
2) Execute the following command:
For Reporting Engine:
cat /var/netwitness/re-server/rsa/soc/reporting-engine/service-id
For Legacy Web Server:

cat /var/netwitness/uax/service-id

Note: The core services are Archiver, Broker, Concentrator, Decoder, Log Decoder and
Carlos services are Reporting Engine, Legacy Web Server. All the other services that are not
included in Core and Carlos services are part of launch services.

Copy the configuration and save it in a file. For example, For reporting-engine service, create a
file reporting-engine.json under /root/ and copy the configurations obtained from step 4
and save.

To set configurations for a service:
a. cd /rsa/metrics/elastic/set-config
b. invoke --file <absolute path of the path>

For example, invoke —--file /root/reporting-engine.json

Data Retention Policy

You can configure the retention policy for monitors (alerts triggered) and metrics based on age and
size.

By default, 90 days of data with 100 GB of size for monitors (alerts triggered ) and 30 days of data
with 100 GB of size for metrics are retained.

To change the configure for monitors (alerts triggered) retention:

1.
2.

SSH to Admin Server.

connect to metrics-server using nw-shell.
Go to alert-retention-threshold using command:
cd /rsa/metrics/elastic/data/retention/alert-retention-threshold

Set the value between 1day to 90days.
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For example, set 50days

5. Restart metrics-server using command:

service rsa-nw-metrics-server restart

To change the configuration for metrics time threshold:
1. SSH to Admin Server.
2. Connect to metrics-server using nw-shell.
3. Go to time-threshold using command:
cd /rsa/metrics/elastic/data/retention/time-threshold
4. Set the value from 1day to 90days.
For example, set 40days
5. Restart metrics-server using command:

service rsa-nw-metrics-server restart

To change the size configuration:
1. SSH to Admin Server.
2. Connect to metrics-server using nw-shell.
3. Go to allocated-size using command:
cd /rsa/metrics/elastic/data/retention/allocated-size
4. Set the value.
For example, set 200GB
5. Restart metrics-server using command:

service rsa-nw-metrics-server restart

Note: Make sure the /var/netwitness partition on standalone Health and Wellness has enough
disk space. After you review your datastore configuration, you may determine that you need to add
a new volume. For more information on adding a new volume, see “Add New Volume and Extend
Existing File Systems” topic in the Virtual Host Installation Guide.
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Backup and Restore Health and Wellness (BETA)

Perform the following in the below order:

L.

Back up the Admin Server. For more information on the instructions, see "Disaster Recovery
(Back Up and Restore)" topic in Recovery Tool User Guide.

At the root level, type the following command on the host in which Health and Wellness is
installed (Standalone virtual host only):

nw-recovery-tool —--export --dump-dir /var/netwitness/backup --category
Search

Note: Make sure that the Admin Server is restored, up and running successfully.

Restore the Health and Wellness using the following command:

nw-recovery-tool —--import --dump-dir /var/netwitness/backup --category
Search

Note: Restore the search category (Health and Wellness) on the same host in which Health
and Wellness is installed.

Reboot the Host on which search category (Health and Wellness) is restored.

5. Restore the Kibana default content using nw-shell:

a. SSH to Admin Server and connect to nw-shell.

b. Connect to metrics Server using the following command:
connect metrics-server

c. Log in with the username and password.

d. Navigate to restore path:
cd /rsa/metrics/content/restore-content

e. Invoke the method using the following command:

invoke
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Troubleshooting Health and Wellness (BETA)

This topic describes how to troubleshoot Health & Wellness issues related to the third-party tool
Kibana.

Unable to view data in the Kibana UI.

1. Go to https://<admin-server-ip>:9200
JSON response is displayed.

2. If the JSON response is not displayed, there is some issue
with the Elasticsearch. You must check logs on host on

which you have deployed Health and Wellness at
/var/log/netwitness/elasticsearch.log

1. SSH to the Host on which you have deployed Health and
wellness. For example, Admin Server.

2. Execute the following command to check the health of

Elasticsearch:
curl https://localhost:9200/ cat/health -k

—u username :password

The Elasticsearch Status should be Green.

Unable to load kibana UI.

1. Go to https://<admin-server-ip>:5601/status

2. Check the status of Kibana. The Kibana Status should be
Green.

An error ‘n of m shards failed’ or “‘unknown field in the index’ in the Kibana UI.

You must refresh the index patterns, perform the following:
1. Log in to Kibana and go to Management > Index Patterns.
2. Click nw* index pattern.

3. Click Refresh to refresh the index pattern on top right corner.

Note: If the issue still persists, refresh other index patterns such as nw-
metricbeat* or nw-concentrator* and so on.

Time out error occurs when you reset or restore OOTB content.

You must ignore the error as reset or restore OOTB content will be updated
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successfully.

Few Kibana visualizations fails.

After you install Health and Wellness Beta, few Kibana visualizations fails with an
error “Could not locate that index-pattern (id: nw-metricbeat), [click here to re-
create it]”.

Y ou must import missing OOTB content, perform the following:
1. SSH to Admin Server and connect to nw-shell.
2. Login to nw-shell and enter the username and password.

3. Connect to metric server using the following command:
connect metrics-server

4. Navigate to the restore option using the following command:
cd /rsa/metrics/content/restore-content

5. To invoke the method, using the following command:
invoke

This will import the missing OOTB content and any changes made to the existing
content is not affected.

Issue with disable-all for launch services.

If you have customized the configuration for a launch service, metrics reporting is
not stopped even if disable-all is enabled.

You must restart the launch service for which configuration is customized. For
example, if the configuration is customized for Context Hub Server, restart
contexthub-server.

Unable to send data to elastic search once disk usage reaches 80% or above.

If the Elasticsearch disk usage reaches 85% or above,

the saved objects (index patterns, dashboards, visualizations etc) becomes read-only
mode.

And, services does not write new metrics to Elasticsearch or allow to edit any saved
objects.

To change the indexes to write mode, you must execute the following command on
the host in which Elasticsearch is installed:

curl -k --cert /etc/pki/nw/elastic/elasticsearch-cert.pem --
key /etc/pki/nw/elastic/elasticsearch-key.pem -X PUT -H
"Content-Type: application/json" -d '{"index.blocks.read only
allow delete": null }' https://localhost:9200/ all/ settings
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Note: This command is supported only with certificates.
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Manage NetWitness Platform Updates

RSA issues NetWitness Platform software version updates on a regular basis as it strives to continually
improve the product. A software version update consists of a release, service pack, or patch (including
security patch) and ancillary software on which the release, service pack, or patch depends. User guides
are provided for each software version update release, which include detailed steps for installing the
update. It is important that you download the update guide for the release from RSA Link
(https://community.rsa.com/community/products/netwitness) and follow the steps described there.
Additional information is available in the "Apply Version Updates to a Host" topic in the Hosts and
Services Getting Started Guide and in System Updates Panel - Settings Tab.
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Reissue Certificates

Introduction

For a secure deployment, NetWitness Platform has installed internal RSA-issued certificates such as CA
Certificate and Service certificates .

The validity for NetWitness Platform certificates are as follows:

o CA root certificate for 11.x deployment is valid for 10 years
o CA root certificate for 10.6.x deployment is valid for 5 years

« Service certificates are valid for 1000 days

When these certificates are about to expire or have expired, you must renew and reissue the certificates
as soon as possible to avoid any issues with your NetWitness deployment.

Note: You can view the expiration details, by executing the ca-expire-test-sh script on the
NetWitness Server. For more information, see Reissue root CA security certificates on RSA
NetWitness Platform 11.x and download the script.

CA Certificate Reissue

To renew the CA certificates, do the following:

o Before you upgrade from 10.6.x to 11.x, check the expiry and reissue those certificates. For more
information, see the Reissue root CA security certificates on RSA NetWitness Platform 11.x.

o Ifyouare on 10.6.x , check the expiry and reissue all the certificates. For more information, see the
Reissuing security certificates on RSA NetWitness Platform 10.6.x.

Note: If you have Windows Legacy Collectors (WLC) in your deployment, renew the CA certificate
of the WLC after renewing the CA certificate of the NetWitness Admin Server.

Service Certificate Reissue

To renew the Service certificates, do the following:

o If your hosts are on NetWitness Platform 11.3 or later, you must use the cert-reissue script. For
more information, see the Reissuing Service Certificate .

o If your hosts are on 11.1.x or 11.2.x, you must upgrade the NetWitness Platform to 11.3 or later and
run the cert-reissue script.
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Note: If you have a host that is decommissioned or plan to remove, do not renew the certificate for
that host.

Reissuing Service Certificate

You can reissue service certificates in the following two ways.
o All at once
Reboot NW Server host after the cert-reissue --host-all command completes.
e One at a time
Reissue the NW Server host certificates first, restart the host, then reissue each component host.

IMPORTANT: If you are reissuing certificates for each host individually (one at a time), you must
reissue the certificate for the NW Server host before you can reissue certificates for any other host.
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When to Use the --host-all Argument

Use the cert-reissue --host-all command string if you have a large number of hosts. Make sure
that:

o All your hosts are running 11.3.0.0 or later.
o All your hosts are online.

o The N'W Server host run time services are running.

cert-reissue Arguments and Options for All Hosts

The following tables lists the argument you can use to reissue certificates for all hosts at one time. See
Troubleshooting Cert-Reissue Command for additional options you can use with Customer Support to
troubleshoot errors.

T

--host-all Reissues certificates for all hosts at one time applying system health checks and
restarts services.

Note: If even one host is not online, this command fails. If you have numerous hosts
in your deployment, make sure that all hosts are up and running.

Caution: Make sure you do not run this argument on a node or host that you plan to remove or
decommission.
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When to Use the Individual Host Arguments (--host-id <id>,

--host-name <display-name>, --host-addr <ip/hostname>)

The cert-reissue --host-id <id>, cert-reissue --host-name <display-name>, Or

cert-reissue --host-addr <ip/hostname> reissues a certificate for an individual host. You may
want to reissue certificates for an individual host if you have a small number of hosts.

Make sure that:

o Each host is running 11.3.0.0 or later.

o Each host is online.

o The N'W Server host run time services are running

¢ You reissue certificates for the NW Server host first.
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cert-reissue Arguments and Options for a Single Host

The following tables lists the arguments and options you can use to reissue certificates for a single host
(one host at a time). For more information, see the Troubleshooting Cert-Reissue Command section on
the additional options you can use with Customer Support to troubleshoot errors.

Note: You must run the command for the NW Server host first and reboot that host before you run the
command for each component host.

pomens [oescrpion

--host-id <id>

--host-
name <display-
name>

--host-
addr <Hostname-

in UI>
or

--host-
addr <hostname>

Reissues certificate for the host identified by <id> (host identification code).

Reissues certificate for host identified by <display-name>.

display-name is the value shown under Name in the ADMIN > Hosts View in
the NetWitness Platform Interface.

Reissues certificate for the host identified by the value shown under Hostname in
the ADMIN > Hosts > Edit dialog in the NetWitness Platform Interface. This
value can be an ip-addres (default) or a user-specified name.

Edit Host

112Core

<ip-address>

Cancel

You can change the
default <ip-address>to a
user-specific name.

Edit Host

Name

Hostname
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Reissuing Certificates for All Hosts Except Windows Legacy
Collection (WLC) host

Use the cert-reissue command to reissue certificates for all hosts except the WLC host with the
following procedures.

Running the Cert-Reissue Command for All Hosts

1. SSH to the NW Server host.

2. Submit the appropriate command string.
cert-reissue --host-all

Running the Cert-Reissue Command for an Individual Host

1. SSH to the NW Server host.

2. Submit the appropriate command string (that is cert-reissue --host-id or --host-name or
--host-addr). Each of the following command strings is an example of how you reissue
certificates for a specific host.

¢ —-host-id <host-identification-code>
e —--host-name <named-displayed-under-Name-in-Hosts-view>
e ——host-addr <ip-address-default-hostname-or-user-specified-hostname>

Reissuing Certificates for a WLC Host

You must use the wlc-cli-client utility to reissue certificates for a WLC host (you cannot use the
cert-reissue command). You also need to specify a number of WLC identification parameters with
this utility.

Note: The certificates for a Windows Legacy Server host are stored in the following directories on the
host.

C:\ProgramData\netwitness\ng\logcollector cert.pem
C:\ProgramData\netwitness\ng\logcollector dh2048.pem

Th validity period of WLC certificates can range from 2 to 20 years. If you rename or remove the files
and restart NwLogCollector Service, NetWitness regenerates them.

/ssl/truststore.pem - is no longer used in 11.x

Every reissue of a certificate on the Windows Legacy server creates a new private key.
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To reissue certificates on a WLC host.
1. SSH to the NW Server host.

2. Submit the following command string.

wlc-cli-client --cert-renew --host <wlc-host-ip-address> --port 50101 --
use-ssl false —--username <wlc-username> --password <wlc-password> --ss-—
username <deploy-admin-username> --ss-password <deploy-admin-password>

Successful Reissue Summary Report

When you run cert-reissue --host-all , the following summary report will be displayed if all
hosts are online, all run time services are running, and all hosts on version 11.3.0.0 or higher.

Fm———————— e ittt = P e e e e e e e —————— +
| | Host | Status | Message |
Fom—————— Fmm e —————————— e t——————— e |
|<host-id>| <IP-address> |Success |Cert reissue successful |
|<host-id>| <]IP-address> |Success |Cert reissue successful |
|<host-id>| <IP-address> |Success |Cert reissue successful |
|<host-id>| <IP-address> |Success |Cert reissue successful |
|<host-id>| <IP-address> |Success |Cert reissue successful |
e e o +

Unsuccessful Reissue Summary Reports

Y ou must contact Customer Support (https://community.rsa.com/docs/DOC-1294) to troubleshoot

problems. You know there is a problem if any <host-id> does not return a SuccessStatus. Success

indicates that certificates were reissued for a host. The following examples illustrate unsuccessful
reissues.

Reissue Failed for Host and Aborted Command

The following three examples illustrate the failure of certificate reissuing for any hosts.

fmmmmmm e T fommmmm e +
| | Host | Status | Message |
fommmem e o e T e ——— |
|<host-id>| <IFP-address> |Failed! |failed to connect, is host online? |
|<host-id>| <IP-address> |Failed! |service(s) down |
| <host-id»>| <IP-address> IN/A | [ Skipped... ] |
| <host-id>| <IP-address> IN/A | [ Skipped... ] |
|<host-id»| <IP-address> IN/A | [ Skipped... ] |
e e $mmmmmm e T e +
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| Status | Message

|<host-id>»| <IP-address>

|<host-id>| <IP-address>

|<host-id>»| <IP-address> IN/A | [ Skipped... ] |
| <host-id>| <IP-address> IN/A I[ Skipped... ] |
|<host-id>| <IP-address> IN/A |[ Skipped... ] |
R fmmm e R e +

Reissue Certificate Partially Executed

B T +

B b |

|IFailed! |version <version-earlier-than-11.3.0.0> not supported|

|Failed! |version <version-earlier-than-11.3.0.0> not supported|

The NW Server Host certificates were reissued but failed to properly distribute the reissued certificates
to one or more component hosts.

| <host-id>| <IP-address>

|<host-id>| <]P-address>

| | Host

| <host-id>| <IP-address>

| <host-id>| <IP-address> IN/2 | [ Skipped.. ]

| <host-id>| <IP-address> IN/A | [ Skipped... ]

| <host-id>| <IP-address> IN/A | [ Skipped... ]

|<host-id>| <IP-address> IN/A | [ Skipped... ]

tmmm—————— e ———— e ————— e e e e e e e e e e e e e e e e e e e e e ————————— +

i
B ommmmmmmm oo —
| Status | Message

o e

|Partial |Reissue completed, triggers failed
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Display System and Service Logs

NetWitness Platform provides views into system logs and service logs. When you view service logs, you
can select messages for the service or host.

View System Logs

1. Goto ADMIN > System.
2. In the options panel, select System Logging.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Hosts S Event Sources  Endpoint Sources  Health
Info System Logging
Updates

Realtime | Historical | Seftings
Licensing

ALL - Search
Email

N Timestamp Level | Message
Global Notifications
0:0:1%l0, 10.4.61.95, 127.0.01])
Legacy Notifications

I System Logging

Global Auditing

LicensingMiscConfiguration changed by sdmin

Conversion to Listfailed n to ContextHub was not established

Jobs

cConfigurati admin

Live Services
nfigurati admin
URL Integration nfigurati

Context Menu Actions nfigursti

Investigation nfigurati

unch.aplwransport client RequestTimeoutException: Request to esa-an: ady timed out at com.rse.asoc.|

ESA Analytics

Cloud Gateway
‘Whois

HTTP Proxy Settings

NTP Settings

Display Service Logs

To display NetWitness Platform service logs:
1. Goto ADMIN > Services.

2. In the Services list, select a service.
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3. Inthe Actions column, select View > Logs.

RSA RESPOND  INVESTIGATE MONITOR CONFIGURE  ADMIN
Hosts  Sel Event Sources  Endpoint Sources  Health & Wellness

£ Chang conc - Concentrator | Logs

System

Security

(@) admin

System Logging
Realtime Histarical

~ || Keywords Concentrater v | Search
Tmestamp Level | Message

EBUG  Saved configuration to fetc/n

R R R R R T ]

RS /\ NETWITNESS' PLATFORM 113.00

Filter Log Entries

To filter the results shown in the Realtime tab:

1. (Optional) For system and service logs, select a Log Level and a Keyword, or both. System logs
have seven log levels. Service logs have only six log levels because they do not include the TRACE

level. The default is ALL log entries.

2. (Optional) For service logs, select the Service: host or service.

Click Filter.

The view is refreshed with the most recent 10 entries matching your filter. As new matching log

entries become available, the view is updated to show those entries.

Show Details of a Log Entry

Each row of the Realtime tab Log list provides the summary information of a log entry. To view

complete details:

1. Double-click a log entry.

The Log Message dialog, which contains the Timestamp, Logger Name, Thread, Level and

Message, is displayed.
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Log Message

Timestamp 2019-02-01T21:46:30.000 2
Logger Mame Ping

Thread

Level DEBUG

Message has received a ping command, a reply of 51 bytes was sent
1 2

2. After viewing, click Close.

Access Reporting Engine Log File

All Log Files

The Reporting Engine stores the following logs in the rsasoc/rsa/soc/reporting-engine/log
directory:

o Current logs in the reporting-engine.log file.
o Backup copies of previous logs in the reporting-engine. log. * file.
o All UNIX script logs in the files that have the following syntax: reporting-engine.sh

timestamp.log (for example, reporting-engine.sh 20120921.10g9).

The Reporting Engine rarely writes command line error messages to the rsasoc/nohup.out file.

Upstart Logs

The Reporting Engine appends the log messages and output written by upstart daemon and the commands
used to start the reporting-engine to the /var/log/secure directory.

An upstart log file is a system log file, which means that only the root user can read it. The Reporting
Engine generates log files, retains backup copies of previous log files, stores UNIX script log files, and
appends upstart log files to another directory.

Search and Export Historical Logs

NetWitness Platform provides a searchable view of the NetWitness Platform log or the service log in a
paged format. When initially loaded, the grid shows the last page of the log entries for the system or the
service. You can export logs from the current view.
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Display the Historical System Log

To display the historical log for the system:
1. Goto ADMIN > System.
2. In the options panel, select System Logging.
The System Logging panel is opened to the Realtime tab by default.
3. Click the Historical tab.
A list of historical logs for the system is displayed.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Hosts S s Event Sources Endpoint Sources  Health & System  Se

Info cto aseins

System Logging
Updates

Realtime | Historica Sattings
Licensing

End Date ALL v || Keywords Search % Export

Email

Timestamp Level | Message

Global Notifications
Legacy Notifications

| System Logging
Global Auditing
Jobs

Live Services

URL Integration
uthentication failure far.
Context Menu Actions
Invastigation

ESA Analytics

Cloud Gateway
Whois

HTTP Proxy Settings

NTP Settings

20 LicensingMiscConfiguration changed by admin
& ¢ | Page|103] of 103 | N Displaying 5101 - 5142 of 5142

Display a Historical Service Log

To display the historical log for services:
1. Select ADMIN > Services.
2. Select a service.
3. Inthe Actions column, select View > Logs.
The service logs view is displayed with the Realtime tab open.

4. Click the Historical tab.
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A list of historical logs for the selected service is displayed.

RSA| RESPOND  INVESTIGATE MONITOR CONFIGURE ADMIN

Hosts  Services Event Sources Endpoint Sources Health & Wi S Security

£ Changg e B broker - Broker Logs

System Logging

Realtime Historical
Start Date End Date AL v | Keywords Broker ~ || Search 2 Export
Timestamp Level | message

201
62302050987 eb7

nw- Exception std:-exception:what: Parameter username: Value cannot be empty

d & ping command, a reply of

) hes logg:

. sent 13 69 KB over life of connectior
Ingzed off user

d & ping command, a reply of

o o

216000 min hias been granted QT

207 18:52:16.000 User admin (session 57478

{ | Paze 200 of200 | (e Displaying 9951 - 10000 of 10000

RS /\ NETWITNESS' PLATFORM 11300

Search Log Entries

To
1.
2.

search the results shown in the Historical tab:
(Optional) Select a Start Date and End Date. Optionally, select a Start Time and End Time.

(Optional) For system and service logs, select a Log Level and a Keyword, or both. System logs
have seven log levels. Service logs have only six log levels because they do not include the TRACE
level. The default is ALL log entries.

(Optional) For service logs, select the Service: host or service.

Click Search.
The view is refreshed with the most recent 10 entries matching your filter. As new matching log
entries become available, the view is updated to show those entries.

Show Details of a Log Entry

Each row of the Historical tab Log grid provides the summary information of a log entry. To display all
the details for a log message:

1. Double-click a log entry.
The Log Message dialog, which contains the Timestamp, Logger Name, Thread, Level and
Message, is displayed.
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Log Message

Timestamp 2019-02-01721:46:30.000
Logger Name Ping

Thread

Level DEBUG

Message has received a ping command, a reply of 51 bytes was sent

2. After viewing, click Close.

Page Through Log Entries

To peruse the different pages of the list, use the paging controls on the bottom of the grid as follows:
o Use the navigation buttons

o Manually type the page number you want to view, and press ENTER.

Export a Log File

To export the logs in the current view:

Click Export, and select one of the drop-down options: CSV Format or Tab Delimited.

The file is downloaded with a filename that identifies the log type and the field delimiter. For example,
a NetWitness Platform system log exported with comma-separated values is named UAP log export
CSV.txt, and a host log exported with tab-separated values is named APPLIANCE log export
TAB.txt.
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Maintain Queries Using URL Integration

A URL integration provides a way to represent the bread crumbs, or query path, you take when actively
investigating a service in the Navigate view. You do not need to display and edit these objects often.

A URL integration maps a unique ID that is automatically created each time you click on a navigation
link in the Navigation view to drill into data. When the drill-down completes, the URL reflects the query
IDs for the current drill point. The Display Name is displayed in the bread crumb in the Navigate view.

The URL Integration panel provides a list of queries and allows users who have the proper permissions
to modify this underlying source of data and analyze the query patterns of other users of the NetWitness
Platform system. Within the panel, you can:

o Refresh the list.

o Edit a query.

o Delete a query.

o Clear all queries in the list.

Caution: After a query has been removed from the system, any Investigation URLs that included the
ID of that query will no longer function.

Edit a Query
1. Goto ADMIN > System.
2. In the options panel, select URL Integration.

URL Integration

= 4 | ORefresh & Clear

Page 1 | of1 |

I

Select the row in the grid and either double-click the row or click |ﬁ

The Edit Query Dialog is displayed.

O Display Name Query Username When Created ~

O o nwappliance11639 did = "nwappliance1163% admin Tue Jul 11 2017 06:40:09 +00:00 (UTC)
[ threat.category ='spe...  threat.category = 'spectrum’ admin Tue Jul 11 2017 08:35:33 +00:00 (UTC)
O 2 CONTENt = 'Spectrum.C..  CONTENT ='spectrum.consume’ admin Tue Jul 11 2017 08:41:33 +00:00 (UTC)
[ content = 'spectrum.a..  content = 'spectrum.analyze’ admin Tue Jul 11 2017 08:45:09 +00:00 (UTC)
O a4 Ewu.edu domain.dst ="gwu.edu’ admin Tue Jul 11 2017 09:37:28 +00:00 (UTC)
0 s 10.100.33.1 ip.src=10.100.33.1 admin Wed Jul 12 2017 02:42:56 +00:00 (UTC)
O s ip.src="127.0.0.1" ip.src=127.0.0.1 admin Wed Jul 12 2017 09:35:24 +00:00 (UTC)
[ top.srcport = 34004 tep.sreport = 54004 admin Wed Jul 12 2017 09:37:44 +00:00 (UTC)
O s nwappliance23912 did = 'nwappliance23912° admin Wed Jul 12 2017 11:09:05 +00:00 (UTC)
O @ Ewu.edu domain.sre = gwu.edu’ admin Thu Jul 13 2017 13:58:52 +00:00 (UTC)
O 1o OTHER service =0 admin Fri Jul 14 2017 04:56:50 +00:00 (UTC)
O 11 test dom alert = 'test dom’ admin Fri Jul 14 2017 09:5%:43 +00:00 (UTC)

Displaying 1-12 of 12
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Display Name content = 'spectrum.consume’

Query content = 'spectrum.consume’

Cancel Save

4. Edit the Display Name and the Query, but do not leave either field blank.

5. To save the changes, click Save.

Delete a Query

Caution: After a query has been removed from the system, any Investigation URLs that included the
ID of that query will no longer function.

To remove a query from NetWitness Platform entirely:
1. Select the query.
2. Click =

A dialog requests confirmation that you want to delete the query.

3. Click Yes.

Clear All Queries
To clear all queries from the list:

« Click & Clear

The entire list is cleared.

Use a Query in a URI

URL integration facilitates integrations with third-party products by allowing a search against the
NetWitness Platform architecture. By using a query in a URI, you can pivot directly from any product
that allows custom links, into a specific drill point in the Investigation view in NetWitness Platform.

The format for entering a URI using a URL-encoded query is:

http://<nw host:port>/investigation/<serviceld>/navigate/query/<encoded
query>/date/<start date>/<enddate>
where
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e <nw host: port> is the IP address or DNS, with or without a port, as appropriate (ssl or
not). This designation is only needed if access is configured over a non-standard port through a
Proxy.

e <serviceId> is the internal Service ID in the NetWitness Platform instance for the service
to query against. The service ID can be represented only as an integer. You can see the
relevant service ID from the url when accessing the investigation view within NetWitness
Platform. This value will change based on the service being connected to for analysis.

e <encoded query> is the URL-encoded NetWitness Platform query. The length of query is
limited by the HTML URL limitations.

e <start date> and <end date> define the date range for the query. The formatis <yyyy-
mm-dd>T<hh :mm>. The start and end dates are required. Relative ranges (for example, Last
Hour) are not supported in this version. All times are run as UTC.

For example:
http://localhost:9191/investigation/12/navigate/query/alias%20exists/date
/2018-09-01T00:00/2018-10-31T00:00

Examples

These are query examples where the NetWitness Server is 192.168.1.10 and the servicelD is identified
as 2.

All activity on 03/12/2018 between 5:00 and 6:00 AM with a hostname registered

e Custom Pivot: alias.host exists

e https://192.168.1.10/investigation/2...13-03-12T06:00

All activity on 3/12/2018 between 5:00 and 5:10 PM with http traffic to and from IP address 10.10.10.3

e Custom Pivot: service=80 && (ip.src=10.10.10.3 || ip.dst=10.0.3.3)
e Encoded Pivot Dissected:

e service=80 => service&3D80

e ip.src=10.10.10.3 => ip%2Esrc%3D10%2E10%2E10%2E3

e ip.dst=10.10.10.3 => ip%2Esrc%3D10%2E10%2E10%2E3

e https://192.168.1.10/investigation/2...13-03-12T17:10

Additional Notes

Some values may not need to be encoded as part of the query. For example, commonly the IP source
(src) and destination (dst) is used for this integration point. If leveraging a third-party application for
integration of this feature, it is possible to reference those without encoding applied.
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Configure FIPS Support

NetWitness Platform 11.x ships with FIPS-validated 140-2 Cryptographic Modules that support all
cryptographic operations within NetWitness Platform. NetWitness Platform leverages two modules that
support a level three design assurance:

« RSA BSAFE Crypto-J
« RSA OwB

Both modules have been certified with an operational environment comparable to the standard
NetWitness Platform configuration.

By default, the cryptographic modules enforce the usage of FIPS-certified cipher suites wherever
possible. For exceptions, refer to the information below and to the release notes. For additional
information about the FIPS modules, see https://csrc.nist.gov/publications/detail/fips/140/2/final.

The RSA BSAFE Crypto-J FIPS Certificate number is 3172, and OwB uses the CCME FIPS Module in
FIPS-approved mode.

In 11.x, FIPS is enabled on all services except Log Collector. This includes Log Decoder and Decoder if
they were FIPS-enabled in 10.6.x or any previous version. FIPS cannot be disabled on any services
except for Log Collector, Log Decoder and Decoder.

Note: For a fresh installation of 11.x, by default, all core services will be FIPS enforced except Log
Collector and Log Decoder. FIPS cannot be disabled on any services except for Log Collector, Log
Decoder and Network Decoder.

Note: For upgrades to 11.x from previous versions, the following conditions apply for the Log
Collector, Log Decoder and Decoder services:

- Log Collector is not FIPS enabled after upgrading to 11.x, even if FIPS was enabled in a previous
version. You must enable FIPS support after upgrading to 11.x. See the instructions in FIPS support for
Log Collectors.

- If FIPS was enabled for the Log Decoder and Network Decoder services in a prevous version, FIPS
will also be enabled in 11.x. However, if Log Decoder and Network Decoder were NOT FIPS
enabled in a previous version, they will not be enabled in 11.x, and you can manually enable FIPS for
these services if required. See the instructions in FIPS support for Log Decoders and Decoders.
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FIPS support for Log Collectors

To enable FIPS for Log Collectors:

1.
2.

Stop the Log Collector service.

Open the /etc/systemd/system/nwlogcollector.service.d/nwlogcollector-opts-—
managed.conf file.

Change the value of the following variable to off as described here:
Environment="OWB ALLOW NON FIPS=on"

to

Environment="OWB ALLOW NON FIPS=off"

Reload the system daemon by running the following command:
systemctl daemon-reload

Restart the Log Collector service.

Set the FIPS mode for the Log Collector service in the UI :

Note: This step is not required if you are upgrading from 10.6.x to 11.x and FIPS was enabled in
10.6.x.

a. Goto ADMIN > Services.
b. Select the Log Collector service and go to View > Config.
c. In SSL FIPS Mode, select the checkbox under Config Value and click Apply.

FIPS support for Log Decoders and Decoders

To enable FIPS for Log Decoders and Decoders that did not have FIPS enabled in 10.6.x:

L.

Go to ADMIN > Services and select a Log Decoder or Network Decoder service.
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2. Select View > Config, and in System Configuration, enable SSL FIPS Mode by selecting the
check box in the Config Value column.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Hosts ervices  Event Sources  Endpoint Sources  Health & Wellness

# Change Service ELHYB-Log Decoder |  Config

General Files Data Retention Scheduler ~ App Rules  Correlation Rules Feeds Parsers Parser Mappings Data Privacy ~ Appliance Service Configuration

System Configuration Enable All  Disable Al

Name Config Value sk (Enabled), generated only in memory for other Decoder content use
Com) o
~ Name Config Value
Port 50002
0 © ALERTS Enabled
56002 3 DOMAINSCAN Enabled
002
1000 @ EMAILSCAN Enabled
100
2 # FeedParser Enabled
a
# file_category Enabled =
Log Decader Configuration
g gurat Can arcare Confio a .
Service Parsers Configuration Enable Al Disable Al
Name Config Value
Name Config Value
= Adapter

accurey ™
Berkelsy Packet Filter
acdancevantage ™
Capure Interface Selected log_events,Log Events
actvidentity ™
= Cache
aforecloudiink ™
Cache D varinemit
sirdefense 4
Cache Size 4GB
sirmagnet m]
3 Capture Settings
| [ airtighme ™
Assembler Maximum Size 32 MR
—ine I~ s

RS /\ NETWITNESS' PLATFORM

3. Restart the service.

4. Click Apply.
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Manage the deploy_admin Account

The deploy admin account is a system account that is used throughout multiple NetWitness Platform
components for system-specific access. It is a password-based account that may need periodic password
updating if deployment environment policies require it. The deploy admin account is used on every
NetWitness Platform host, and must be kept in sync between all hosts. Prior to 11.4.1, the process to
change the deploy admin account required administrators to log into every NetWitness Platform host
and run the /opt/rsa/saTools/bin/set-deploy-admin-password script on each system. Starting
with 11.4.1, the deploy admin password is centrally managed with the nw-manage script on the NW
Server. nw-manage script execution updates the password on all NetWitness Platform component hosts
that use the deploy admin account. The nw-manage script output displays the password update results
for each host. If a NetWitness Platform component host is down or unreachable for any reason, the nw-
manage script provides an additional option to synchronize the deploy admin password on the
previously unresponsive host with the NW Server when that host becomes available again.

The following procedures describe how to change the deploy admin password for all hosts in your
environment, for hosts in a mixed version environment, and for hosts that are unavailable during the first
attempt to change the deploy admin password.

Change the deploy_admin Account Password

1. Log in to the NW Server host using SSH or the NwConsole.

2. Run the following command:
nw-manage --update-deploy-admin-pw
A prompt for the new password is displayed.

3. Enter the new password.

Change the deploy_admin Account Password in a Mixed

Version Environment

If you are operating in a mixed version environment (for example, NW Server is on a newer version
(greater than or equal to 11.4.1) and the NW component hosts are still on an older version of NetWitness
(less than 11.4.1), the nw-manage script prompts you to run the /opt/rsa/saTools/bin/set-
deploy-admin-password script on those older component hosts first. After the hosts on the older
versions are updated, you rerun the nw-manage script on the NW Server with the --skip-version-
checks argument.

1. On each component host that is on an older version, reset the deploy admin password by running
the following command:
/opt/rsa/saTools/bin/set-deploy-admin-password
This resets the deploy admin password on all the component hosts with the older versions.

2. Log in to the NW Server host using SSH or the NwConsole and run the following command:
nw-manage --update-deploy-admin-pw --skip-version-checks
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A prompt for the new password is displayed.

3. Enter the new password.

Change the deploy_admin Account Password for a

Component Host that is Unavailable

If a component host is down or otherwise unreachable the first time you run the nw-manage script, it is
identified as skipped in the nw-manage --update-deploy-admin-pw output. When the host is back
online, its deploy admin password must be synchronized with the NW Server.

To synchronize the previously unreachable host with the NW Server:
1. Log in to the NW Server host using SSH or the NwConsole.

2. Run the following command:
nw-manage --sync-deploy-admin-pw -—-host-key <ID, IP, hostname or display

name of host>
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Change Host IP Addresses

This topic describes how to change IP addresses for NetWitness Servers and component hosts.

This covers how to change the IP address for:

An N'W Server Host
An ESA Host

A Component Host - Archiver, Broker, Concentrator, Endpoint Log Hybrid , ESA Secondary, Log
Hybrid, Malware, Network Decoder, Network Hybrid, or UEBA host

A Log Decoder-Log Collector Host with Remote Collectors
A Virtual Log Collector Host

Change an NW Server Host IP Address

To change the IP address of an NW Server host:

L.

2.

Remove hosts from Hosts view in NetWitness Platform User Interface (UI).
a. Log into the NetWitness Platform UI.
b. Goto ADMIN > Hosts.

c. Select all the hosts except for NW Server host, click the arrow next to the = (delete icon), and
select Remove Host to remove the hosts.

Warning: Do NOT remove the NW Server host.

Get the UUIDs of NW Server host and component hosts.
a. SSH to the NW Server host.
b. Run the following command to get the UUID of the NW Server host.

cat /etc/salt/minion
This is an example of the UUID for an NW Server host.
id: ba847bed-afca-4dfd-beca-ebdf7ac3a228

c. Onthe NW Server host, run the following command.
orchestration-cli-client -k
A list of host profile information is displayed, including UUIDs for each host. UUIDs host s are
shown in bold in the following example.
Key: ID=a3f9d06f-4£67-4721-9e74-1f127e24ed4ad, STATUS=Provisioned
Key: ID=992dcb26-39c2-4c29-b9c9-7£5e98£3c542, STATUS=Provisioned
Key: ID=£f8b8c231-3a04-482a-bded-5abed4a242441, STATUS=Provisioned
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3. Remove UUIDs for all hosts except the NW Server host.
In this step you remove the UUID of each host that was removed from the UI in the previous step.

Note: Make sure you DO NOT remove UUID for NW Server host itself .

a. SSH to the NW Server host.

b. Run the following command for each host that was removed from the UI, replacing <uu1D> with
the UUID of the host:
orchestration-cli-client --remove-key <UUID>
For example:
orchestration-cli-client --remove-key a3f9d06f-4f67-4721-9e74-
1fl127e24e4dad

c. Run the following commands.
rm -f /etc/netwitness/platform/legacy mongo/*

rm -f /etc/netwitness/platform/legacy rabbit/*
4. Change the IP address of the NW Server host.

a. If you are changing the IP address of the primary ESA server, make sure that your NW Server
host is pointing to the right application of the MongoDB by running the following command.
security-cli-client --set-config-prop --prop-hierarchy nw —--prop-name
rsa.data.application.servers[0] --prop-value <desired esa ip>

b. Run the following command to verify the existing ESA Primary IP address.
security-cli-client --get-config-prop --prop-hierarchy nw —--prop-name
rsa.data.application.servers[0]
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5.

8.

Edit the MongoDB on the NW Server host.

a. SSH to the NW Server host and log onto the MongoDB instance on the NW Server host by
running the following command.
mongo admin -u deploy admin -p

b. When you are prompted, enter the deploy admin password.
¢. Remove user IDs with the attributes of sms, esm, les, asg, and sa.

i. Run the following commands in the order given.
use admin
db.system.users.remove ({_id: "sms.sms"}
db.system.users.remove
db.system.users.remove ({_ id: "les.les"}

( )

({_ id: "esm.esm"})

( )
db.system.users.remove ({_ id: "asg.asg"})
db.system.users.remove ({ id: "sa.sa.<sa-server-server 1id>})
You can use the following command string to get the <sa-server-server id>.

cat /etc/netwitness/platform/nodeinfo/sa-server/service-id

ii. Verify that these user IDs have been removed by running the following command.
db.system.users.find()

d. Update the host [P address by running the following commands in the order given, replacing
<old ip> with the original IP address of the host, and <new ip> with the new IP address.

Note: Only change the NW Server host IP address entry as needed.

1. use orchestration-server

il. db.host.update ({ "hostname" : "<old ip>" },{$set: {"hostname"
"<new_ip>" } } )

e. Verify that the IP address has been updated and exit by running the following commands.
i. db.host.find()
il. exit

Update the ipv4 setting.
nw-manage —--update-host --host-id <NW Server Host UUID> --ipv4 <new_ ip>

In the user interface, check the hostname value, and if the current value is an IP address, update the
value with the new IP address.

Note: If the hostname value is a hostname and not an [P address, no action is required unless the
hostname itself was changed. If the hostname changed, update it in the user interface.

a. Goto Admin > Hosts and select the NW Server host.

b. Click the Edit icon |ﬂ, and in Hostname, update the value.
Verify the ipv4 setting has the correct new ipv4 setting.
nw-manage --list

On the NW Server host, reset the deploy admin password to the old deployment password to make
sure that it has not expired.
cd /opt/rsa/saTools/bin
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./set-deploy-admin-password
Please enter the new deploy admin account password: <old-deploy-admin-
password>

Please confirm the new deploy admin account password: <old-deploy-admin-
password>

10. Run the nwsetup-tui (Setup program) on the NW Server host.

a. For this step, you use the same tool to update the IP address as you did for the original installation
of NetWitness Platform (nwsetup-tui). You must run nwsetup-tui from a console session
(for example, Dell iDRAC). Most of the prompts are the same. The ones that are unique to
changing the IP address are described here.

i. In the NetWitness Platform Install or Upgrade pane, select option 1 Install (Fresh Install).

ii. If you see the following warning, click Yes to continue.

f Fresh Install is

e to upgrade the host.

Warming: ::-:|:|-c|:;:- data aval
selected, you will not

Are you sure you wamt to comtinue with a fresh

install?
|'=: Yes ='| TE

Note: You must use the same Master and Deploy Admin credentials that you used when
you originally installed this host.

You are prompted for the following information.

IP Address

Subnet Mask

Default Gateway
Primary DNS Server
Secondary DNS Server
Local Domain Name
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iii. (Conditional) If you imaged the host with a buildstick and selected NW Server host, you may
need to:

o Select option 2 An External Repo (on an externally-managed server) in response to the
following prompt:

MethWitness Sulte Update Repository E
The NetWitness Sulte Update Repesitory contains all the RPMs needed
to build amd maintain all the NetWitness Suite components. ALl

components managed by the WNW Server need access to the Repository.

Do you want to set up the MetWitness Suite Update Repository on:

BATh= Local Repo (on the WW Server)
' An Extermal Repo (on an extermally-managed server

oI = Exit =

o Select the appropriate directory, for example:
https://nw-node-zero/nwrpmrepo

b. After you complete the nwsetup-tui steps, run the following command.
rm /etc/netwitness/security-client/security-client-amgp.yml

c. Reboot the host.

11. Add the component hosts back to NW Server host.

After you complete the nwsetup-tui steps, you must add the component hosts, that were removed
in step "1. Remove hosts from Hosts view in NetWitness Platform User Interface (UI)," back to the
NW Server host.

Change an ESA Host IP Address

This section tells you how to change an ESA host IP address under the following two scenarios.
e Change NW Server Host IP Address and Keep Same ESA Host IP Address
o Change IP Address for ESA Host Only

Change NW Server Host Address and Keep the Same ESA Host IP
Address

To change the NW Server host IP address and keep the same ESA P address:
1. Update NW Server host IP address references on ESA hosts.
a. SSH to the ESA host.

b. Change the IP address of the NW Server host to the new IP address.

vi /etc/salt/minion
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2. Run the nwsetup-tui on the ESA host.

a.

b.

Run nwsetup-tui and follow the instructions in the prompts.

After you complete the nwsetup-tui steps, run the following command:
rm /etc/netwitness/security-client/security-client-amgp.yml

3. Set up the ESA host as the Primary ESA host on the NW Server host.

a.
b.

C.

f.

Log into the NetWitness Platform UI.
Go to ADMIN > Hosts.

Click Discover.
The ESA host is displayed in the New Hosts dialog.

Select the host and click Enable. For example:

Enan‘l{ab Reject

Host Public Key Hash

host-uuid public-key

The host is displayed in the Hosts view.

Select the ESA host and click Install.
The Install Services dialog is displayed.

In Category, click the arrow and select ESA Primary.

4. Add ESA services to deployments that you have defined, because the services are not associated
with the deployments.

a.

b.

C.

Log into the NetWitness Platform UI.
Go to CONFIGURE > ESA Rules.

Select a deployment, and under ESA Services, click + (add icon) to add the services to the
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deployment, as shown in the following image.

RSA| RESPOND  INVESTIGATE MONITOR CONFIGURE ADMIN @ admin ®
Live Content  Incident Rules Respond Notifications ESA Rules  Subscriptions Custom Feeds Log Parser Rules
Services Settings
RULES Deployment - ESA - ESA Correlation
Bt Deplo ts map rules from your rule library ta the appropriate ESA Services. Choose Rules, Services and rule execution method.
GET RULES FROM RSA LIVE .
ESA Services
DEPLOYMENTS @ — o | Choosefrom available ESA Services. Remove services from ather deployments before adding to a new one.
11-2 - ESA Correlation O |+
Advanced 0 ) | swws  Namen Address Version Last Deployment Date
Basic a ‘I ’ N e .
Click + button to add unassigned ESA services to the Deployment.
ESA e O
I ESA - ESA Correlation @D TGEICNE 4 Deploy Now
ESASEC - ESA Correlation (0]
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Live o D
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Change an ESA Primary Host IP Address Only

To change the IP address of the ESA host only:

1. Remove an ESA Primary host from the NW Server host.
a. Log into the NetWitness Platform UL
b. Goto ADMIN > Hosts.

c. Select the ESA host, click the arrow next to the = (delete icon), and select Remove Host to
remove the host.

2. Remove the UUID of the ESA Primary Host:
a. SSH to the ESA Primary host and get the UUID for the ESA host using the following command:

cat /etc/salt/minion

b. SSH to the NW Server host and run the following command for the ESA Primary host that was
removed from the UI, replacing <uu1D> with the UUID of the ESA Primary host:
orchestration-cli-client --remove-key <UUID>
For example:
orchestration-cli-client --remove-key a3f9d06f-4f67-4721-9e74-
1fl127e24edad

3. Setup the NW Server host to point to the correct MongoDB host.

a. If you are changing the IP address of the primary ESA server, make sure your that your NW
Server host is pointing to the right application of the MongoDB by running the following
command on the NW Server host:

111 Change Host I[P Addresses



System Maintenance Guide

security-cli-client --set-config-prop --prop-hierarchy nw —--prop-name
rsa.data.application.servers[0] --prop-value <desired esa ip>

b. Run the following command to verify the existing ESA Primary IP address:
security-cli-client --get-config-prop --prop-hierarchy nw —--prop-name
rsa.data.application.servers[0]

4. Run nwsetup-tui on the ESA Primary host.
For this step, you use the same tool to update the IP address as you did for the original installation of
NetWitness Platform (nwsetup-tui). You must run nwsetup-tui from a console session (for
example, Dell iDRAC). Most of the prompts are the same. The ones that are unique to changing the
IP address are described here.

a. In the NetWitness Platform Install or Upgrade pane, select option 1 Install (Fresh Install).

b. If you see the following warning, click Yes to continue.

Wi FTULI backup dat v Lat L Fras Install is
selected, you wall not be able to vpgrade the host

Are you sure you want to comtinue with a fresh

install?
|*== -“ES='| EE

Note: You must use the same Master and Deploy Admin credentials that you used when you
originally installed this host.

You are prompted for the following information.
IP Address

Subnet Mask

Default Gateway

Primary DNS Server

Secondary DNS Server

Local Domain Name

c. After you complete the nwsetup-tui steps, run the following command.
rm /etc/netwitness/security-client/security-client-amgp.yml

5. Add the ESA Primary host back to the NW Server host to set it up as the Primary ESA host.
a. Log into the NetWitness Platform UI.
b. Go to ADMIN > Hosts.

c. Click Discover.
The ESA Primary host is displayed in the New Hosts dialog.
d. Select the host and click Enable. For example:

Enan& Reject

Host Public Key Hash

host-uuid public-key
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The ESA host is displayed in the Hosts list.
e. Click Install.
The Install Services dialog is displayed.
f. In Category, click the arrow and select ESA Primary.
g. Reboot the ESA host.
h. Reboot the NW Server host.

6. Add ESA services to deployments that you have defined because the services are not associated with
the deployments.

a. Log into the NetWitness Platform UI.
b. Goto CONFIGURE > ESA Rules.

c. Select a deployment, and under ESA Services, click + (add icon) to add the services to the
deployment, as shown in the following image.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Live Content Incident Rules Respond Notifications ESA Rules  Subscriptions Custem Feeds Log Parser Rules
Services Settings
RULES Deployment - ESA - ESA Correlation
g Deployments map rules from your rule library to the appropriate ESA Services. Choose Rules, Services and rule execution method.
GET RULES FROM RSA LIVE X
ESA Services
DEPLOVMENTS @ — . | Choosefrom available ESA Services. Remove services from other deployments before adding to a new one.
11-2 - ESA Correlation [0] +
Advanced 0@ |Z swws o Neme~ Address Version Last Deployment Date
Basic o @ .
Click + button to add unassigned ESA services to the Deployment,
ESA o O
I ESA - ESA Correlation (72] show Updates = [ SN
ESASEC - ESA Correlation (0]
ESA Rules
Enrichments 0o O
All Event Stream Analysis (ESA) rules created or downloaded. Add rules to a deployment to activate them
Live o @O
+ ¥ © |Filter X
Named Window o ©
O status Rule Name ~ Trial Rule Severity Type Email snmp syslog Script | Last Modified
O Deployed Account Added to Administrators Group and Re... Yes Low RSA Live ESA Rule 8] 0 0 2019-02-01 17:01:55
[J Deployed Basic Alert RUle with single statement evaluation. Yes Low Advanced EPL @] Q (o] Q 2019-02-03 23:57:12
[J Deployed Ba T RUle with single statement evaluation...  Yes Low Rule Builder 9:42
[] Deployed Ba lert RUle with single statement evaluation. Yes Low Advanced EPL 23:57:12 v
| Page 1 nf1 | | ™ PageSize 100~ nicnlaving 1 - 79 af 7arules 7
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Change a Component IP Address

This section tells you how to change the IP address of a component host (that is, Archiver, Broker,
Concentrator, Endpoint Log Hybrid , ESA Secondary, Log Hybrid, Malware, Network Decoder Network
Hybrid, and UEBA host) under the following two scenarios.

e Change NW Server Host IP Address and Keep Same Component Host IP Addresses
o Change the Component host I[P Address Only
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Change NW Server Host IP Address and Keep Same Component Host IP

Addresses

To change the NW Server host IP address and retain the component hosts IP addresses:
1. Update NW Server host IP address references on component hosts.
a. SSH to the component host
b. Change the IP address of the NW Server host to the new IP address.
vi /etc/salt/minion
2. Run nwsetup-tui on the component host.
a. Run nwsetup-tui and follow the instructions in the prompts.
b. After you complete the nwsetup-tui steps, run the following command:
rm /etc/netwitness/security-client/security-client-amgp.yml
3. Set up a component host on the NW Server host.
a. Log into the NetWitness Platform UI.
b. Go to ADMIN > Hosts.
c. Click Discover.
The component host is displayed in the New Hosts dialog.
d. Select the host and click Enable. For example:

Enahl& Reject

Host Public Key Hash

host-uuid public-key

The component host is displayed in the Hosts list.
e. Click Install.

The Install Services dialog is displayed.
f. In Category, click the arrow and select the appropriate host type
g. Reboot the NW Server host

h. Reboot the component host.

Change a Component IP Address Only

To change a component host IP address:
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1. Remove the component host from the NW Server host using the UI:
a. Log into the NetWitness Platform UI.
b. Go to ADMIN > Hosts.

c. Select the component host click the arrow next to the — (delete icon), and select Remove Hostto
remove the host.

2. Remove the UUID of the component Host:

a. SSH to the component host and get the UUID for the host by running the following command:
cat etc/salt/minion

b. SSH to the NW Server host and run the following command for the component host that was
removed from the UI, replacing <uUID> with the UUID of the host:
orchestration-cli-client --remove-key <UUID>
For example:
orchestration-cli-client --remove-key a3f9d06f-4£f67-4721-9e74-
1fl127e24e4dad

3. Run nwsetup-tui.

For this step, you use the same tool to update the IP address as you did for the original installation of
NetWitness Platform (nwsetup-tui). You must run nwsetup-tui from a console session (for
example, Dell iDRAC). Most of the prompts are the same. The ones that are unique to changing the
IP address are described here.

a. Inthe NetWitness Platform Install or Upgrade pane, select option 1 Install (Fresh Install).

b. If you see the following warning, click Yes to continue.

Warning: backup data available f Frezsh Install

selected, you will mot be able to upgrade the host.

Are you sure you wanmt to comtinue with a fresh

install?
] ma

Note: You must use the same Master and Deploy Admin credentials that you used when you
originally installed this host.

You are prompted for the following information.
IP Address

Subnet Mask

Default Gateway

Primary DNS Server

Secondary DNS Server

Local Domain Name

c. After you complete the nwsetup-tui steps, run the following command.
rm /etc/netwitness/security-client/security-client-amgp.yml

4. Set up the component host on the NW Server host.
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a. Log into the NetWitness Platform UlI.
b. Go to ADMIN > Hosts.
c. Click Discover.
The component host is displayed in the New Hosts dialog.
d. Select the host and click Enable. For example:

Enan@ Reject

Host Public Key Hash

host-uuid public-key

The component host is displayed in the Hosts list.

Note: If the component host is the ESA secondary host, after this host is displayed in the Hosts
list, you see only one service on this host. You need to select ESA Secondary as the Category
in the following steps to install both the Correlation and Entity Behavior Analytics services
on this host.

e. Click Install.
The Install Services dialog is displayed.
f. In Category, click the arrow and select the appropriate service category.
5. Reboot the component host.

6. Reboot the NW Server host.

Change Log Decoder-Log Collector with Remote Collectors
IP Address

If you have Log Decoders set up with Remote Collectors, you must delete the Remote Collectors before
you change the Log Decoder/Log Collector host IP address, and add the Remote Collectors back after
the IP address has been changed.

To change a Log Decoder/Log Collector host IP address that has Remote Collectors:
1. Remove Remote Collectors.
a. Log into the NetWitness Platform UI.
b. Goto ADMIN > Services.
c. Select the Log Decoder service with Remote Collectors and click View > Config.

d. Select the Remote Collectors and click the arrow next to the — (delete icon) to remove them.
2. Change the Log Decoder host IP address.
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Follow the steps described in under Change [P Address of a Component Host to change the Log
Decoder host.

3. Add Remote Collectors.
a. Log into the NetWitness Platform UL
b. Go to ADMIN > Services.

c. Select the Log Decoder service and click View > Config.

d. Click + (add icon) to add the Remote Collectors.

Change VLC IP Address

Y ou must remove all entries from Destination Groups before you change the Virtual Log Collector
(VLC) IP address, and then add the Destination Group entries back after the IP address has been
changed.

1. Remove Destination Group Entries

o

Log into the NetWitness Platform Ul.

b. Goto ADMIN > Services.

c. Select the VLC service and click View > Config.

d. On the Local Collectors tab, select Destinations from the Select Configuration menu.
e. Select the destinations and click the = (delete icon) to remove them.

2. Change VLC host IP address.
Follow the steps described in under Change [P Address of a Component Host to change the VLC
host IP address.

3. Add Destination Group entries.
a. Log into the NetWitness Platform UL
b. Goto ADMIN > Services.
c. Select the VLC service and click View > Config.

d. On the Local Collectors tab, select Destinations from the Select Configuration menu.

e. Click + (add icon) to add the Destination Group entries.
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DISA STIG

Note: 11.3.1 feature - DISA STIG (Defense Information Systems Agency Security Technical
Implementation Guide) support was introduced in NetWitness Platform 11.3.1. Versions 11.0.0.0 to
11.3.0.0 do not support DISA STIG.

RSA NetWitness Platform version 11.3.1 supports all Audit Rules in the DISA STIG Control Group.
RSA will expand its support of STIG rules in future NetWitness Platform versions.

This section includes the following topics.

How STIG Limits Account Access

NetWitness Passwords

Generate the OpenSCAP Report

Manage STIG Controls Script (manage-stig-controls)
Rules List

Exceptions to STIG Compliance

IMPORTANT: All rules are enabled by default except for control goup 1-ssh-prevent-root an
control group 3-fips-kernel. You can enable or disable rules by control group using the manage-
stig-controls script.

How STIG Limits Account Access

The STIG hardening RPM helps to lock down information, systems, and software, which might
otherwise be vulnerable to a malicious computer attack by limiting account access to a system. For
example, the STIG script:

o Ensures that the account password has a length, complexity, expiration period, and lockout period that
are in accordance with DISA best practices.

o Applies auditing and logging of user actions on the host.

NetWitness Passwords

RSA NetWitness Platform requires passwords that are STIG compliant.

Generate the OpenSCAP Report

Security Content Automation Protocol (SCAP) is a line of standards or rules managed by the National
Institute of Standards and Technology (NIST). It was created to provide a standardized approach to
maintaining the security of enterprise systems, such as automatically verifying the presence of patches,
checking system security configuration settings, and examining systems for signs of compromise.
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The OpenSCAP report evaluates your environment against the SCAP rules. The results are sent to the
HOSTNAME-ssg-results. (XML |HTML) depending on the output format you select.

Disable Rules in OpenSCAP Report that Hang the Report

There may be STIG rules that you do not want to include in the OpenSCAP report because they make
the report hang. Use the following command to disable items on the SCAP report:

sed -1 's/select idref="rule-id" selected="true"/select idref="rule-id"
selected="false"/g' /usr/share/xml/scap/ssg/content/ssg-rhel7-xccdf.xml

where rule-id is the Rule ID that you can replace with the Rule ID that may hang during a test.

For example, the report has a rule ID called partition for audit (shownas Rule ID:
partition for audit). If you disable a rule, OpenSCAP does not check against that rule. This
means that you need to check for compliance to the partition for audit rule manually.

Install OpenSCAP

Y ou must
1. SSH to the host.

2. Create a centos-Base.repo file under /etc/yum. repos.d directory.
The following example shows the contents of the centos-Base. repo file.

[base]

name=CentOS-$releasever - Base
mirrorlist=http://mirrorlist.centos.org/?release=Sreleasever&arch=S$basearch&repo=os
baseurl=http://mirror.centos.org/centos/$releasever/os/$basearch/

enabled=1

gpgcheck=1

gpgkey=file:///etc/pki/rpm-gpg/RPM-GPG-KEY-Cent0S-5

priority=1

#freleased updates

[updates]

name=CentOS-$releasever - Updates
mirrorlist=http://mirrorlist.centos.org/?release=Sreleasever&arch=$basearché&repo=updates
baseurl=http://mirror.centos.org/centos/Sreleasever/updates/Sbasearch/

enabled=1

gpgcheck=1

gpgkey=file:///etc/pki/rpm-gpg/RPM-GPG-KEY-Cent0S-5

priority=1

#packages used/produced in the build but not released

[addons]

name=CentOS-$releasever - Addons
mirrorlist=http://mirrorlist.centos.org/?release=Sreleasever&arch=$basearch&repo=addons
baseurl=http://mirror.centos.org/centos/$releasever/addons/Sbasearch/

enabled=0

gpgcheck=1
gpgkey=file:///etc/pki/rpm-gpg/RPM-GPG-KEY-Cent0S-5
priority=1

#additional packages that may be useful

[extras]

name=CentOS-$releasever - Extras
mirrorlist=http://mirrorlist.centos.org/?release=Sreleasever&arch=Sbasearché&repo=extras
baseurl=http://mirror.centos.org/centos/Sreleasever/extras/Sbasearch/

enabled=1

gpgcheck=1

gpgkey=file:///etc/pki/rpm-gpg/RPM-GPG-KEY-Cent0S-5

priority=1

#additional packages that extend functionality of existing packages
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[centosplus]

name=CentOS-$releasever - Plus
mirrorlist=http://mirrorlist.centos.org/?release=$releasever&arch=$basearch&repo=centospl
us

baseurl=http://mirror.centos.org/centos/$releasever/centosplus/Sbasearch/

enabled=1

gpgcheck=1
gpgkey=file:///etc/pki/rpm-gpg/RPM-GPG-KEY-Cent0S-5
priority=2

#contrib - packages by Centos Users

[contrib]

name=CentOS-$releasever - Contrib
mirrorlist=http://mirrorlist.centos.org/?release=Sreleasever&arch=$basearch&repo=contrib
baseurl=http://mirror.centos.org/centos/$releasever/contrib/Sbasearch/

enabled=0

gpgcheck=1

gpgkey=file:///etc/pki/rpm-gpg/RPM-GPG-KEY-Cent0S-5

priority=2

3. Execute the following commands.
yum install openscap-scanner

yum install scap-security-guide

For fresh installs, the OpenSCAP report is on the Image.

Sample Report

The following report is a sample section from an OpenSCAP report.

_______________________________________________________________ Introduction
Test Result
Result ID Start time End time Benchmark Benchmark version
xeedf org.open-scap testrasult_stig-rhelf-server-upstresm stig-rhel6-server-upstream 2015-06-26 04:38 2015-06-26 04:39 embadded 0%
Target info
Targets Addresses
« NWAPPLIANCE20809

Score

system
um:xcedfscormg:default 79.95 100.00 79.95%

Results overview

not selected not checked not applicable informational unknown total
153 0 49 0 173 19 0 0 ] 396

Ensure tmp Located On Separate Partition pass
Ensure var Located On Separate Partition pass
Ensure varlog Located On Separate Partition pass
Ensure 'varlog/audit Located On Separate Partition fail
Ensure 'home Located On Separate Partition pass
Encrypt Partitions notchecked
Ensure Red Hat GPG Key Installed fail
Ensure gpgcheck Enabled In Main Yum Configuration pass
Ensure gpgcheck Enabled For All Yum Package Reposttories fail
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Report Fields

N

Result ID The Extensible Configuration Checklist Description Format
(XCCDF) identifier of the report results.
Profile XCCDF profile under which the report results are categorized.
itk - Start time When the report started.
s 1ol End time When the report ended.
Benchmark  XCCDF benchmark
Benchmark  Version number of the benchmark.
version
Introduction - system XCCDF scoring method.
Score
score Score attained after running the report.
max Highest score attainable.
% Score attained after running the report as a percentage.
bar Not Applicable.
Results pass Passed rule check.
overview - Rule ) . )
Results fixed Rule check that failed previously is now fixed.
Summary fail Failed rule check,
error Could not perform rule check.
not selected  This check was not applicable to your NetWitness Platform
deployment.
not checked  Rule could not be checked. There are several reasons why a rule
cannot be checked. For example, the rule check requires a check
engine not supported by the OpenSCAP report.
not Rule check does not apply to your NetWitness Platform deployment.
applicable
informational Rule checks for informational purposes only (no action required for
fail),
unknown Report was able to check the rule. Run steps manually as described
in the report to check the rule.
total Total number of rules checked.
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N

Exceptions Title Name of rule being checked.

Result Valid values are pass, fixed, fail error, not selected, not
checked, not applicable, informational or unknown.

Note: Results values are defined the Results overview - Rule
Results Summary.

Create the OpenSCAP Report

The following tasks show you how to create the OpenSCAP Report in HTML, XML, or both HTML and
XML.

Create Report in HTML Only

To create an OpenSCAP report in HTML only:
1. SSH to the host.
2. Submit the following command:
mkdir -p /opt/rsa/openscap
3. Submit the following command for report upgrades only:

sed -1 -r -e "s/<platform.*//g" /usr/share/xml/scap/ssg/content/ssg-rhel7-
xccdf . xml

4. Submit the following command:

oscap xccdf eval --profile "stig" --report /root/stigscan/ hostname’ .html -
-cpe /usr/share/xml/scap/ssg/content/ssg-rhel7-cpe-dictionary.xml
/usr/share/xml/scap/ssg/content/ssg-rhel7-xccdf.xml

5. Open the report in your browser:

/tmp/hostname-ssg-results.html

Create Report in XML Only

To create an OpenSCAP report in xml only:
1. SSH to the host.
2. Submit the following command:
mkdir -p /opt/rsa/openscap
3. Submit the following command for report upgrades only:

sed -1 -r -e "s/<platform.*//g"™ /usr/share/xml/scap/ssg/content/ssg-rhel’-
xccdf . xml

4. Submit the following command:

oscap xccdf eval --profile "stig" --results /root/stigscan/ hostname’ .xml -
-cpe /usr/share/xml/scap/ssg/content/ssg-rhel7-cpe-dictionary.xml
/usr/share/xml/scap/ssg/content/ssg-rhel7-xccdf.xml

DISA STIG 122



System Maintenance Guide

Create Report in Both XML and HTML

To create an OpenSCAP report in both xml and html:

1.
2.

SSH to the host.

Submit the following command:

mkdir -p /opt/rsa/openscap

Submit the following command for report upgrades only:

sed -1 -r -e "s/<platform.*//g" /usr/share/xml/scap/ssg/content/ssg-rhel’-
xccdf.xml

Submit the following command:

oscap xccdf eval --profile "stig" --results /root/stigscan/ hostname’ .xml -
-report /root/stigscan/ hostname’ .html --cpe
/usr/share/xml/scap/ssg/content/ssg-rhel7-cpe-dictionary.xml
/usr/share/xml/scap/ssg/content/ssg-rhel7-xccdf.xml

Manage STIG Controls Script (nanage-stig-controls)

You can use the manage-stig-controls script and its arguments to enable or disable STIG Control
groups for which you want to apply STIG configuration. You can specify all hosts or individual hosts as
arguments and you can enable or disable all control groups or individual control groups. This script is
available in /usr/bin directory.

To manage STIG controls for a host:

1.
2.

SSH to the NW Server host or use the Console from the NetWitness Platform User Interface.

Submit the manage-stig-controls script with the commands, control groups, and other arguments
you want to apply.

3. Reboot the host.
Commands
--enable-all-controls Enables all STIG controls. For example:
manage-stig-controls --enable-all-controls
-—disable-all-controls Disables all STIG controls. For example:

manage-stig-controls --disable-all-controls

-—enable-default-controls Enables all STIG Controls except ssh-prevent-root and fips-kernel.

For example:

manage-stig-controls --enable-default-controls
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--enable-control-groups  Epables (comma delimited) list of STIG Control GroupIDs. For
<ibs=> example:
manage-stig-controls --enable-control-groups 'l,
2, 3F

--disable-control-groups  Disables (comma delimited) list of STIG Control Group IDs For
SLDS> example:

manage-stig-controls --disable-control-groups '1l,
2, 3"

Control Groups

You use the ID as an argument for the control group or groups.

Specified
Description
by Default
1 ssh-prevent-root Prevent root login through SSH. no
2 ssh SSH STIG configuration. yes
3 fips-kernel FIPS Kernel configuration no
4 auth Authentication STIG configuration yes
5 audit Audit STIG configuration yes
6 packages RPM Package STIG configuration yes
7 services Services STIG configuration yes
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Other Arguments

pomen psserpten

—--host-all Apply STIG configuration to all hosts. For example:
manage-stig-controls --host-all
--skip- Disable health checks for all hosts (not recommended). For example:
health- manage-stig-controls --skip-health-checks
checks
--host-id  Apply STIG configuration for the host identified by <id> (host identification code). For
S example:
manage-stig-controls --host-id <id>
-~host- Apply STIG configuration for host identified by <display-name>. display-name is
MENNES 1 the value shown under Name in the ADMIN > Hosts View in the NetWitness
<display=  piatform Interface. For example:
name>
manage-stig-controls --host-name <display-name>
-—host- Apply STIG configuration for the host identified by the value shown under Hostname
addr in the ADMIN > Hosts > Edit dialog in the NetWitness Platform Interface. This value
Iiof};zame_ can be an ip-addres (default) or a user-specified name. For example:
or manage-stig-controls --host-addr <hostname>
-—host- Edit Host
addr
<hostname>
Name 112Core
Hostname <ip-address>
Cancel
You can change the
default <ip-address>to a
Edit Host USEI’—SF)ECiﬁC name.
Name 112Core
Hostname [huuSerseﬁ
v, -- Enable verbose output. For example:
b
verbose manage-stig-controls -v
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Rules List

The following table lists all the STIG rules with their:

o Control Group - you can use the Control Group ID as an argument in the manage-stig-controls script
to expand on reduce the scope of rules checked. (1= ssh-prevent-root, 2 = ssh, 3 = fips-kernel, 4 =
auth, 5 = audit, 6 = packages, 7 = services)

o Default Status - tells you if the rule is enabled or disabled by default.

o Passed or Exception status - tells you if the rule passed (that is, complies with STIG) or is an

exception.

CCE Number

Rule Name

Control

Group

Default | Passed/

Exception

CCE-26404-4

CCE-26631-2

CCE-26828-4
CCE-26884-7

CCE-26892-0

CCE-26923-3
CCE-26952-2

CCE-26970-4

CCE-26971-2

CCE-26989-4

CCE-27002-5
CCE-27051-2
CCE-27053-8

Ensure /var Located On Separate
Partition

Set Password Strength Minimum
Different Characters

Disable DCCP Support

Set Lockout Time For Failed
Password Attempts

Set the GNOME3 Login Warning
Banner Text

Limit Password Reuse

Configure Periodic Execution of
AIDE

Enable GNOME3 Login Warning
Banner

Ensure /var/log/audit Located On
Separate Partition

Ensure gpgcheck Enabled In
Main Yum Configuration

Set Password Minimum Age
Set Password Maximum Age

Set Password Hashing Algorithm
in /etc/libuser.conf

n/a

auth

n/a

auth

audit

audit

n/a

n/a

auth

n/a

enabled

n/a
enabled

enabled

enabled
enabled

enabled

enabled

enabled

enabled
enabled
enabled

Exception

Passed

Exception

Exception

Passed

Passed

Exception

Passed

Exception

Passed

Passed
Passed

Passed
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Control | Default | Passed/

CCE Number Rule Name .
Group | Status | Exception
CCE-27081-9 Limit the Number of Concurrent  auth enabled Passed
Login Sessions Allowed Per
User
CCE-27082-7 Set SSH Client Alive Count ssh disabled Passed
CCE-27083-5 Record Events that Modify the audit enabled Passed

System's Discretionary Access
Controls - Ichown

CCE-27096-7 Install AIDE n/a n/a Exception

CCE-27104-9 Set PAM's Password Hashing n/a enabled Passed
Algorithm

CCE-27115-5 Set Password Strength Minimum  audit enabled Passed
Different Categories

CCE-27124-7 Set Password Hashing Algorithm n/a enabled Passed
in /etc/login.defs

CCE-27127-0 Enable Randomized Layout of n/a enabled  Exception
Virtual Address Space

CCE-27157-7 Verify File Hashes with RPM n/a n/a Exception

CCE-27160-1 Set Password Retry Prompts n/a enabled Passed
Permitted Per-Session

CCE-27165-0 Uninstall telnet-server Package  n/a enabled Passed

CCE-27173-4 Ensure /tmp Located On n/a n/a Exception
Separate Partition

CCE-27175-9 Verify Only Root Has UID 0 n/a enabled Passed

CCE-27200-5 Set Password Strength Minimum  auth enabled Passed
Uppercase Characters

CCE-27206-2 Ensure auditd Collects File audit enabled Passed
Deletion Events by User -
rename

CCE-27206-2 Ensure auditd Collects File audit enabled Passed
Deletion Events by User -
unlinkat

CCE-27206-2 Ensure auditd Collects File audit enabled Passed

Deletion Events by User - unlink

CCE-27209-6 Verity and Correct File n/a n/a Exception
Permissions with RPM
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CCE Number

Rule Name

Control

Group

Default
Status

Passed/

Exception

CCE-27213-8

CCE-27214-6

CCE-27218-7

CCE-27275-7

CCE-27277-3

CCE-27279-9

CCE-27280-7

CCE-27286-4

CCE-27287-2

CCE-27293-0
CCE-27295-5

CCE-27297-1

CCE-27303-7
CCE-27309-4

CCE-27311-0

CCE-27314-4
CCE-27320-1
CCE-27326-8

Record Events that Modify the
System's Discretionary Access
Controls - setxattr

Set Password Strength Minimum
Digit Characters

Remove the X Windows Package
Group

Set Last Logon/Access
Notification

Disable Modprobe Loading of
USB Storage Driver

Configure SELinux Policy

Record Events that Modify the
System's Discretionary Access
Controls - Isetxattr

Prevent Log In to Accounts With
Empty Password

Require Authentication for Single
User Mode

Set Password Minimum Length

Use Only FIPS 140-2 Validated
Ciphers

Set Interval For Counting Failed
Password Attempts

Modify the System Login Banner

Set Boot Loader Password in
grub2

Verify Permissions on SSH
Server Public *.pub Key Files

Enable SSH Warning Banner
Allow Only SSH Protocol 2

Ensure No Device Files are
Unlabeled by SELinux

audit

auth

n/a

n/a

services

n/a

auth

auth

ssh
n/a

n/a

ssh
n/a
n/a

enabled

enabled

enabled

enabled

enabled

enabled

enabled

enabled

enabled

enabled
enabled

enabled

enabled
enabled

enabled

enabled
enabled
enabled

Passed

Passed

Passed

Passed

Exception

Passed

Passed

Passed

Passed

Passed

Exception

Passed

Exception

Exception

Passed

Passed
Passed

Passed
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Control | Default | Passed/
CCE Number Rule Name .
Group | Status | Exception

CCE-27333-4 Set Password Maximum n/a enabled Passed
Consecutive Repeating
Characters

CCE-27334-2 Ensure SELinux State is n/a enabled  Exception
Enforcing

CCE-27339-1 Record Events that Modify the audit enabled Passed
System's Discretionary Access
Controls - chmod

CCE-27342-5 Uninstall rsh-server Package n/a enabled Passed

CCE-27343-3 Ensure Logs Sent To Remote n/a n/a Passed
Host

CCE-27345-8 Set Password Strength Minimum  auth enabled Passed
Lowercase Characters

CCE-27349-0 Set Default firewalld Zone for n/a n/a Exception
Incoming Packets

CCE-27350-8 Set Deny For Failed Password auth enabled Passed
Attempts

CCE-27351-6 Install the screen Package n/a enabled Passed

CCE-27353-2 Record Events that Modify the audit enabled Passed
System's Discretionary Access
Controls - fremovexattr

CCE-27355-7 Set Account Expiration n/a enabled Passed
Following Inactivity

CCE-27356-5 Record Events that Modify the audit enabled Passed
System's Discretionary Access
Controls - fchown

CCE-27358-1 Deactivate Wireless Network n/a enabled Passed
Interfaces

CCE-27360-7 Set Password Strength Minimum  auth enabled Passed
Special Characters

CCE-27361-5 Verify firewalld Enabled n/a n/a Exception

CCE-27363-1 Do Not Allow SSH Environment  ssh enabled Passed
Options

CCE-27364-9 Record Events that Modify the audit enabled Passed
System's Discretionary Access
Controls - chown
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CCE Number

Rule Name

Control

Group

Default
Status

Passed/

Exception

CCE-27367-2

CCE-27375-5

CCE-27377-1

CCE-27386-2

CCE-27387-0

CCE-27388-8

CCE-27389-6

CCE-27393-8

CCE-27394-6

CCE-27399-5

CCE-27407-6

CCE-27410-0

CCE-27413-4

CCE-27433-2

CCE-27434-0

CCE-27437-3

Record Events that Modify the
System's Discretionary Access
Controls - removexattr

Configure auditd space left
Action on Low Disk Space

Disable SSH Support for .rhosts
Files

Ensure Default SNMP Password
Is Not Used

Record Events that Modify the
System's Discretionary Access
Controls - fchownat

Record Events that Modify the
System's Discretionary Access
Controls - fchmodat

Record Events that Modify the
System's Discretionary Access
Controls - fsetxattr

Record Events that Modify the
System's Discretionary Access
Controls - fchmod

Configure auditd mail acct
Action on Low Disk Space

Uninstall ypserv Package
Enable auditd Service

Record Events that Modify the
System's Discretionary Access
Controls - Iremovexattr

Disable Host-Based
Authentication

Set SSH Idle Timeout Interval

Configure Kernel Parameter for
Accepting [Pv4 Source-Routed
Packets for All Interfaces

Ensure auditd Collects
Information on the Use of
Privileged Commands

audit

audit

n/a

n/a

audit

audit

audit

audit

audit

audit

audit

ssh
n/a

audit

enabled

enabled

enabled

n/a

enabled

enabled

enabled

enabled

enabled

enabled

enabled

enabled

enabled

enabled

enabled

enabled

Passed

Passed

Passed

Exception

Passed

Passed

Passed

Passed

Passed

Passed
Passed
Passed
Passed
Passed

Passed

Passed
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Control | Default | Passed/
CCE Number Rule Name .
Group Exception

CCE-27445-6 Disable SSH Root Login n/a n/a Exception

CCE-27447-2 Ensure auditd Collects audit enabled Passed
Information on Exporting to
Media (successful)

CCE-27455-5 Use Only FIPS 140-2 Validated n/a enabled Passed
MACs

CCE-27458-9 Mount Remote Filesystems with  n/a enabled Passed
Kerberos Security

CCE-27461-3 Ensure auditd Collects System audit enabled Passed
Administrator Actions

CCE-27471-2 Disable SSH Access via Empty  n/a enabled Exception
Passwords

CCE-27485-2 Verify Permissions on SSH n/a n/a Passed
Server Private * key Key Files

CCE-27498-5 Disable the Automounter n/a enabled Passed

CCE-27503-2 All GIDs referenced in n/a enabled Passed
/etc/passwd must be defined in
/etc/group

CCE-27511-5 Disable Ctrl-Alt-Del Reboot services enabled Passed
Activation

CCE-27512-3 Set Password to Maximum of auth enabled Passed
Consecutive Repeating
Characters from Same Character
Class

CCE-27557-8 Set Interactive Session Timeout auth disabled Passed

CCE-80104-3 Disable GDM Automatic Login  n/a enabled Passed

CCE-80105-0 Disable GDM Guest Login n/a enabled Passed

CCE-80108-4 Enable the GNOME3 Login n/a enabled Passed
Smartcard Authentication

CCE-80110-0 Set GNOMES3 Screensaver n/a enabled Passed
Inactivity Timeout

CCE-80111-8 Enable GNOME3 Screensaver n/a enabled Passed
Idle Activation

CCE-80112-6 Enable GNOME3 Screensaver n/a enabled Passed
Lock After Idle Period
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CCE Number

Rule Name

Control

Group

Default
Status

Passed/

Exception

CCE-80127-4

CCE-80129-0

CCE-80134-0

CCE-80135-7

CCE-80136-5

CCE-80144-9

CCE-80148-0

CCE-80156-3

CCE-80157-1

CCE-80158-9

CCE-80162-1

CCE-80163-9

CCE-80165-4

CCE-80174-6

CCE-80179-5

Install McAfee Virus Scanning
Software

Virus Scanning Software
Definitions Are Updated

Ensure All Files Are Owned by a
User

Ensure All Files Are Owned by a
Group

Ensure All World-Writable
Directories Are Owned by a
System Account

Ensure /home Located On
Separate Partition

Add nosuid Option to Removable
Media Partitions

Disable Kernel Parameter for
Sending ICMP Redirects for All
Interfaces

Disable Kernel Parameter for IP
Forwarding

Configure Kernel Parameter for
Accepting ICMP Redirects for
All Interfaces

Configure Kernel Parameter for
Accepting Source-Routed
Packets By Default

Configure Kernel Parameter for
Accepting ICMP Redirects By
Default

Configure Kernel Parameter to
Ignore ICMP Broadcast Echo
Requests

Ensure System is Not Acting as a
Network Sniffer

Configure Kernel Parameter for
Accepting [Pv6 Source-Routed
Packets for All Interfaces

n/a

n/a

n/a

n/a

enabled

enabled

enabled

enabled

enabled

n/a

n/a

enabled

enabled

n/a

Exception

Exception

Passed

Passed

Passed

Passed

Passed

Exception

Exception

Exception

Passed

Exception

Exception

Passed

Exception
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Control | Default | Passed/
CCE Number Rule Name .
Group Exception

CCE-80192-8 Ensure rsyslog Does Not Accept n/a enabled Passed
Remote Messages Unless Acting
As Log Server

CCE-80205-8 Ensure the Default Umask is Set n/a enabled Passed
Correctly in login.defs

CCE-80207-4 Enable Smart Card Login n/a n/a Exception

CCE-80213-2 Uninstall tftp-server Package n/a enabled Passed

CCE-80214-0 Ensure tftp Daemon Uses Secure n/a enabled Passed
Mode

CCE-80215-7 Install the OpenSSH Server n/a enabled Passed
Package

CCE-80216-5 Enable the OpenSSH Service n/a enabled Passed

CCE-80220-7 Disable GSSAPI Authentication  ssh enabled Passed

CCE-80221-5 Disable Kerberos Authentication n/a enabled Passed

CCE-80222-3 Enable Use of Strict Mode n/a enabled Passed
Checking

CCE-80223-1 Enable Use of Privilege n/a enabled Passed
Separation

CCE-80224-9 Disable Compression Or Set n/a enabled Passed
Compression to delayed

CCE-80225-6 Print Last Log n/a enabled Exception

CCE-80226-4 Enable Encrypted X11 n/a n/a Exception
Forwarding

CCE-80240-5 Mount Remote Filesystems with  n/a enabled Passed
nosuid

CCE-80245-4 Uninstall vsftpd Package n/a enabled Passed

CCE-80258-7 Disable KDump Kernel Crash services enabled Passed
Analyzer (kdump)

CCE-80346-0 Ensure YUM Removes Previous packages enabled Passed
Package Versions

CCE-80347-8 Ensure gpgcheck Enabled for packages enabled Passed
Local Packages

CCE-80348-6 Ensure gpgcheck Enabled for n/a n/a Exception
Repository Metadata

133 DISA STIG




System Maintenance Guide

Control | Default | Passed/

CCE Number Rule Name .
Group | Status | Exception

CCE-80349-4 The Installed Operating System  n/a n/a Exception
Is Vendor Supported and
Certified

CCE-80350-2 Ensure Users Re-Authenticate n/a enabled Passed
for Privilege Escalation - sudo
lauthenticate

CCE-80351-0 Ensure Users Re-Authenticate n/a enabled Passed
for Privilege Escalation - sudo
NOPASSWD

CCE-80352-8 Ensure the Logon Failure Delay  auth enabled Passed
is Set Correctly in login.defs

CCE-80353-6 Configure the root Account for auth enabled Passed
Failed Password Attempts

CCE-80354-4 Set the UEFI Boot Loader fips- disabled Passed
Password kernel

CCE-80359-3 Enable FIPS Mode in GRUB2 fips- disabled Exception

kernel

CCE-80370-0 Set GNOMES3 Screensaver Lock n/a enabled Passed
Delay After Activation Period

CCE-80371-8 Ensure Users Cannot Change n/a enabled Passed
GNOME3 Screensaver Settings

CCE-80372-6 Disable SSH Support for User ssh enabled Passed
Known Hosts

CCE-80373-4 Disable SSH Support for Rhosts  audit enabled Passed
RSA Authentication

CCE-80374-2 Configure Notification of Post- n/a n/a Exception
AIDE Scan Details

CCE-80375-9 Configure AIDE to Verify n/a n/a Exception
Access Control Lists (ACLs)

CCE-80376-7 Configure AIDE to Verify n/a n/a Exception
Extended Attributes

CCE-80377-5 Configure AIDE to Use FIPS n/a n/a Exception
140-2 for Validating Hashes

CCE-80378-3 Verify User Who Owns n/a enabled Passed

/etc/cron.allow file

CCE-80379-1 Verify Group Who Owns n/a enabled Passed
/etc/cron.allow file
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Control | Default | Passed/
CCE Number Rule Name .
Group Exception

CCE-80380-9 Ensure cron Is Logging To n/a enabled Passed
Rsyslog

CCE-80381-7 Shutdown System When Auditing audit enabled Passed
Failures Occur

CCE-80382-5 Record Attempts to Alter Logon  audit enabled Passed
and Logout Events - tallylog

CCE-80383-3 Record Attempts to Alter Logon  n/a n/a Passed
and Logout Events - faillock

CCE-80384-1 Record Attempts to Alter Logon  audit enabled Passed
and Logout Events - lastlog

CCE-80385-8 Record Unauthorized Access audit enabled Passed
Attempts to Files (unsuccessful)
- creat

CCE-80386-6 Record Unauthorized Access audit enabled Passed
Attempts to Files (unsuccessful)
- open

CCE-80387-4 Record Unauthorized Access audit enabled Passed
Attempts to Files (unsuccessful)
- openat

CCE-80388-2 Record Unauthorized Access audit enabled Passed
Attempts to Files (unsuccessful)
- open_by handle at

CCE-80389-0 Record Unauthorized Access audit enabled Passed
Attempts to Files (unsuccessful)
- truncate

CCE-80390-8 Record Unauthorized Access audit enabled Passed
Attempts to Files (unsuccessful)
- ftruncate

CCE-80391-6 Record Any Attempts to Run audit enabled Passed
semanage

CCE-80392-4 Record Any Attempts to Run audit enabled Passed
setsebool

CCE-80393-2 Record Any Attempts to Run audit enabled Passed
chcon

CCE-80395-7 Ensure auditd Collects audit enabled Passed
Information on the Use of
Privileged Commands - passwd
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Control | Default | Passed/
CCE Number Rule Name

Group | Status | Exception

CCE-80396-5 Ensure auditd Collects audit enabled Passed
Information on the Use of
Privileged Commands - unix

chkpwd

CCE-80397-3 Ensure auditd Collects audit enabled Passed
Information on the Use of
Privileged Commands - gpasswd

CCE-80398-1 Ensure auditd Collects audit enabled Passed
Information on the Use of
Privileged Commands - chage

CCE-80399-9 Ensure auditd Collects audit enabled Passed
Information on the Use of
Privileged Commands -
userhelper

CCE-80400-5 Ensure auditd Collects audit enabled Passed
Information on the Use of
Privileged Commands - su

CCE-80401-3 Ensure auditd Collects audit enabled Passed
Information on the Use of
Privileged Commands - sudo

CCE-80402-1 Ensure auditd Collects audit enabled Passed
Information on the Use of
Privileged Commands - sudoedit

CCE-80403-9 Ensure auditd Collects audit enabled Passed
Information on the Use of
Privileged Commands - newgrp

CCE-80404-7 Ensure auditd Collects audit enabled Passed
Information on the Use of
Privileged Commands - chsh

CCE-80405-4 Ensure auditd Collects audit enabled Passed
Information on the Use of
Privileged Commands - umount

CCE-80406-2 Ensure auditd Collects audit enabled Passed
Information on the Use of
Privileged Commands - postdrop

CCE-80407-0 Ensure auditd Collects audit enabled Passed
Information on the Use of
Privileged Commands -
postqueue
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Control | Default | Passed/
CCE Number FUIEENE

Group | Status | Exception

CCE-80408-8 Ensure auditd Collects audit enabled Passed
Information on the Use of
Privileged Commands - ssh-

keysign

CCE-80410-4 Ensure auditd Collects audit enabled Passed
Information on the Use of
Privileged Commands - crontab

CCE-80411-2 Ensure auditd Collects audit enabled Passed
Information on the Use of
Privileged Commands - pam
timestamp_check

CCE-80412-0 Ensure auditd Collects File audit enabled Passed
Deletion Events by User - rmdir

CCE-80413-8 Ensure auditd Collects File audit enabled Passed
Deletion Events by User -
renameat

CCE-80414-6 Ensure auditd Collects audit enabled Passed

Information on Kernel Module
Loading - init_ module

CCE-80415-3 Ensure auditd Collects audit enabled Passed
Information on Kernel Module
Unloading - delete _module

CCE-80416-1 Ensure auditd Collects audit enabled Passed
Information on Kernel Module
Unloading - rmmod

CCE-80417-9 Ensure auditd Collects audit enabled Passed
Information on Kernel Module
Loading and Unloading -
modprobe

CCE-80430-2 Record Events that Modify audit enabled Passed

User/Group Information -
/etc/security/opasswd

CCE-80431-0 Record Events that Modify audit enabled Passed
User/Group Information -
/etc/shadow

CCE-80432-8 Record Events that Modify audit enabled Passed
User/Group Information -
/etc/gshadow
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CCE Number

Rule Name

Control

Group

Default
Status

Passed/

Exception

CCE-80433-6

CCE-80434-4

CCE-80435-1

CCE-80436-9

CCE-80437-7

CCE-80438-5

CCE-80439-3

CCE-80446-8

CCE-80447-6

CCE-80513-5

CCE-80514-3

CCE-80515-0

CCE-80519-2

CCE-80537-4

CCE-80544-0

CCE-80545-7

CCE-80546-5

Record Events that Modify
User/Group Information -
/etc/group

Ensure Home Directories are
Created for New Users

Record Events that Modify
User/Group Information -
/etc/passwd

Mount Remote Filesystems with
noexec

Configure PAM in SSSD
Services

Configure Multiple DNS Servers
in /etc/resolv.conf

Configure Time Service Maxpoll
Interval

Ensure auditd Collects
Information on Kernel Module
Loading - insmod

Configure the Firewalld Ports

Remove Host-Based
Authentication Files

Remove User Host-Based
Authentication Files

Configure SSSD LDAP Backend
Client CA Certificate Location

Install Smart Card Packages For
Multifactor Authentication

Configure auditd space_left on
Low Disk Space

Ensure Users Cannot Change
GNOMES3 Session Idle Settings

Verify and Correct Ownership
with RPM

Configure SSSD LDAP Backend
to Use TLS For All Transactions

audit

n/a

audit

n/a

n/a

n/a

services

audit

n/a

n/a

n/a

n/a

audit

n/a

n/a

n/a

enabled

enabled

enabled

enabled

enabled

enabled

n/a

enabled

enabled

enabled

enabled

Passed

Passed

Passed

Passed

Exception

Exception

Passed

Passed

Exception

Passed

Passed

Exception

Exception

Passed

Passed

Exception

Exception
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Control | Default | Passed/
CCE Number Rule Name .
Group Exception
CCE-80547-3 Ensure auditd Collects audit enabled Passed
Information on Kernel Module
Loading and Unloading - finit
module
CCE-80563-0 Ensure Users Cannot Change n/a enabled Passed
GNOMES3 Screensaver Lock
After Idle Period
CCE-80564-8 Ensure Users Cannot Change n/a enabled Passed
GNOMES3 Screensaver Idle
Activation
CCE-80660-4 Record Any Attempts to Run audit enabled Exception
setfiles
CCE-80661-2 Ensure auditd Collects audit enabled Exception
Information on Kernel Module
Loading - create_module
CCE-81153-9 Add nosuid Option to /home n/a enabled Passed
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Exceptions to STIG Compliance

This topic contains:
« Rule exceptions that are the responsibility of the customer to resolve.

o Rule exceptions that are "Not a Finding" which means that they do not apply to NetWitness Platform.
RSA has verified that the system meets these requirements.

« Rules to be supported in future release.

Key to Elements in Exception Descriptions

CCE Number

The Common Configuration Enumeration (CCE), assigns unique entries (also called CCE numbers) to
configuration guidance statements and configuration controls to improve workflow by facilitating fast and
accurate correlation of configuration issues present in disparate domains. In this way, it is similar to
other comparable data standards such as the Common Vulnerability and Exposure (CVE®) List
(http://cve.mitre.org/cve), which assigns identifiers to publicly known system vulnerabilities. The
OpenSCAP report lists exceptions by CCE number.

This sections lists the exceptions you can receive when you run the OpenSCAP report. The ID or
Common Configuration Enumeration (CCE) number in the table is the identification number for the
exception from the OpenSCAP report.

Control Group ID

Number that identifies the control group you specify in the manage-stig-controls script to enable or
disable the rule.

Specified
Description
by Default
1 ssh-prevent-root Pprevent root login through SSH. no
2 ssh SSH STIG configuration. yes
3 fips-kernel FIPS Kernel configuration no
4 auth Authentication STIG configuration yes
5 audit Audit STIG configuration yes
6 packages RPM Package STIG configuration yes
7 services Services STIG configuration yes
Check

Describes what the rule checks to identify exceptions to DISA STIG compliance.
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Comments

Provides insight on why you would receive this exception. This section includes one of the following
comments that describes the exception:

o Customer Responsibility - You are responsible to make sure the system meets this requirement.

« Not a Finding - Exception does not apply to NetWitness Platform. RSA has verified that the system
meets this requirement.

o Future Feature - NetWitness Platform does not meet this requirement. RSA plans to fix this in a
future release of NetWitness Platform.

Customer Responsibility Exceptions

CCE-26952-2 Configure Periodic Execution of AIDE (Control Group = audit)

At a minimum, configure AIDE to run a weekly scan and at most, daily. To implement a
daily execution of AIDE at 4:05am using cron, add the following line to the
/etc/crontab file:
05 4 * * * root /usr/sbin/aide --check

Check  To implement a weekly execution of AIDE at 4:05am using cron, add the following line
to the /etc/crontab file:
05 4 * * 0 root /usr/sbin/aide --check
AIDE can be executed periodically through other means; this is merely one example.
The usage of cron's special time codes, such as @daily and @weekly is acceptable.

Customer Responsibility. NetWitness Platform does not provide AIDE because it has a
Comments negative impact on performance. If you must install it, run as infrequently as possible to
adhere to your security policy.

CCE-27096-7 Install AIDE (Control Group = n/a)

Check  Install the AIDE package with the following command: $ sudo yum install aid

Customer Responsibility. NetWitness Platform does not provide AIDE because it has a
Comments negative impact on performance. If you must install it, run as infrequently possible to
adhere to your security policy.

CCE-27218-7 Remove the X Windows Package Group

The Rule CCE-27218-7 "Remove the X Windows Package Group" is an exception for
Check .
Log Collector and Log Decoder services.

Customer Responsibility. Log Collector plugin collection framework uses SELinux
Comments sandbox technology that has a direct dependency on the given rpm. Removing of the rpm
will lead to loss of plugin collection functionality in Log Collector service.
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CCE-27295-5 Use Only FIPS 140-2 Validated Ciphers (Control Group = n/a)

Limit the ciphers to those algorithms which are FIPS-approved. Counter (CTR) mode is
also preferred over cipher-block chaining (CBC) mode. The following line in
/etc/ssh/sshd config demonstrates use of FIPS 140-2 validated ciphers:

Ciphers aesl28-ctr,aesl92-ctr,aes256-ctr
Check The following ciphers are FIPS 140-2 certified on RHEL 7:

- aesl28-ctr - aesl92-ctr - aes256-ctr - aesl28-cbc - aesl92-cbc
- aes256-cbc - 3des-cbc - rijndael-cbc@lysator.liu.se

Any combination of the above ciphers will pass this check. Official FIPS 140-2
paperwork for RHEL7 can be found at
http://csrc.nist.gov/groups/STM/cmvp/documents/140-1/140sp/140sp2630.pdf.

Customer Responsibility. Enable FIPS Mode. Refer to the System Maintenance Guide

Comments for RSA NetWitness Platform version 11.3 for instructions.

CCE-27445-6 Disable SSH Root Login (Control Group = ssh-prevent-root)

Check The root user should never be allowed to login to a system directly over a network.
Customer Responsibility. Disable root login through SSH by adding or editing the

Comments following line in the /etc/ssh/sshd_config file:
PermitRootLoginNetWitness.

CCE-80127-4 Install McAfee Virus Scanning Software (Control Group = n/a)

Install McAfee VirusScan Enterprise for Linux antivirus software which is provided for
Check . )
DoD systems and uses signatures to search for the presence of viruses on the filesystem.

Customer Responsibility. Install virus scanning software. RSA does not provide this

Comments software.

CCE-80129-0 Virus Scanning Software Definitions Are Updated (Control Group =

n/a)

Check  Make sure that virus definition files are no older than 7 days or their last release.

Comments Customer Responsibility. RSA does not provide this software.

CCE-80207-4 Enable Smart Card Login (Control Group = n/a)

For guidance on enabling SSH to authenticate against a Common Access Card (CAC),
Check consult documentation at: https://access.redhat.com/documentation/en-US/Red Hat

Enterprise Linux/7/html/System-Level Authentication

Guide/smartcards.html#authconfig-smartcards https://access.redhat.com/solutions/82273
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Comments

Customer Responsibility. The NetWitness Platform supports username/certificate for
authentication to shell. If you want to configure a smart card log in, you must do this
outside of RSA NetWitness.

CCE-80359-3 Enable FIPS Mode in GRUB2 (Control Group = fips-kernel)

Check

Comments

To ensure FIPS mode is enabled, install the dracut-fips package and rebuild
initramfs by running the following commands:

$ sudo yum install dracut-fips dracut -f

After the dracut command has been run, add the fips=1 argument to the default
GRUB 2 command line for the Linux operating system inthe /etc/default/grub
file as shown in the following example:

GRUB_CMDLINE LINUX='crashkernel=auto rd.lvm.lv=VolGroup/LogVol06
rd.lvm.lv=VolGroup/lv_swap rhgb quiet rd.shell=0 fips=1"

Finally, rebuild the grub.cfg file by using the grub2-mkconfig -o command as
follows ( On BIOS-based machines, issue the following command as root):

~1# grub2-mkconfig -o /boot/grub2/grub.cfg
On UEFI-based machines, issue the following command as root:
~]1# grub2-mkconfig -o /boot/efi/EFI/redhat/grub.cfg

Customer Responsibility. NetWitness Platform does not enabled by default. You can
enable FIPS by following the procedures in the Configure FIPS Support,

CCE-80374-2 Configure Notification of Post-AIDE Scan Details (Control Group =

n/a)

Check

Comments

AIDE should notify appropriate personnel of the details of a scan after the scan has been
run. If AIDE has already been configured for periodic execution in the /etc/crontab
file, append the following line to the existing AIDE line:

| /bin/mail -s '$ (hostname) - AIDE Integrity Check' root@localhost
Otherwise, add the following line to the /etc/crontab file:

05 4 * * * root /usr/sbin/aide --check | /bin/mail -s

'S (hostname) - AIDE Integrity Check' root@localhost

AIDE can be executed periodically through other means. This is just one example.

Customer Responsibility. NetWitness Platform does not provide AIDE because it has a
negative impact on performance. If you must install it, run as infrequently possible to
adhere to your security policy.

CCE-80375-9 Configure AIDE to Verify Access Control Lists (Control Group = n/a)

By default, the ac1 option is added to the FIPSR ruleset in AIDE. If using a custom
ruleset or the ac1 option is missing, add ac1 to the appropriate ruleset. For example,
add ac1 to the following line in the /etc/aide.conf file:

Check FIPSR = p+i+ntutgts+tmtctacl+selinux+xattrs+sha256
AIDE rules can be configured in multiple ways; this is merely one example that is
already configured by default.
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Customer Responsibility. NetWitness Platform does not provide AIDE because it has a
Comments negative impact on performance. If you must install it, run as infrequently possible to
adhere to your security policy.

CCE-80376-7 Configure AIDE to Verify Extended Attributes (Control Group = n/a)

By default, the xattrs option is added to the FIPSR ruleset in AIDE. If using a custom

ruleset or the xattrs option is missing, add xattrs to the appropriate ruleset. For
Check example, add xattrs to the following line in the /etc/aide.conf file:

FIPSR = pt+i+tnt+utgts+mt+ctacl+selinux+xattrs+sha256

AIDE rules can be configured in multiple ways. This is just one example that is already

configured by default.

Customer Responsibility. NetWitness Platform does not provide AIDE because it has a
Comments negative impact on performance. If you must install it, run as infrequently possible to
adhere to your security policy.

CCE-80377-5 Configure AIDE to Use FIPS 140-2 for Validating Hashes (Control

Group = n/a)

By default, the sha512 option is added to the ORMAL ruleset in AIDE. If using a custom
ruleset orthe sha512 option is missing, add sha512 to the appropriate ruleset. For
example, add sha512 to the following line in the /etc/aide.conf file:ORMAL =
FIPSR+shabl2

AIDE rules can be configured in multiple ways; this is merely one example that is
already configured by default.

Check

Customer Responsibility. NetWitness Platform does not provide AIDE because it has a
Comments negative impact on performance. If you must install it, run as infrequently possible to
adhere to your security policy.

CCE-80519-2 Install Smart Card Packages For Multi-Factor Authentication (Control

Group = n/a)

Configure the operating system to implement multifactor authentication by installing the

Check  required packages with the following command:
$ sudo yum install esc pam pkcsll authconfig-gtk

Customer Responsibility. The NetWitness Platform supports username/certificate for
Comments authentication to shell. If you want to configure a smart card log in, you must do this
outside of RSA NetWitness.

Exceptions That Are Not a Finding

The following exceptions do not apply to NetWitness Platform. RSA has verified that the system meets
these requirements.
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CCE-26404-4 Ensure /var Located On Separate Partition (Control Group = n/a)

Check

Comments

The /var directory is used by daemons and other system services to store frequently-
changing data. Ensure that /var has its own partition or logical volume at installation
time, or migrate it using LVM.

Not a Finding.NetWitness software is installed in /var/netwitness by default and
has a separate partition on /var/netwitness.

CCE-26828-4 Disable DCCP Support (Control Group = n/a)

Check

Comments

Verify that the GNOME Login Inactivity Timeout is set on the host (The graphical
desktop environment must set the idle timeout to no more than 15 minutes.).

Not a Finding. NetWitness Platform does not use Gnome Graphical User Interface
(GUI) Desktop.

CCE-26884-7 Set Lockout Time For Failed Password Attempts (Control Group =

auth)

Check

Comments

To configure the system to lock out accounts after a number of incorrect login attempts
and require an administrator to unlock the account using pam faillock.so, modify
the content of both /etc/pam.d/system-auth and /etc/pam.d/password-auth
by adding the following line immediately before the pam unix.so statement in the
AUTH section:

auth required pam faillock.so preauth silent deny= unlock time=
fail interval=

Add the following line immediately after the pam unix.so statement in the AUTH
section:

auth [default=die] pam faillock.so authfail deny= unlock time=
fail interval=

Add the following line immediately before the pam unix.so statement in the ACCOUNT
section:

account required pam faillock.s

Not a Finding. root unlock time is setto 600 seconds.

CCE-26971-2 Ensure /var/log/audit Located On Separate Partition (Control Group

= audit)

Audit logs are stored in the /var/log/audit directory. Ensure that it has its own
Check partition or logical volume at installation time, or migrate it later using LVM. Make

absolutely certain that it is large enough to store all audit logs that will be created by the
auditing daemon.

Comments Vot 2 Finding.NetWitness Platform has the /var/1og directory as a separate
partition.
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CCE-27127-0 Enable Randomized Layout of Virtual Address Space (Control Group
=n/a)

To set the runtime status of the kernel.randomize va_ space kernel parameter, run
the following command:

Check $ sgdp sysctl -w kernel.randomize_va_spgcefZ
If this is not the system default value, add the following line to the

/etc/sysctl.conf file:
kernel.randomize va space = 2

Comments Not a Finding. Value of /proc/sys/kernel/randomize va_space is already 2.

CCE-27157-7 Verify File Hashes with RPM (Control Group = n/a)

Without cryptographic integrity protections, system executables and files can be altered
by unauthorized users without detection. The RPM package management system can
check the hashes of installed software packages, including many that are important to
system security. To verify that the cryptographic hash of system files and commands
match vendor values, run the following command to list which files on the system with
hashes that differ from what is expected by the RPM database:
$ rpm -Va | grep '*..5'" A 'c¢'

in the second column indicates that a file is a configuration file, which may

Check appropriately be expected to change. If the file was not expected to change, investigate
the cause of the change using audit logs or other means. The package can then be
reinstalled to restore the file. Run the following command to determine which package
owns the file:
$ rpm -gf
The package can be reinstalled from a yum repository using the command:
FILENAME $ sudo yum reinstall

Alternatively, the package can be reinstalled from trusted media using the command:
PACKAGENAME $ sudo rpm -Uvh PACKAGENAME

Not a Finding. Only mismatched files not marked as config files in rpms are
Commercial Off the Shelf (COTS) product based that cannot be updated.

Most File Hash/RPM combinations are in sync. Any discrepancies are COTS products
that cannot be updated.

Comments

CCE-27339-1 Record Events that Modify the System's Discretionary Access
Controls - chmod

Check Verify that the host records events that modify the system's discretionary access
controls - chown.
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Comments

Not a Finding. Make sure that you have the correct chown configuration on the host.
The following settings are the correct configuration.

[root@localhost nwadmin]# grep chown /etc/audit/*
/etc/audit/audit.rules:-a exit,always -F arch=b64 -S chown -S
chmod -S fchmod -S fchmodat -S fchown -S fchownat -S fremovexattr
-S fsetxattr -S lchown -S lremovexattr -S lremovexattr -S
lsetxattr -S removexattr -S setxattr -F auid>=500 -F
auid!=4294967295 -k perm mod

/etc/audit/audit.rules:-a exit,always -F arch=b32 -S chown -S
fchmod -S fchmodat -S fchown -S fchownat -S fremovexattr -S
fsetxattr -S lchown -S lremovexattr -S lremovexattr -S lsetxattr
-S removexattr -S setxattr -F auid>=500 -F auid!=4294967295 -k
perm mod

CCE-27209-6 Verify and Correct File Permissions with RPM (Control Group = n/a)

Rule Name

Check

Comments

The RPM package management system can check file access permissions of installed
software packages, including many that are important to system security. Verify that the
file permissions of system files and commands match vendor values. Check the file
permissions with the following command:

$ sudo rpm -Va | grep '~.M'

Output indicates files that do not match vendor defaults. After locating a file with

incorrect permissions, run the following command to determine which package owns it:
$ rpm -gqf FILENAME

Next, run the following command to reset its permissions to the correct values:
$ sudo rpm --quiet --setperms PACKAGENAME

Not a Finding. The file permissions do not match the rpm, they are configured to be
stricter during configuration management.
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CCE-27303-7 (Control ID = 2) Modify the System Login Banner (Control Group =

ssh)

Check

To configure the system login banner edit the /etc/issue file. Replace the default
text with a message compliant with the local site policy or a legal disclaimer. The DoD
required text is either:

" You are accessing a U.S. Government (USG) Information System (IS) that is
provided for USG-authorized use only. By using this IS (which includes any device
attached to this IS), you consent to the following conditions:

The USG routinely intercepts and monitors communications on this IS for purposes
including, but not limited to, penetration testing, COMSEC monitoring, network
operations and defense, personnel misconduct (PM), law enforcement (LE), and
counterintelligence (CI) investigations.

At any time, the USG may inspect and seize data stored on this IS.

o Communications using, or data stored on, this IS are not private, are subject to

routine monitoring, interception, and search, and may be disclosed or used for any
USG-authorized purpose.

This IS includes security measures (e.g., authentication and access controls) to
protect USG interests -- not for your personal benefit or privacy. -Notwithstanding
the above, using this IS does not constitute consent to PM, LE or CI investigative
searching or monitoring of the content of privileged communications, or work
product, related to personal representation or services by attorneys, psychotherapists,
or clergy, and their assistants. Such communications and work product are private
and confidential. See User Agreement for details."

or

" I've read & consent to terms in IS user agreem't."

Comments Not a Finding. The login banner is displayed but does not hyphenate "agreem't"

CCE-27311-0 Very Permissions on SHH Server *.pub Key Files (Control Group =

na)

Check

Comments

Not a Finding. All public keys are set to with permissions 640 in the /etc/ssh/
directory.

CCE-27314-4 Enable SSH Warning Banner (Control Group = na)

Check
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Comments Vot a Finding. The required configuration exists in the etc/ssh/sshd_conf file.

CCE-27349-0 Set Default firewal1d Zone for Incoming Packets (Control Group =
n/a)

To set the default zone to drop for the built-in default zone which processes incoming
Check IPv4 and IPv6 packets, modify the following line in the

/etc/firewalld/firewalld.conf file to be:
DefaultZone=drop

Not a Finding. NetWitness Platform £irewalldservice is disabled because it uses IP

Comments Tables, not FirewallD.

CCE-27361-5 Verify firewalld Enabled (Control Group = n/a)

Check The firewalld service can be enabled with the following command:
$ sudo systemctl enable firewalld.service

Not a Finding. NetWitness Platform firewalld service is disabled because it uses IP

Comments Tables, not FirewallD.

CCE-27386-2 Ensure Default SNMP Password Is Not Used (Control Group = n/a)

Edit /etc/snmp/snmpd.conf file by removing or changing the default community
Check strings of public and private. After the default community strings have been changed,

restart the SNMP service:
$ sudo service snmpd restart

Not a Finding. NetWitness Platform does not use snmp, and the snmpd service not

Comments enabled.

CCE-27455-5 Use Only FIPS 140-2 Validated MACs (Control Group = na)
Check

Not a Finding. The following configuration exists in /etc/ssh/sshd_config file:

Comments MACs hmac-shal,hmac-sha?2-256, hmac-sha2-512

CCE-27471-2 Disable SSH Access via Empty Passwords (Control Group = n/a)

Check Explicitly disallow SSH login from accounts with empty passwords, add or correct the
ec following line in the /etc/ssh/sshd_config file.
Not a Finding. NetWitness Platform sets the permitemptypasswords parameter to no

DRI by default. This should pass the DISA STIG rule check.
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CCE-27485-2 Very Permissions on SHH Server Private *.key Key Files (Control

Group = na)

Check

Comments

Not a Finding. All private keys are set to with permissions 640 in the /etc/ssh/
directory.

CCE-80156-3 Disable Kernel Parameter for Sending ICMP Redirects for All

Interfaces (Control Group = n/a)

Check

Comments

To set the runtime status of the t.ipv4.conf.all.send redirects kernel
parameter, run the following command:

$ sudo sysctl -w net.ipv4.conf.all.send redirects=0

If this is not the system default value, add the following line to the

/etc/sysctl.conf file:
t.ipv4.conf.all.send redirects = 0

Not a Finding. NetWitness Platform does not accept incoming Internet Control
Message Protocol (ICMP) traffic.

CCE-80157-1 Disable Kernel Parameter for IP Forwarding (Control Group = n/a)

Check

Comments

To set the runtime status of the t.ipv4.ip forward kernel parameter, run the
following command:

$ sudo sysctl -w net.ipv4.ip forward=0

If this is not the system default value, add the following line to the

/etc/sysctl.conf file:
t.ipvd.ip forward = 0

Not a Finding. NetWitness Platform only uses FIPS certified MACs (for example,
MACs hmac—shal,hmac—sha2—256,hmac—sha2—512)

CCE-80158-9 Configure Kernel Parameter for Accepting ICMP Redirects for All

Interfaces (Control Group = n/a)

Check

Comments

To set the runtime status of the t.ipv4.conf.all.accept redirects kernel
parameter, run the following command:

$ sudo sysctl -w net.ipv4.conf.all.accept redirects=0

If this is not the system default value, add the following line to the /etc/sysctl.conf
file:

t.ipvd.conf.all.accept redirects = 0

Not a Finding NetWitness Platform does not accept incoming Internet Control Message
Protocol (ICMP) traffic.

DISA STIG

150



System Maintenance Guide

CCE-80163-9 Configure Kernel Parameter for Accepting ICMP Redirects By
Default (Control Group = n/a)

To set the runtime status of the t.ipv4.conf.default.accept redirects kernel
parameter, run the following command:

Check S sgdp sysctl -w net.ipv4.conf.default.gccgpt_redirects=0
If this is not the system default value, add the following line to the /etc/sysctl.conf
file:
t.ipvéd.conf.default.accept redirects = 0

Not a Finding NetWitness Platform does not accept incoming Internet Control Message

Comments Protocol (ICMP) traffic.

CCE-80165-4 Configure Kernel Parameter to Ignore ICMP Broadcast Echo

Requests (Control Group = n/a)

Rule
Name

To set the runtime status of the t.ipv4.icmp echo ignore broadcasts kernel
parameter, run the following command:

Check $ sgdp sysctl -w net.ipv4.icmp_echo_ignprefbroadcasts=l
If this is not the system default value, add the following line to the /etc/sysctl.conf
file:

t.ipvé4.icmp echo ignore broadcasts = 1

Not a FindingNetWitness Platform does not accept incoming Internet Control Message

COMMBD | 1ol (ICMP) traffic.

CCE-80225-6 Print Last Log (Control Group = n/a)

When enabled, SSH will display the date and time of the last successful account log in.
Check To enable LastLog in SSH, add or correct the following line in the /etc/ssh/sshd

config file:
PrintLastLog yes

Comments Vot a Finding. NetWitness Platform sets printlastlog to yes by default.

CCE-80226-4 Enable Encrypted X11 Forwarding (Control Group = n/a)

Enable Encrypted X11 Forwarding - By default, remote X 11 connections are not
encrypted when initiated by users. SSH has the capability to encrypt remote X11
Check connections when SSH's x11Forwarding option is enabled. To enable X11

Forwarding, add or correct the following line in the /etc/ssh/sshd config file:
X11lForwarding yes

Comments Vot a Finding.NetWitness Platform does not have X11 installed or running.
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CCE-80348-6 Ensure gpgcheck Enabled for Repository Metadata (Control Group =

n/a)

Verify the operating system prevents the installation of patches, service packs, device
drivers, or operating system components of local packages without verification of the

Check  repository metadata. Check that yum verifies the repository metadata prior to install with
the following command. This should be configured by setting repo gpgcheckto 1l in
/etc/yum.conf.

Not a Finding. .NetWitness Platform rpm signing procedures do not support signing the

COTTET repo metadata

CCE-80349-4 The Installed Operating System Is Vendor Supported and Certified
(Control Group = n/a)

The installed operating system must be maintained and certified by a vendor. Red Hat
Enterprise Linux is supported by Red Hat, Inc. As the Red Hat Enterprise Linux
vendor, Red Hat, Inc. is responsible for providing security patches and meeting and
maintaining government certifications and standards.

Check

Comments Not a Finding. The Operating System is a vendor supported and certified by CentOS.

CCE-80383-3 Record Attempts to ALter Logon Events - failock (Control Group =

na)
Check

Not a Finding. The required rules are configured in the /etc/audit/rules.d/nw-

Comments stig.rules file.

CCE-80399-9 Ensure auditd Collects Information on the Use of Privileged

Commands - userhelper (Control Group = na)
Check

Not a Finding. The required rules are configured in the /etc/audit/rules.d/nw-

Comments stig.rules file.

CCE-80437-7 Configure PAM in SSSD Services (Control Group = n/a)

SSSD should be configured to run SSSD pam services. To configure SSSD to known
Check SSH hosts, add pam to services under the [sssd] sectionin /etc/sssd/sssd.conf
file. For example: [sssd] services = sudo, autofs, pam
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Not a Finding. NetWitness Platform does not currently support Multi-Factor

Comments . S, : ;
authentication. As a result, SSSD service is not installed on a NetWitness Host.

CCE-80438-5 Configure Multiple DNS Servers in /etc/resolv.conf (Control Group =
n/a)

Multiple Domain Name System (DNS) Servers should be configured in the
/etc/resolv.conf file. This provides redundant name resolution services in the
event that a domain server crashes. To configure the system to contain as least 2 DNS
Check servers, add a corresponding nameserver entry in ip_address /etc/resolv.conf
file for each DNS server where ip address is the IP address of a valid DNS server.

For example:
search example.com nameserver 192.168.0.1 nameserver 192.168.0.2

Not a Finding. NetWitness Platform orchestrates and configures an internal DNS
Comments server that all NetWitness hosts use for name resolution. You can configure external
DNS servers, but it is dependent on your environment.

CCE-80439-3 Configure Time Service Maxpoll Interval (Control Group = na)

Check

Comments Not a Finding. The required maxpoll 10 value is set in the /etc/ntp.conf file.

CCE-80447-6 Configure the Firewalld Ports (Control Group = n/a)

Configure the firewalld ports to allow approved services to have access to the
system. To configure firewalld to open ports, run the following command:

$ sudo firewall-cmd --permanent --add-port= or port number/tcp $
sudo firewall-cmd --permanent --add-port=
Check . .
Run the command list above for each of the ports listed below: <ports>
To configure service nam firewalld to allow access, run the following command
(s):
firewall-cmd --permanent --add-service=ssh
Not a Finding. i fi 11d ice is di i
Comments g. NetWitness Platform firewa service 1s disabled because it uses IP

Tables, not FirewallD.

CCE-80515-0 Configure SSSD LDAP Backend Client CA Certificate Location
(Control Group = n/a)

Configure SSSD to implement cryptography to protect the integrity of LDAP remote
access sessions. By setting the 1dap tls cacertdir option in

Check /etc/sssd/sssd.conf to point to the path for the X.509 certificates used for peer
authentication.
ldap tls cacertdir /path/to/tls/cacert
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Comments

Not a Finding. NetWitness Platform does not currently support Multi-Factor
authentication. As a result, SSSD service is not installed on a NetWitness Host.

CCE-80545-7 Verify and Correct Ownership with RPM (Control Group = n/a)

Check

Comments

The RPM package management system can check file ownership permissions of
installed software packages, including many that are important to system security. After
locating a file with incorrect permissions, which can be found with rpm -va | grep
M. \(U\].G\)"

Run the following command to determine which package owns it:

S rpm -gf

Next, run the following command to reset its permissions to the correct values:
FILENAME $ sudo rpm --setugids PACKAGENAME

Not a Finding.Files/Directories with ownership differing from the rpm are generally
COTS based and have been changed from root ownership to a specified COTS related
account.

CCE-80546-5 Configure SSSD LDAP Backend to Use TLS For All Transactions

(Control Group = n/a)

Check

Comments

This check verifies that RHEL7 implements cryptography to protect the integrity of
remote LDAP authentication sessions. To determine if LDAP is being used for

authentication, use the following command:
$ sudo grep -i useldapauth /etc/sysconfig/authconfig If
USELDAPAUTH=yes

To check if LDAP is configured to use TLS, use the following command:
$ sudo grep -i ldap id use start tls /etc/sssd/sssd.conf

Not a Finding.NetWitness Platform does not currently support Multi-Factor
authentication. As a result, the SSSD service is not installed on a NetWitness Host.

Rules Supported in a Future Release

The following checks for non-compliance to STIG rules are not supported in NetWitness Platform and
will be added in a future release.

CCE-27277-3 Disable Modprobe Loading of USB Storage Driver (Control Group =

services)

Check

To prevent USB storage devices from being used, configure the kernel module loading
system to prevent automatic loading of the USB storage driver. To configure the system
to prevent the usb-storage kernel module from being loaded, add the following line to a
file in the /etc/modprobe.d directory :

install usb-storage /bin/true

This will prevent the modprobe program from loading the usb-storage module, but will
not prevent an administrator (or another program) from using the insmod program to
load the module manually.
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Comments

Future Feature.

CCE-27309-4 Set Boot Loader Password in grub2 (Control Group = fips-kernel)

Check

Comments

The grub2 boot loader should have a superuser account and password protection enabled
to protect boot-time settings. To do so, select a superuser account name and password
and and modify the /etc/grub.d/01 users configuration file with the new account
name. Because plain text passwords are a security risk, generate a hash for the password
by running the following command:

$ grub2-setpassword

When prompted, enter the password that was selected.
NOTE: It is recommended not to use common administrator account names like root,
admin, or administrator for the grub2 superuser account. Change the superuser to a
different username (The default is 'root').

$ sed -i s/root/bootuser/g /etc/grub.d/01 users

To meet FISMA Moderate, the bootloader superuser account and password MUST
differ from the root account and password. Once the superuser account and password
have been added, update the grub.cfqg file by running:

grub2-mkconfig -o /boot/grub2/grub.cfg
NOTE: Do NOT manually add the superuser account and password to the grub.cfg file
as the grub2-mkconfig command overwrites this file.

Future Feature.

CCE-80179-5 Configure Kernel Parameter for Accepting IPv6 Source-Routed

Packets for All Interfaces

Check

Comments

To set the runtime status of the t.ipv6.conf.all.accept source route kernel
parameter, run the following command:

$ sudo sysctl -w net.ipv6.conf.all.accept source route=0

If this is not the system default value, add the following line to the /etc/sysctl.conf
file:

t.ipv6.conf.all.accept source route = 0

Future Feature.

CCE-80660-4 Record Any Attempts to Run setfiles (Control Group = audit)

At a minimum, the audit system should collect any execution attempt of the setfiles
command for all users and root. If the auditd daemon is configured to use the augenrules
program to read audit rules during daemon startup (the default), add the following lines to

a file with .rules in /etc/audit/rules.d: -a always,exit -F
path=/usr/sbin/setfiles -F perm=x -F auid>=1000 -F

heck
i auid!=429496729%as a suffix 5 -F key=privileged-priv_change. If the

auditd daemon is configured to use the auditctl utility to read audit rules during
daemon startup, add the following lines to /etc/audit/audit.rules file:
-a always,exit -F path=/usr/sbin/setfiles -F perm=x -F auid>=1000
-F auid!=4294967295 -F key=privileged-priv_chang

Comments Future Feature.

155 DISA STIG



System Maintenance Guide

CCE-80661-2 Ensure auditd Collects Information on Kernel Module Loading -

create_module (Control Group = audit)

To capture kernel module loading events, use following line, setting ARCH to either b32
for 32-bit system, or having two lines for both b32 and b64 in case your system is 64-bit:
-a always,exit -F arch=
The place where you add the line depends on the way ARCH -S create module -F
key=modules auditd daemon is configured. If it is configured to use the augenrules
program (the default), add the line to a file with the . rules suffix in the
/etc/audit/rules.d directory. If the auditd daemon is configured to use the
auditctl utility, add the line to the /etc/audit/audit.rulesfile.

Check

Comments Future Feature.
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Troubleshoot NetWitness Platform

For information about troubleshooting NetWitness Platform, see the following topics:

o Debugging Information

o Error Notification

» Miscellaneous Tips

o NwLogPlayer: see the Log Parser Customization Guide for details. Go to the Master Table of
Contents to find all RSA NetWitness Platform 11.x documents. Under Additional Resources on the
right, click RSA Live Content. The guide is located under Log Parsers.

o Troubleshoot Feeds

Debugging Information

NetWitness Platform Log Files

The following files contain NetWitness Platform log information.

T

rabbitmg /var/log/rabbitmg/nw@localhost.log
/var/log/rabbitmg/nw@localhost-sasl.log

collectd /var/log/messages

nwlogcollector /var/log/messages

nwlogdecoder /var/log/messages

sms /opt/rsa/sms/wrapper.log

=il /opt/rsa/sms/logs/sms.log

sms /opt/rsa/sms/logs/audit/audit.log

NetWitness Platform /var/lib/netwitness/uax/logs/nw.log

NetWitness Platform /var/lib/netwitness/uax/logs/audit/audit.log

NetWitness Platform /opt/rsa/jetty9/logs

Files of Interest

The following files are used in key NetWitness Platform components, and can be useful when trying to
track down miscellaneous issues.
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N N

RabbitMQ configuration file. This
configuration file partially drives the

rabbit /etc/rabbitmg/rabbitmg.config behavior of RabbitMQ,
particularly around network/SSL
settings.
RabbitMQ environment configuration
rabbit /etc/rabbitmg/rabbitmg-env. file. This file specifies the RabbitMQ
conf node name and location of the enabled

plugins file.

This file specifies the list of enabled
plugins in RabbitMQ. This file is
managed by the RabbitMQ server, with

, the rabbitmg-plugins command.

rabbit ﬁﬁ;ﬁzbbltmq/rsa—enabled— This file overrides the

/etc/rabbitmg/enabled plugins
path to work around issues with
upgrading the Log Collector from early
versions.

The RabbitMQ trust store. This file
contains a sequence of PEM-encoded
X.509 certificates, represented trust

rabbit /etc/rabbitmg/ssl/truststore.pem (CAs. Any clients that connect to
RabbitMQ and present a certificate that
is signed by a CA in this list is
considered a trusted client.
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T N N

The RabbitMQ Mnesia directory.
Mnesia is the Erlang/OTP database
technology, for storing Erlang objects
persistently. RabbitMQ uses this
technology for storing information such
as the current set of policies, persistent
exchanges and queues, and so forth.

Importantly, the msg_store_
persistent and msg store
transient directories are where

/var/log/rabbitmg/mnesia/ RabbitMQ stores messages that have

nw@localhost been spooled to disk, for example, if
messages are published as persistent
messages, or have paged off to disk due
to memory limitations. Keep a close eye
on this directory if disk or memory
alarms have tripped in RabbitMQ.

rabbit

Caution: Do not delete these files
manually. Use RabbitMQ tools to
purge or delete queues. Modifying
these files manually may render your
RabbitMQ instance inoperable.

Error Notification

NetWitness Platform has a set of error message types associated with different components and
operations. NetWitness Platform displays feedback in the form of a simple error notification and a log
entry.

When an error notification dialog is displayed, you have two options: simply acknowledge the message
or view the system log for more information.

m Trial License Expired

If you want to view the system log for more information when an error notification is displayed, click
View log. The log opens in the ADMIN > System view with a list of messages. Timestamp and
message level are also listed.
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Miscellaneous Tips

Audit Log Messages

It can be useful to see which user actions result in which log message types in the
/var/log/messages file.

The event categories spreadsheet included in the log parser package in the NetWitness Platform Parser
v2.0.zip archive lists the event categories and the event parser lines to help with building reports, alerts,
and queries.

NwConsole for Health & Wellness

RSA has added the command option logParse in NwConsole. This command option supports log
parsing, a convenient way to check a log parser without setting up the full system to perform log parsing.
For more information about the 1ogParse command, at the command line, type help logParse.

Thick Client Error: remote content device entry not found

The remote content device entry was not found error can be generated for a correlation rule applied to a
Concentrator. In NetWitness Platform Investigate, if you click the correlation-rule-name meta
value in the Alert meta key, you do not get session information.

Instead of using correlation rules on Decoders and Concentrators, use ESA rules. The ESA rules do
record the correlation sessions that match the ESA rule.

Troubleshoot NetWitness Platform 160



System Maintenance Guide

View Example Parsers
Since Flex and Lua parsers are encrypted when they are delivered by Live, you cannot easily view their
contents.

However, some plain text examples are available here: https://community.emc.com/docs/DOC-41108.

Configure WinRM Event Sources
The following Inside Dell article has a video that walks through the process of setting up Windows RM
(Remote Management) collection: https://inside.dell.com/docs/DOC-122732.

Additionally, it contains two scripts that are shortcuts for procedures described in the "Windows Event
Source Configuration Guide."

Troubleshoot Feeds

Overview
The purpose of the feed generator is to generate a mapping of an event source to the list of groups to
which it belongs.

If you have an event source from which you are collecting messages, and it is not displayed in the
correct event source groups, this topic provides background and information to help you track down the
problem.

Details
The ESM Feed maps multiple keys to single value. It maps the DeviceAddress, Forwarder,
and DeviceType attributes to groupName.

The purpose of the ESM feed is to enrich event source meta with the groupName collected on the Log
Decoder.

How it Works

The feed generator is scheduled to update every minute. However, it is triggered only if there are any
changes (create, update, or delete) in event sources or groups.

It generates a single feed file with event-source-to-group mapping, and pushes the same feed to all of the
Log Decoders that are connected to NetWitness Platform.

Once the feed file is uploaded on the Log Decoders, for any new events, it enriches events meta data
with groupName, and appends this groupName to logstats.

Once the groupName is in logstats, the ESM Aggregator groups information and sends it to ESM. At this
point, you should see the Group Name column under the Event Source Monitoring tab.

The entire process can take some time. Therefore, you may need to wait for several seconds after you
add a new group or event source, before the Group name is displayed.
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Note: If the event source type attribute changes when the feed is updated, NetWitness Platform adds a
new logstats entry rather than updating the existing one. Thus, there will be two different logstats
entries in logdecoder. Previously existing messages would have been listed under the previous type,
and all new messages are logged for the new event source type.

Feed File

The format of the feed file is as follows:

DeviceAddress, Forwarder, DeviceType, GroupName

The DeviceAddress is either ipv4, ipvé6, or hostname, depending on which of these have been
defined for the event source.

The following is a sample of the feed file:

"12.12.12.12","d6", "NETFLOW", "grpl"

"12.12.12.12","1d4", "netflow", "grpl"

"12.12.12.12","de", "netfow", "grpl"
"0:E:507:E6:D4DB:E:59C:A","10.25.50.243", "apache", "Apachegrp"
"1.2.3.4","LCC", "apache", "Apachegrp"
"10.100.33.234","LC1", "apache", "Apachegrp"
"10.25.50.248","10.25.50.242", "apache", "Apachegrp"
"10.25.50.251","10.25.50.241", "apache", "Apachegrp"
"10.25.50.252","10.25.50.255", "apache", "Apachegrp"
"10.25.50.253","10.25.50.251", "apache", "Apachegrp"
"10.25.50.254","10.25.50.230", "apache", "Apachegrp"
"10.25.50.255","10.25.50.254", "apache", "Apachegrp"
"13.13.13.13","LC1", "apache", "Apachegrp"
"AB:F255:9:8:6C88:EEC:44CE:7",, "apache", "Apachegrp"
"Appliancel234",, "apache", "Apachegrp"
"CB:F255:9:8:6C88:EEC:44CE:7","10.25.50.253", "apache", "Apachegrp"

Troubleshooting

You can check the following items to narrow down where the problem is occurring.

Feed File Existence

Verify that the feeds ZIP archive exists in the following location:

/opt/rsa/sms/esmfeed.zip

Do not modify this file.
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Group Meta Populated on LD

Verify that the group meta is populated on the Log Decoder. Navigate to the Log Decoder REST and
check logstats:

http://LogDecoderIP:50102/decoder?msg=logStats&force-content-type=text/plain

This is a sample logstats file with group information:

device=apache forwarder=NWAPPLIANCE10304 source=1.2.3.4 count=338
lastSeenTime=2015-Feb-04 22:30:19 lastUpdatedTime=2015-Feb-04 22:30:19
groups=IP1234Group, apacheGroup

device=apachetomcat forwarder=NWAPPLIANCE10304 source=5.6.7.8 count=1301
lastSeenTime=2015-Feb-04 22:30:19 lastUpdatedTime=2015-Feb-04 22:30:19

groups=AllOtherGroup,ApacheTomcatGroup

In the above text, the group information is bold.

Device Group Meta on Concentrator

Verify that the Device Group meta data exists on the Concentrator, and that events have values for the
device.group field

Device Group (8 values) L
testgroup (28,878) - localgroup (3,347) - squid (3,346) - allothergroup (780) - apachetomcatgroup (561) - ip1234group (457) - cacheflowelff (219) - apachegroup (91)

sessionid = 22133

time = 2015-02-05T14:35:03.0
size = 9

lc.cid = "NWAPPLIANCE10304"
forward.ip = 127.0.01

device.ip = 20.20.20.20 ~
medium = 32

device.type = "unknown" =
device.group = "TestGroup”
kig_thread = "o

SMS Log File

Check the SMS log file in the following location to view informational and error messages:
/opt/rsa/sms/logs/sms.log

The following are examples informational messages:

Feed generator triggered...

Created CSV feed file.
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Created zip feed file.

Pushed ESM Feed to LogDeocder : <logdecoder IP>

The following are examples of error messages:

Error creating CSV File : <reason>Unable to push the ESM Feed: Unable to
create feed zip archive.

Failed to add Group in CSV: GroupName: <groupName> : Error: <error>

Unable to push the ESM Feed: CSV file is empty, make sure you have al-least on
group with al-least one eventsource.

Unable to push the ESM Feed: No LogDecoders found.

Unable to push the ESM Feed: Unable to push feed file on LogDecoder-
<logdecoderIP>Unable to push the ESM Feed:
admin@<logdecoderIP>:50002/decoder/parsers received error: The zip archive
"/etc/netwitness/ng/upload/<esmfeedfileName>.zip" could not be opened

Unable to push the ESM Feed: <reason>

Verify Logstats Data is Getting Read and Published by ESMReader
and ESMAggregator

These are the steps to verify that logstats are collected by collectd and published to Event Source
Management.

ESMReader
1. On LogDecoders add the debug "true' flag in /etc/collectd.d/NwLogDecoder ESM.conf:

#
# Copyright (c) 2014 RSA The Security Division of EMC
#
<Plugin generic_ cpp> PluginModulePath "/usr/lib64/collectd"
debug "true"
<Module "NgEsmReader" "all"> port "56002"
ssl "yes"
keypath "/var/lib/puppet/ssl/private keys/d4c6dcd4-6737-4838-
a2f7-ba7e9%9alcS5aae.pem"
certpath "/var/lib/puppet/ssl/certs/d4c6dcd4-6737-4838-a2f7-
ba7e9%9al65aae.pem"
interval "600"

query "all"
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<stats></stats></Module><Module "NgEsmReader" "update"> port
"56002" ssl "yes"

keypath "/var/lib/puppet/ssl/private keys/d4c6dcd4-6737-4838-
a2f7-ba7e9%9alcS5aae.pem"

certpath "/var/lib/puppet/ssl/certs/d4c6dcd4-6737-4838-a2f7-
ba7e9%9al65aae.pem"

interval "o60"

query "update"

<stats></stats></Module></Plugin>

2. Run the command:
collectd service restart

3. Run the following command:

tail -f /var/log/messages | grep collectd

Verify that ESMReader is reading logstats and there are no errors. If there are any read issues, you

will see errors similar to the following:
Apr 29 18:47:45 NWAPPLIANCE15788 collectd[14569]: DEBUG: NgEsmReader all:
error getting ESM data for field "groups" from logstat device=checkpointfwl
forwarder=PSRTEST source=1.11.51.212. Reason: <reason>Apr 29 18:58:36
NWAPPLIANCE15788 collectd[14569]: DEBUG: NgEsmReader update: error getting ESM
data for field "forwarder" from logstat device=apachetomcat

source=10.31.204.240. Reason: <reason>

ESMAggregator
1. On NetWitness Platform, uncomment the verbose flag in /etc/collectd.d/ESMA ggregator.conf:

# ESMAggregator module collectd.conf configuration file

#

# Copyright (c) 2014 RSA The Security Divsion of EMC

#

<Plugin generic_ cpp> PluginModulePath "/usr/lib64/collectd"

<Module "ESMAggregator">
verbose 1
interval "o60"

cache save interval "600"
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persistence dir "/var/lib/netwitness/collectd"

</Module> </Plugin>

2. Run the following command:
collectd service restart

3. Run the following command:
run “tail -f /var/log/messages | grep ESMA
Look for for ESMAggregator data and make sure your logstat entry is available in logs.

Sample output:

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: MetaDatal[O0]
logdecoder[0] = d4c6dcd4-6737-4838-a2f7-ba7e%al6baae

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: MetaDatal[l]
logdecoder utcLastUpdate[0] = 1425174451

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: MetaDatal[2]
groups = Cacheflowelff,Mixed

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: MetaDatal[3]
logdecoders = d4c6dcd4-6737-4838-a2f7-ba7e%al65aae

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: MetaDatal[4]
utcLastUpdate = 1425174451

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: Dispatching
ESM stat NWAPPLIANCE15788/esma_ update-cacheflowelff/esm counter-3.3.3.3 with a
value of 1752 for NWAPPLIANCE15788/cacheflowelff/esm counter-3.3.3.3
aggregated from 1 log decoders

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: MetaDatal[O0]
logdecoder[0] = 767354a8-5e84-4317-bc6a-52e4f4d8bfff

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: MetaDatal[l]
logdecoder utcLastUpdate[0] = 1425174470

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: MetaDatal[2]
groups = Cacheflowelff,Mixed

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: MetaDatal[3]
logdecoders = 767354a8-5e84-4317-bc6a-52e4f4d8bfff

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: MetaDatal[4]
utcLastUpdate = 1425174470

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: Dispatching

RRD stat NWAPPLIANCE15788/esma_ rrd-cacheflowelff/esm counter-3.3.3.3 with a
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value of 1752 for NWAPPLIANCE15788/cacheflowelff/esm counter-3.3.3.3

aggregated from 1 log

Configure JMX Feed Generator Job Interval

Although the feed generation job is scheduled to execute every minute by default, you can change this by
using jconsole.

To change the feed generator job interval:

1. Open jconsole for the SMS service.

2. On the MBeans tab, navigate to com.rsa.netwitness.sms > API > esmConfiguration > Attributes.
3. Modify the value for the property FeedGeneratorJobIntervallnMinutes.
4

Go to Operations under the same navigation tree, an click commit(). This persists the new value in
the corresponding json file under /opt/rsa/sms/conf, and uses the value if SMS is restarted.

Setting a new value reschedules the feed generator job for the new interval.

167 Troubleshoot NetWitness Platform



System Maintenance Guide

Troubleshooting Cert-Reissue Command

You must contact Customer Support (https://community.rsa.com/docs/DOC-1294) to troubleshoot
problems. You know there is a problem if any <host-id> does not return a SuccessStatus. Success
indicates that certificates were reissued for a host.

Argument Options Used for Troubleshooting

You use the following argument options with cert-reissue --host-all to troubleshoot problems.

Youcanrun cert-reissue --host--all<arguments> multiple times without an adverse effect.

Note: Use the following Argument Options with caution. They force the cert-reissue command to
execute for all the hosts.

--skip-health- Reissues certificates for all hosts at one time without applying system health
hISIELe checks (force Reissue). This means that the command does not:

« verify that all hosts are online line.

« verify that all services are running.

Use case: You have numerous hosts and you know that a small minority of
them will fail. This updates all the hosts that conform to the checking rules and
you can reissue certificates for the others subsequently with the help of
Customer Support.

—;Skikp—ver sion- Do not verify that hosts are running version 11.4.0.0 or later.
cnecks

Use Case: You have numerous hosts and your know that some of them are not
updated to 11.4 or later. This reissues certificates for all the hosts that are at
11.4 or later and you can reissue certificates for the others subsequently with
the help of Customer Support.

--ignore-trigger-  Jgnore any errors that trigger failures. This option forces the cert reissue
errors process to continue disregarding the errors instead of aborting or failing the
cert reissue command quickly.

When a cert reissue for a host succeeds, the reissued certificates on that host
are not provisioned to other dependent hosts (referred to as trusts). In this
case, the:

« host with reissued certificates is reported as “Partial.”

« the hosts with trusts that failed to update are listed separately in the
summary table to tell you that these hosts may require a refresh using the
new --refresh-trusts-only option.

“iefreSh‘trUStS‘ Refreshes trusts exclusively for host identified by <id> (does not reissue
e certificates for that host).
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Problems and How to Troubleshoot Them

This section describes solutions to problems that you may encounter when running the cert-reissue
command to reissue certificates with suggested causes and solutions.

Failed!

2019-02-06 13:34:39.646 INFO 8540 --- [ main]
c.r.n.i.o.client.OrchestrationClient : Checking host connections...

2019-02-06 13:34:57.861 ERROR 8540 --- [ main]
c.r.n.i.o.client.HostValidator : Host '192.168.200.99' (nw-platform-esa-
primary) verification failed!

2019-02-06 13:34:57.862 INFO 8540 --- [ main]
c.r.n.i.o.client.OrchestrationClient : Checking status of services...
2019-02-06 13:35:57.931 ERROR 8540 --- [ main]

c.r.n.i.o.client.HostValidator : Service 'nw-platform-node-zero -
Investigate Server' not available!

e dmmm e e e e +
| | Host | Status | Message |
pommmmmmem ettt oo st Tt |
|<host-id>| <IP-address> |Failed! |failed to connect, is host online? |
|<host-id>| <IP-address> |Failed! |service(s) down |
|<host-id>| <IP-address> IN/A I[ Skipped... ] |
|<host-id>| <IP-address> IN/A I [ Skipped... ] |
|<host-id>| <IP-address> IN/A I[ Skipped... ] |
pommmmmeee mm Hommmmme e -

cert-reissue --host-all failed because one or more hosts are offline or one or more
run time services are unreachable. You can force this command to run in spite of this error
by specifying the ——-skip-health-checks option, that is:

cert-reissue --host-all--skip-health-checks

1. Bring appropriate hosts back online or make sure the NW Server hosts run time
services are running.

2. Run cert-reissue for the hosts affected.
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Failed!

—f——

| | | Status | Message |

" 4 -4 " - [ 1
| <host-id>| <IP-address> |Failed! |version <version-earlier-than-11.3.0.0> not supported|
| <host-id>| <IP-address> |Failed! |wversion <version-earlier-than-11.3.0.0> not supported|
| <host-id>| <IP-address> IN/B I[ Skipped... ]
|<host-id>| <IP-address> IN/B I[ Skipped... ]

| <host=id>| <IP-address> IN/A I[ Skipped... ]

+ + . 4 + .

cert-reissue -host-all command string failed because one or more hosts are
running a version earlier than 11.4.0.0

Note: You can force the reissue of certificates for the remaining hosts using the -
skip-version-checks argument.

Update the host to 11.4 or later and run cert-reissue for that host again.
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Partial

2019-02-06 02:27:09.078 ERROR 20647 --- [ main]
c.r.n.i.o.client.OrchestrationClient : Trigger failed for host '<IP-
address>' (nw-platform-decoder)

2019-02-06 02:27:09.079 ERROR 20647 --- [ main]
c.r.n.i.o.client.OrchestrationClient : Trigger failed for host '<IP-
address>' (nw-platform-concentrator)

2019-02-06 02:27:09.118 WARN 20647 --- [ main]
c.r.n.i.o.client.OrchestrationClient : One or more host(s) may require
manual refresh due to failed triggers:

| | Host |

R 0 -+

| <host-id>»| <JP-address> |

| <host-id>| <IP-address> |

: + + e +

| Host | Status | Message |

e ..o o B e s s |

| <host-id>»| <IP-address> |Partial |Reissue completed, triggers failed |
| <host-id>| <IP-address> IM/R I[ Skipped. ] |
| <host-id>| <IP-address> IN/A | [ Skipped... ] |
| <host-id>| <IP-address> IN/A | [ Skipped... ] |
| <host-id>| <IP-address> IN/A | [ Skipped... ] |
+ + e e +

cert-reissue command completed on NW Server host however one or more triggers
failed. This aborted the cert-reissue command for other hosts.

Address all the errors and run the cert-reissue --host--all<arguments> command
string again.
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Partial

2019-02-06 14:18:03.208 ERROR 17800 --- [ main]
c.r.n.i.o.client.OrchestrationClient : Trigger failed for host
'192.168.200.82"' (nw-platform-node-x)

2019-02-06 14:29:05.200 WARN 17800 --- [ main]
c.r.n.i.o.client.OrchestrationClient : One or more host(s) may require
manual refresh due to failed triggers:

Fmm Fomm e ——————————— +

e e e B ettt

| | Host | Status | Message |
fm—— e it + e e |
|<host-id>| <JP-address> |IFailed! |Cert reissue failed! |

|<host-id>| <JP-address> |Partial |Reissue completed, triggers failed I
|<host-id>| <JP-address> |Success | Cert reissue successful |
|<host-id>| <JP-address> |Success | Cert reissue successful |
| <host-id>| <JP-address> Iiggcess I_ Cert_'._ Ieissu_e successful |
tommm————— fommmmm—————————————— pm—————— e e e e — e — e —————— +

One or more hosts did not pass system health checks. In addition, one or more of the
unhealthy hosts are running core services, which will result in the NW Server host cert-
reissue to fail (because of failed triggers explained above). By disabling health checks
and trigger errors, you can continue the process and reissue certificates for the remaining
hosts. The NW Server host Status is reported as Partial because the cert-reissue
command completed for the NW Server but downstream triggers failed for other hosts.

Manually refresh the failed core hosts (to synchronize trust peers).

Submit the following command string to reissue certificates for healthy hosts.
cert-reissue --host-all --skip-health-checks --ignore-trigger-errors
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This section describes the NetWitness Platform user interface views in which you can perform system
maintenance tasks. You use this interface to:

o Monitor and maintain services (settings, statistics, command and message syntax, REST API, RSA
Console utility, and protocols supported in NetWitness Platform).

o Display the current NetWitness Platform version and license status.

o Manage your Local Update Repository from which you apply software version updates to hosts.

The following topics describe each interface in detail:

o« Health and Wellness View

o System View - System Info Panel
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Health and Wellness View

The Health and Wellness settings allow you to set and view alarms, monitor events, and view
policies and system statistics. For more details on each of these, see the following topics:

o Health and Wellness View - Alarms View

« Event Source Monitoring View

o Health and Wellness Historical Graphs

o Health and Wellness Settings View - Archiver

o Health and Wellness Settings View - Event Sources

o Health and Wellness Settings View - Warchouse Connector

o Monitoring View

« Policies View

o System Stats Browser View

References

174



System Maintenance Guide

Health and Wellness View - Alarms View

Y ou can monitor hosts and services to determine when user-defined limitations have been reached
by viewing all the active alarms. Policy rules, that you define or assign to hosts and services, in the
Policies tab trigger these alarms. You can:

o View all the alarms that are currently active for all your systems and services

o Select an alarm and view its details

What do you want to do?

Administrator ~ View the alarm status of NetWitness Monitor Alarms
Servers and services.

Administrator ~ View detailed information about a specific =~ Monitor Alarms
alarm.

Related Topics

Manage Policies

Quick Look

The required permission to access this view is Manage services. To access the Alarms view, go to
Admin > Health & Wellness. The Health & Wellness view opens with the Alarms tab
displayed. The Alarms tab contains an alarms list and an Alarm Details panel.
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[m] Active @ Higt dec WMounted Flesystem Disk Usage Perc 66%

O Active @ Hig Broker broker fon Rate (current)

O Active @ Hig Broker Session Rate Zero Broker s Session Rate {current)

a

a -

»
| Page 1 of1 | | € ™ AuwRefresh Items 1-22 of 22
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Time when the alarm was triggered.
Pl Status of the alarm:

o Active - the statistical threshold was crossed triggering the alarm.

e Cleared - the clearing threshold was crossed and the alarm is no longer active.
KBl Scverity assigned to this alarm:

o Critical
« High
¢ Medium

o Low
Name of the rule that triggers the alarm.
Service defined in the rule.
n Host on which the alarm is triggered.
Statistic selected in the rule that triggers the alarm.
n Value of the statistic that triggered the alarm.
n Identification number of the alarm.

Note: NetWitness Platform sorts the alarms in time order. You can sort the relevant parameters in
ascending or descending order.

This figure shows the Alarms tab with the Alarm Details panel expanded.
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RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

@ admin

nt Sources  Endpoint Sources  Health & Wellne:

Alarms Policies System Stats Browser  Event Source Monitoring Settings
= Delete
O nime state Rule Name service Hostname g 010-1852-0005
o Active Hy Inreachable broker Time 2019-01-10 06:49:52 PM
[m] Active Hest Unreachable Host archiver
O actve Log Decoder Capture Not Started Log Decoder logdec CRITICAL
— ogdec
Active Criticel Fllesystem Usage on Rabbitmg Message .. Host dec Log Decoder
O Active Packet Capture Pool Depleted Decader dec Log Decoder Monitoring Palicy
O Active Decader dec Log Decoder Capture Rate Zero
0 ctve sprure Rate 2 Decoder dee This Leg Decoder is presently capturing no logs.
[m] Active Archiver Aggregation Stopped Archiver
[m] Active Broker Aggregation St
o Active Concentretor etz R 2. Log Decoder capture interface
4 Active @ Critical  Log Decoder Capture Rate Zero Log Decoder logdec the correct interface in Administra
- - «this servicer -» Config; item ‘Capture Inte
Active Respond Server in Critical State Respond Server s The value should not be blank.
O ctve Broker Agere - 3. No logs are being received. Check your upstream log
— sources, including Log Collecrors, to ensure that they are
actve Communication Failure Betw E <ending logs
] Active Communi n Failure Betwee Host ) Stat Capture/Capture Packet Rate (current)
[} Active High Filesystem Usage Host dec o
- 1
Active High Filesystem Usage dec
[m] Active High Filesystemn Usage on Rabbitmq Mes: dec
a Active Broker Session Rate Zero broker o]
[m] Active Broker Session Rate Zero =2 (2] EX
o) SA_COB_LogDecoder P
(7] SA_COB_LogDecoder P
(] 272334b1-53dc-deff-87b2-2b3e 9387397
(9] ogdecoder_decoder/gsuge-capture.packet.rate
o] [ESRIS SA_OOB_LogDecoder_Policy01_Rule04:272334b1-53dc-defr-
5 878226368337 3cS o zdecoder_decoder/zauge
) capture.packetrate
| Page 1 of1 | | C ™ AumRefresh ftems1-220f22 f
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Alarm Details Panel

The Alarm Details panel displays information for the alarm selected in the Alarms list. It contains
all the information in the Alarms list plus the following fields.

Alarm Notified time

- Suppression start time

Suppression end time

Suppression start (selected time zone)
Suppression end (selected time zone)
I The Policy ID

A Thc Rule ID

BEM e Host ID

BN The Stat ID

Item key
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Event Source Monitoring View

Note: For NetWitness Platform 11.4.1, this view has been deprecated. To manage Event
Sources, use the Admin > Event Sources view. For details, see "About Event Source
Management" in the RSA NetWitness Platform Event Source Management Guide.
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Health and Wellness Historical Graphs

Configuring Archiver monitoring enables you to automatically generate notifications when critical
thresholds concerning Archiver aggregation and storage have been met. The Historical Graph view
provides a visualization of historical data.

Note: Historical graphs are not available for non-numeric statistics, and is indicated by a greyed-
out icon.

See the following topics for more details:

« Historical Graph View for Events Collected from an Event Source

« Historical Graph for System Stats

Historical Graph View for Events Collected from an Event Source

Note: For NetWitness Platform 11.4.1, this view has been deprecated. To manage Event
Sources, use the Admin > Event Sources view. For details, see "About Event Source
Management" in the RSA NetWitness Platform Event Source Management Guide.

Historical Graph for System Stats
To access the Historical Graph for the System Stats:
1. Goto ADMIN > Health & Wellness.
The Health & Wellness view is displayed with the Alarms tab open.
2. Click the System Stats Browser tab.
The System Stats Browser tab is displayed.

3. In the Historical Graph column, select b

The Historical graph for the selected statistic for a host is displayed.
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The figure displays the system stats view for the Memory Utilization statistics.

Historical Graph

Concentrator: Memory Utilization Time Frame | Current Day v

Zoom 1h 6h  12h 1d Al From | Feb 1, 2019 To | Feb 1, 2019

aom E

30M
08:00 09:00 10:00 11:00 12:00 13:00 14:00 15:00 16:00 17:00 18:00 15:00

L— “Feb | Iy 0 ] I? 12:00 — 1500 hjﬂ
4

m 3
— average

Click and drag in the plot area to zoom in

Parameters

You can customize the graph view as required. The table lists the various parameters used to
customize the historical graph view.

Time Frame Select the time frame for which you want to view the historical data.
The available options are: Current Day, Current Week Current Month,
and Current Year,

From <date> To Select the date range for which you want to view the historical data,
<date>

You can zoom in for a detailed view of the data in the Historical graph.

Zoom in function 1 and 2:

You can select one of the values to view the historical data for the selected value. The figure below
displays an example for the 6h frame selected for zoom in. The slider bar at the right bottom corner
is also changed to a 6h window.

Alternatively, you can slide the bar in the right hand corner to zoom in to a required frame.
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Historical Graph

Host: Mounted Filesystem Disk Usage Percent Time Frame | Current Momi v
Zoom Tw 2w 3w 1m Al From | Jun 29, 2017 To | Jul 14, 2017
7
8.5
s §
£
3
5.5
5
4.5
30. Jun 2. Jul 4. Jul 6. Jul 8. Jul 10. Jul 12 Jul 14, Jul
-
19. Jun 26 Jun 3 Ju 1 |
L] mn ]
average
Click and drag in the plot area to zoom in

Zoom in function 3:
You can click and drag in the plot area to zoom in for a required frame of time.

The figure below displays an example of how the graph appears while you click and drag.

Historical Graph

Host: Mounted Filesystem Disk Usage Percent Time Frame | Current Momi v
Zoom Tw 2w 3w 1m Al From | Jul 10, 2017 To | Jul 13, 2017

7

Tuesday, Jul 11, 18:00 6.5

average: 600 [

L 6 E
=
o

5.5

5

4.5

08:00 16:00 11, Jul 08:00 16:00 12. Jul 08:00 16:00 13. Jul 08:00
19. Jun 26. Jun 3. Jul TQ Ju [

average

Click and drag in the plot area to zoom in
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Health and Wellness Settings View - Archiver

To access the Archiver Monitoring view:
1. Go to Administration > Health & Wellness.
2. Select Settings > Archiver.

What do you want to do?

Administrator Monitor service details of Archiver Monitor Service Details

Quick Look

RSA| RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Services Event Sources Endpoint Sources Health & Wellness m  Security

s System Stats Browser  Event Source Monitoring ISR

To monitor Event Sources, s

nagement. To monicor Archiver and Warehouse Connector, see Health Palicy. -

Archiver Monitoring

These settings allow for notifications to be generated when critical Archiver and
storege have been met.

Aggregation Status
Notify After < -

For [l Failed [ Offiine

Aggregation Connection

Notify After Failing For S| minutes  ~

Storage Connection

Notify After Failing For C|minutes  ~

Storage Capacity

Storage Threshold By @ Space O Time

When Storage Size Is | %Ful When warm Storage Size Is R
Notification Type

Config:
Config:

[ Netwitness Platform Console [ Email [ Syslog Notification [ SNMP Trap Notification

Apply Cancel

Bl Displays Archiver Monitoring Panel

A Configures Archiver Monitoring Panel to automatically receive notification

Features

The following table lists the parameters required to configure Archiver to automatically generate
notification when critical thresholds are reached.
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Aggregation Notify After Number of minutes or hours after which you are notified of
Status aggregation status
For Failed - If enabled, you are notified when the
Archiver aggregation status is failed for the defined number
of minutes or hours.
Offline - If enabled, you are notified when the
Archiver aggregation status is offline for the defined number
of minutes or hours.
Aggregation Notify After Number of minutes or hours after which you receive
Connection  Failing for notification if the Archiver aggregation connection fails.
Storage Notify After Number of minutes or hours after which you receive
Connection  Failing for notification if the Archiver storage connection fails.
Storage Storage Threshold ~ Select Space if you want to receive a notification when the
Capacity By Archiver storage capacity exceeds the percentage defined in
the When Storage Size Is field.
Select Time if you want to receive a notification when the
files stored in the Archiver exceeds the defined number of
days in the When Oldest Storage File Is ficld.
When Storage Size Enter the percentage of used storage to trigger a notification.
Is
When Warm Enter the percentage of used storage on the warm server to
Storage Size Is trigger a notification.
Notification ~ Configure email or  Click to configure email so that you can receive notifications
Type distribution list in NetWitness Platform.
Configure Syslog Click to configure audit logs.
and SNMP Trap
servers
NW Console, Enable NW Console to get notifications on the NetWitness
Email, Platform UI notification toolbar.
) ) Enable Email to get email notifications.
Syslog Notification, _ _
SNMP Trap Enable Syslog Notification to generate syslog events.
Notification Enable SNMP Trap Notification to get audit events as
SNMP traps.
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Health and Wellness Settings View - Event Sources

Note: For NetWitness Platform 11.4.1, this view has been deprecated. To manage Event
Sources, use the Admin > Event Sources view. For details, see "About Event Source
Management" in the RSA NetWitness Platform Event Source Management Guide.
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Health and Wellness Settings View - Warehouse Connector

Configuring the Warehouse Connector monitoring enables you to automatically generate notification
when critical thresholds concerning Warehouse Connector and storage have been met.

Access the Warehouse Connector Monitoring view

1. Go to Admin > Health & Wellness.

2. Select Settings > Warehouse Connector.

What do you want to do?

Administrator View the details of Warehouse connector ~ Warehouse Connector Details View

Related topics

Monitor Service Details

Quick Look

The Warehouse Connector Monitoring view is displayed.

RSA| RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Hosts  Services rces Endpoint Sources  Health & Wellness  System  Security

Alarms Monitoring System Stats Browser  Event Source Monitoring [IESSSIRES

To monicor Event Sources, see s To monitor Archiver and Warehouse Connector, see Heslth Policy

r Monitoring

Th 0 e generared when crinical threshalds cencerning Warshanss Cannecrar and
sto
Notify Offline For £ Minutes v
Stream Status
Notify Stopped For < | Minu ~
sk Is o] seun _n
Sauree 15 Rehind 2| Sessions
Rejected Folder Size Is T | %Ful
Number Of Files In Permanent ~
Failure Folder >

n lis

ap S

Console O email [ sysiog [ SNMP Trap

RS /\ NETWITNESS' PLATFORM

Displays the Warehouse Connector Monitoring view panel.
Allows you to configure Warehouse Connector Monitoring parameters.
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Warehouse Connector Monitoring parameters

The following table lists the parameters required to configure the Warehouse Connector to
automatically generate notification when critical thresholds are reached.

Source or
Destination
Status

Notify Offline For

Stream Status Notify Stopped For

Disk Is

Source Is Behind

Rejected Folder Size
Is

Number Of Files in
Permanent Failure
Folder

Number of minutes or hours after which you receive a
notification if the source or destination connection fails.

Number of minutes or hours after which you receive a
notification when the Stream goes offline.

The limit on the percentage of disk usage after which
you would like to receive a notification.

Number of sessions after which a notification is raised if
the source goes behind the defined number of sessions.

Limit on the percentage of folder usage after which you
receive a notification.

Limit on the number of files in the permanent failure
folder after which you receive a notification.

Notification  Configure email or Click to configure email so that you can receive
Type distribution list notifications in NetWitness Platform.
Configure Syslog and  Click to configure audit logs.
SNMP Trap servers
NW Console, Enable NW Console to get notifications on the
Email, NetWitness Platform Ul notification toolbar.
Syslog Notification, Enable Email to get email notifications.
SNMP Trap Enable Syslog Notification to generate syslog events.
Notification Enable SNMP Trap Notification to get audit events as
SNMP traps.
References 186



System Maintenance Guide

Monitoring View

NetWitness Platform provides detailed statistics and other information about the host and the
individual NetWitness Platform services in Details views. You can view the current health of all the
hosts and the services running on the hosts in the Monitoring view.

What do you want to do?

Administrator View and Perform Procedures Monitor Hosts and Services

Quick Look

To access this view:
1. Goto ADMIN > Health & Wellness.
2. Click the Monitoring tab.

The Monitoring view is displayed.

RSA RESPONP1 \NVEST';"TE MONITOR CONFIGURE ADMIN 3 ‘kg:‘l]admin
Hosts S s Event Sources Endpoint S es Health & Wellness stem  Security
Alarms Monitoring Poli ies System Stats Browser ~ Event Source Monitoring Settings
Groups Hosts Filter
Name Count B B
= Stopped Services Stopped Processing Physical Drive Problems Logical Drive Problems Full Filesystems
Sal
@ 0 7 2 host(s) 0 host(s) 0 host(s)
& group -] o
ARCH s CPU:0.3% M 5.37 GB/125.64 GB
5 SubscriptionGroups [-) = et e
Service Health Staws  Rate Name Service Type (=1} Memary Usage Uptime
Ready 0 arc) Archiver 2.5% 613.52MB 3 hours 20 minutes 33 seconds
Ready 0 arc Workbench 03% 2814 MB 3 hours 20 minutes 42 seconds
3 BROK Status: CPU: 0.43% Memory: 2.56 GB/125.64 GB
Service Health Status ~ Rate Name Service Type. cPU Memory Usage Uptime
Ready 0 BROK - Broke: Broker 0.6% 113.80 MB 3 hours 20 minutes 45 seconds
B CONC Status: CPU:0.39% Memory: 8.90 GB/94.21 GB
Service Health Status ~ Rate Name service Type cPU Memory Usage Uptime
Ready 0 CONC - Concentrator Concentrator 45% 938.57 ME 3 hours 20 minutes 12 seconds
B decode Status: CPU: 0.23% Memary: 5.84 GB/109.89 GB
Service Health Status ~ Rate Name Service Type. cPU Memory Usage Uptime
Ready [ ] 0 Decoder 0.8% 215G8 52 minutes 2 seconds
B ELHYE Status: CPU: 1.83% Memory; 35.86 GB/125.64 GB .
‘ v
| Page 1 |of2 | 3} VI C Displaying 1-10 of 16

R S/\ NETWITNESS' PLATFORM

The Monitoring tab shows health statistics for the NetWitness Platform hosts and services.
The Group panel enables you to view statistics for a selected group.
The Hosts panel displays operational statistics.
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Groups Panel

The Groups panel lists all of the groups of hosts available. When you select a group, the associated
content is displayed in the Hosts panel.

Note: If the total host count in the Groups panel is lower than the actual number of hosts displayed
in the Hosts panel, refer to the Troubleshooting Health & Wellness topic for possible causes of
this issue and recommended solutions.

Hosts Panel

The Hosts panel displays operational statistics for hosts and the services running on each host.

Filter Type a host name or a service name in the Filter field to display the corresponding
hosts and services in the Host panel.

Stopped Click Stopped Services to display a list of all stopped services. It also displays
Services the host on which the service is installed.

Stopped Click Stopped Processing to display a list of all the hosts that have services
Processing installed on them that are in the stopped processing status.

Physical Click to view the hosts that have physical drive problems.

drive

Problems

<#> host(s)

Logical Drive Click to view the hosts that have logical drive problems.

Problems

<#> host(s)

Full Click to view the hosts that have full file systems.

Filesystems

<#> host(s)

Note: The summary information in the boxes at the top displays the System Statistics for all of the
hosts configured in NetWitness Platform and does not change with the application of filters on the

groups.

Below the boxes at the top of the Hosts panel is a list of hosts, the services installed on them, and
information regarding the hosts and services.

Host Name  Displays the host name.
If a host has services installed that are not in view, you will see a E prefixed to the
host name.
Click B to view all the services installed on the host.
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Status Displays the status of the Host.
® - The host is active and running.

® _ The host is stopped or yet to start processing.
CPU Displays the current CPU usage of the host.

Memory Displays the Memory used by the host.

When you click E prefixed to the host name, a list of all the services installed on the host is
displayed. The table below describes parameters displayed for a service and their description.

Service Displays the status of the service.
® Ready - The service is active and running.
® Stopped - The service is stopped or yet to start processing.

Health Displays the processing status of the service.
Status ® - The process is running and the data is being processed at a rate greater than
Zero.

® _ The processing is stopped.
@ - The processing is turned on but the data is not being processed.

Rate Shows the rate at which data is being processed.

Name Name of the service in the format <host> - <service>. Click the link in the
Name field to get additional service details.

Service Name of the type of service.

Type

CPU Shows the current CPU usage of the service.

Memory Displays the Memory used by the service.

Usage

Uptime Displays the time for which the service has been running.
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Archiver Details View

The Archiver Details view provides information about the Archiver. The following figure shows the
Archiver details.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN d:‘l;lsdmln

Ho s Event Sources  Endpoint ¢ es Health & Wellness

Alarms Monitoring Policies System Stats Browser ~ Event Source Monitoring Settings

HOST AND SERVICES " q
Archiver Details
Host
Service
I Archiver
[0 3% Used Memo! 319.57 MB
Workbench v
Running Since 2019-Mar-04 20:50:06 Max Pracess Memary 125.64GB
Build Date 2019-Feb-26 15:10:02 Version Information 11.3.00
Details
Aggregation State started Time Begin 2019-Feb-28 14:16:00
Session Free Pages 157 Time End 2019-Mar-06 16:45:23
Meta Free Pages 37500 Session Rate Max 31564
Database Status Session Rate 0
Database Session Rate Database Session Free Space
Database Session Rate Max Database Session Volume Bytes

RS /\ NETWITNESS' PLATFORM

For the related procedure, see Monitor Service Details

This section displays the current generic statistics for the service.

Description

Aggregation State of data aggregation.
State

Time Begin Time (UTC) when the first session was tracked by the index.

Session Free Session pages available for aggregation.
Pages

Time End Time (UTC) when the last session was tracked by the index.

Meta Free Pages available for aggregation.
Pages

Session Maximum sessions per second rate.
Rate Max
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satste [pescrpton

Database
Status

Session
Rate

Database
Session
Rate

Database
Session Free
Space

Database
Session
Rate Max

Database
Session
Volume
Bytes

Status of databases. Valid values are:

e closed - not available for QUERY and UPDATE (databases are being
initialized). This value is seldom seen.

o opened - available for QUERY and UPDATE.

e failure - failed to open. This can happen for any number of reasons. You can
check this if CAPTURE fails to start or if queries fail to return data. This is
normally caused by database corruption.

Sessions per second rate.

Per second rate at which the service is writing sessions to the database.

Amount of session free space available for aggregation.

Maximum per second rate at which the service is writing sessions to the database.

Number of session bytes in the database.
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Broker Details View

The Broker Details view provides information about the Broker. The following figure shows the
Broker details.

RSA RESPOND  INVESTIGATE MONITOR CONFIGURE  ADMIN @ admin

Hosts e Sources Endpoint Sources  Health & Wellness

Alarms  Monitoring  Polides  System Stats Browser  Event Source Monitoring  Settings

HOST AND SERVICES

Broker Details

Host
Service
| Broker
Reporting Engine cPu 0.5% Used Memory 0.52 M8
Running Since 2019-Feb-25 14:59:44 Max Process Memory 314268
Orchestration Server
Build Date 20194an-08 1746113 Version Information
Security Server
Admin Server Details
Config Server
& Agzregation State stopped Weta Rate o
S RTI Session Rate o Meta Rate Max 0
Integration Server Session Rate Max

Content Server

Source Server

RS/\ NETWITNESS' PLATFORM

For the related procedure, see Monitor Service Details.

This section displays the current generic statistics for the service.

Description

Aggregation State  State of data aggregation.

Meta Rate Metadata objects per second rate.

Session Rate Sessions per second rate.

Meta Rate Max Maximum metadata objects per second rate.

Session Rate Max Maximum sessions per second rate.
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Concentrator Details View

The Concentrator Details view provides information about the Concentrator. The following figure
shows the Concentrator details.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN (_;:Dadmin frZ‘J

Hosts Services Event Sources Endpoint Sources Health & Wellness Sy N Security

Alarms Monitoring Policies System Stats Browser ~ Event Source Monitoring Settings adminserver concentrator @

HOST AND SERVICES
: Concentrator Details

Host

Service

I Concentrator
CcPU 1.4% Used Memory 170.57 MB
Running Since 2019-Feb-01 04:47:17 Max Process Memory 780GB
Build Date 2019-Jan-28 18:52:20 Version Information 11.3.00
Details
Aggregation State started Time Begin 2016-Jun-24 06:19:03
heta Rate 0 Time End 2019-Feb-01 20:21:02
Meta Rate Max 238
Session Rate 0
Session Rate Max 9

R S/\ NETWITNESS' PLATFORM

For the related procedure, see Monitor Service Details

The section displays the current generic statistics for the service.

Description

Aggregation State State of data aggregation.

Time Begin Time (UTC) when the first session was tracked by the index.
Meta Rate Metadata objects per second rate.
Time End Time (UTC) when the last session was tracked by the index.

Meta Rate Max Maximum metadata objects per second rate.
Session Rate Sessions per second rate.

Session Rate Max Maximum sessions per second rate.
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Decoder Details View

The Decoder Details view provides information about the Decoder. The following figure shows the
Decoder details.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN L@Jadmin

Hosts Services Event Sources Endpoint Sources Health & Wellness n Security

Alarms Monitoring Policies System Stats Browser ~ Event Source Monitoring Settings

HOST AND SERVICES Damsaer DeEils

Host
Service

I Decoder

Py 38.8% Used Memory 265GB
Running Since 2019-Mar-05 17:48:21 Max Process Memaory 0421 GB
Build Date 2019-Feb-26 15:05:58 Version Information 11.3.00
Details
Capture Status started Meta Bytes 40.00 KB
Capture Kept 0 bytes Meta Total 839
Capture Dropped 0 Packet Bytes 192.00 KB
Capture Dropped Percent 0% Packet Total 789
Capture Rate 0 Session Bytes 400KB
Capture Rate Max 0 Session Total 30
Time Begin Pool Packet Write 0
Time End Pocl Packet Assembler 0
Assemhbler Packet Pages 0 Pocl Packet Capture 500000

R'S/\ NETWITNESS' PLATFORM

For the related procedure, see Monitor Service Details.

This section displays the current generic statistics for the service.

Description

Capture Status of data capture. Valid values are:

Status e starting - Starting data capture (not capturing data yet).

e started - Capturing data.

e stopping - Stopping data capture (received request to stop data capture, but not
have not stopped capturing data yet).

o stopped - Not capturing data.

e disabled - Not configured as a Decoder service.

Meta Number of meta bytes in the database.
Bytes

Capture Number of packets kept during capture.
Kept

Meta Amount of metadata in the database.
Total
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e o

Capture Number of packets reported by the network card as dropped. After the service stops
Dropped  capturing data, the rate is reset to zero.

Packet Number of packet bytes in the database.

Bytes

Capture Packets reported by the network card as dropped as a percentage.

Dropped

Percent

Packet Number of packet objects held in the packet database. The total decreases when the

Total database rolls files off due to size constraints. After the service stops capturing data,
the number is not reset.

Capture Megabits per second rate at which the service is capturing data. Rate is a rolling

Rate average sample over a short time period (10 seconds). After the service stops
capturing data, rate is reset to zero.

Session Number of session bytes in the database.

Bytes

Capture Maximum megabits per second rate at which the service is capturing data. Rate is a

Rate Max rolling average sample over a short time period (10 seconds). After the service stops
capturing data, displays the maximum rate during data capture.

Session Number of sessions held in the session database. This value shrinks when the
Total database rolls files off due to size constraints. After the service stops capturing data,
the number is not reset.

Time Time when first packet was captured (time when the first packet was stored in the

Begin packet database). This time increases as packets are rolled out of the packet
database.

Pool Number of packet pages currently in the PCS pipeline that need to be written to the

Packet database.

Write

Time End Time when the last packet was captured (time when packet was written to the
database). The time increases as new packets are captured.

Pool Number of pool packet pages waiting to be assembled.
Packet
Assembler

Assembler Number of packet pages waiting to be assembled.
Packet
Pages

Pool Number of packet pages available for capture.
Packet
Capture
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ESA Correlation Details View

The ESA Correlation Details view provides information for the ESA Correlation service. The
following figure shows the ESA Correlation service details.

RSA. RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN ’j)admin & (EJ

Hosts Services Event Sources Endpoint S Health & Welln System  Security

Alarms Monitoring Policies System Stats Browser  Event Source Monitoring Settings ESAPrimary @

HOST AND SERVICES . i g
ESAPrimary - ESA Correlation Details
Host
Service
Contexthub Server
. A CPU 0.24 Used Memory 4.02GB
Entity Behavior Analytics ’
Running Since 2019-Mar-15 08:10:07 Max Process Memary 15.30 GB
SA Correlation
| sa correlation Build Date 2019-Mar-09 01:45:29 Version Infarmation 11.3.00
Health Stats VM
Configuration Update Status Healthy Process Modules Healthy
Process VM Memaory Security PKI Certificate Healthy
Data Connection
RS /\ NETWITNESS' PLATFORM 11.3.00

For the related procedure, see Monitor Service Details.

Many services, including the ESA Correlation service, have Health Stats and Java Virtual Machine
(JVM) tabs. The Health Stats tab provides information about the health status of the service. The
JVM tab shows the total memory used by the selected service and the total memory capacity of the
host.

For more information on the ESA Correlation service and ESA Rule memory usage, see the Alerting
with ESA Correlation Rules User Guide.

Health Stats Tab

The Health Stats tab provides information about the health status of the selected service.

Health Stats VM

Configuration Update Status Healthy Process Modules Healthy
Process JVM Memary Healthy Security PKI Certificate Healthy
Data Connection Healthy

The services on this tab can show one of three states:
e Healthy: The service is healthy.

e Unhealthy: The service is mostly functional, but it needs attention to mitigate potential down
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time.

e Fatal: Action needs to be taken to restore the service.

m

Configuration Indicates whether the service requires a restart for configuration changes to take
Update effect. If the Configuration Update Status shows as Unhealthy, restart the service.
Status

Process JVM  Indicates the memory usage status. An Unhealthy status occurs when heap

Memory memory usage is greater than or equal to 80%. A Fatal status occurs when heap
memory usage is greater than or equal to 95%. If the service is using too much
memory, you can add more memory or move services to other hosts. For more
details on memory usage, go to the JVM tab.

Data Indicates the health of the database connection of the service to MongoDB.
Connection

Process Indicates the health of the service. If a service is starting up, it shows as
Modules Unhealthy since its health is not yet determined. A service is Healthy if it is up

and running properly. A service shows as Fatal if it is running in upgrade mode or
if the service is running in safe or degraded mode.

Security PKI  Indicates the service certificate health. It shows as Healthy if a given X509
Certificate certificate is self-signed.

JVM Tab

The JVM tab shows the total memory used by the selected service and the total memory capacity of
the host.

Health Stats Jvm

JVM Total Memory Max 64.00 GB VM Total Memory Used 2310GB

m

JVM Total Memory Max Shows the total memory capacity for the entire host.

JVM Total Memory Shows the total memory used by all services and processes on the
Used host.

ESA Analytics Details View

The ESA Analytics Details view provides health status information about the selected ESA
Analytics service. ESA Analytics services process the data for automated threat detection. It is
important that you address any item that shows a status other than healthy, so that data processing is
not interrupted and critical events are not missed.

The following figure shows the ESA Analytics Details view.
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HEALTH & WELLNESS SECURITY

Monitoring Policies System Stats Browser  Event Source Monitoring Settings NWAPPLIANCE10604 @

Event Stream Analytics Server Details

Host
Service
Event Stream Analysis
cpu 0.1% Used Memory 653.36 MB
Contexthub Server .
Running Since 2017-Jul-13 08:04:02 Max Process Memory 3142 GB
Entity Behavior Analytics . J—— -
| enciy Benavior analy Build Date 2017-4ul-05 18:39:19 Version Information
Health Stats VM
Configuration Update Status Healthy Process Modules Healthy
Process VM Memory Healthy Security PKI Certificate Healthy
Data Connection Healthy

RS /\ NETWITNESS PLATFORM

For the related procedure, see Monitor Service Details.

Many services, including the ESA Analytics service, have Health Stats and Java Virtual Machine
(JVM) tabs. The Health Stats tab provides information about the health status of the service. The
JVM tab shows the total memory used by the selected service and the total memory capacity of the
host. For more information, see Health Stats Tab and JVM Tab.

For more information on ESA Analytics, see the Automated Threat Detection Guide and the ESA
Configuration Guide.

Host Details View

The Host Details view provides information about a host, as shown in the following figure.
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RSA| RESPOND  INVESTIGATE MONITOR CONFIGURE ADMIN @ admin® | (D

Hosts Services Event Sources Endpoint Sources Health & Wellness n  Security

Alarms Monitoring Policies System Stats Browser  Event Source Monitoring Settings adminserver @

HOST AND SERVICES

Host Details
| Host

System Info
Broker

Host adminserver Memory Utilization 69.51%
Reporting Engine - - Used Memory 327968
Qrchestration Server Running Since 2010-Feb-0: 4 Total Memory 4717 GB
Security Server Current Tima 2019-Feb-02 0. Cached Memory 478 GB
Admin server Uptime 4 hours 43 minutes 39 seconds Swap Utilization o

o Used Swap Obytes

System Info e s s .
Config Server Linux 3.10.0-862.14.4.17.x86_64 x86_64 ot Swap Lo0cs
Investigate Server
Respond Server Physical Drive || Logical Drive || File System Adapter Message Bus
Integration Server State Enclosure slot Failure Count Raw Size Inquiry Data

Content Server

Source Server

R'S /\ NETWITNESS PLATFORM

The options panel on the left displays the host and the services installed on the host. You can click
on a host or service to view the statistics and other pertinent information for that host or service.

The Details panel displays information that is specific to the host and provides additional information
regarding the hardware of the host.

For the related procedure, see Monitor Service Details

The top section displays the current performance, capacity, and historical statistics for the host.

Parameter Description

Host Hostname.

CPU Current CPU usage of the host.

Running Since Time when the host was started.
Current Time Current time on the host

Uptime Time for which the host has been active.
System Info OS version installed on the host.

Memory Utilization Percentage of memory utilized by the host.
Used Memory Memory used in GB.

Total Memory Capacity of the memory installed on the system.
Cached Memory Memory that is cached to disk in GB.

Swap Utilization Percentage of system swap in use.

Used Swap Swap used in GB.
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Total Swap Capacity of the swap installed on the system.

The lower section displays the current generic statistics for the host in the tabs described in the
following table.

Physical Type of physical drive, its usage and additional information of the physical drive on the
Drive host.

Logical  Logical drive on the host.
Drive

File File system information, the size, current usage, and available capacity on the host.
System

Adapter Adapter used on the host.

Message Publish In Rate - rate at which incoming messages are published to the message bus
Bus queue.
Total Messages Queued - number of messages in the message queue.
Memory Used - amount of memory used by the message bus (in bytes).
Disk Free - free disk space available for the message bus (in bytes).
Memory Limit - system memory limit. If the memory usage exceeds this value, this
trips the Memory Alarm and NetWitness Platform stops accepting messages.
Disk Free Limit - limit of free disk space available for the message bus. If the
available disk space falls below this value, this trips the Disk Free Alarm and
NetWitness Platform stops accepting messages.
Memory Limit Available - Amount of memory available to this message broker (in
bytes) before the Memory Used Alarm is tripped.
Disk Limit Available - Amount of free disk space available to this message broker (in
bytes) before the Disk Free Limit alarm is tripped.
Disk Free Alarm - True or False. True indicates that the available disk space is below
the value set in Disk Free Limit and NetWitness Platform has stopped accepting
messages.
Memory Alarm - True or False. True indicates that the available memory is below the
value set in Memory Limit and NetWitness Platform has stopped accepting messages.
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Log Collector Details View

The Log Collector Details view provides information for the Log Collector. The following figure
depicts the Log Collector Details.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN J} L@;‘\admin

Hosts Services Event Sources Endpoint Sources Health ness n Security

Alarms Monitoring Policies System Stats Browser ~ Event Source Monitoring Settings ELHYB @

AOSTAND SIS Log Collector Details

Host
Service

Concentrator
cPU 3.8% Used Memo! 1.04GB

| Log coltector v

Running Since 2019-Mar-04 21:18:44 Max Process Memaory 125.64GB

Log Decoder

e Build Date 2019-Feb-26 19:08:37 Version Information 11.3.00

Endpoint Server

Collection || Event Processing

Transport Protocol Status EPS Total Events Errors Warnings
checkpoint stopped 0 0 0 0 o
netflow stopped 0 0 0 0
file stopped 0 0 0 0
sdes stopped 0 0 0 0
adbe stopped 0 0 0 0
vmware stopped 0 0 0 0
sysiog stopped 0 0 0 0
windows stopped 0 0 0 0

R'S/\ NETWITNESS' PLATFORM 11.3.0.0

For the related procedure, see Monitor Service Details.

The lower section consists of the Collection and Event Processing tabs that display generic statistics
for the service.

Collection Tab

Displays the event collection statistics for each Log Collection protocol you have implemented in
NetWitness Platform (see "Log Collection Getting Started Guide" in the Log Collection Guides).

Event Processing Tab

Displays statistics for the NetWitness Platform internal event processing protocol (that is, the Log
Decoder) for Log Collection.

Parameter | Description

Transport NetWitness Platform protocol use for Log Collections (that is, the Log Decoder).
Protocol
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Parameter | Description

Status Status of the Log Decoder. Valid values are:
e starting - Starting data capture (not capturing data yet).
o started - Capturing data.

e stopping - Stopping data capture (received request to stop data capture, but not
have not stopped capturing data yet).

e stopped - Not capturing data.

o disabled - Not configured as a Decoder service.

EPS Rate (events per second) at which this the Log Decoder is processing events from
the Log Collector.

Total Events Total events processed by the Log Decoder.
Errors Number of errors encountered.
Warnings Number of warnings encountered.

Byte Rate Current throughput in bytes per second.

Log Decoder Details View

The Log Decoder Details view provides information for the Log Decoder. The following figure
shows the Log Decoder Details.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Hosts Services Event Sources Endpoint Sources Health & Wellness  System  Security

LE Monitoring Policies System Stats Browser ~ Event Source Monitoring Settings

HOST AND SERVICES .
Log Decoder Details
Host
Service
Concentrator
cPU 97% Used Memot 8.10 GB
Log Collector v
Running Since 2019-Mar-05 08:44:53 Max Process Memory 12554G3
| og pecoder Build Date 2010-Feb-26 15:06:05 Version Information 11200
Endpoint Server
Details
Capture Status started Packet Rate Max 1
Events Per Second 7 Poal Packet Capture 749998
Meta Rate 2% Pocl Packet Assembler 0
Meta Rate Max 88 Assembler Packet Pages 0
Capture Dropped 0 Pool Packet Write 0
Capture Dropped Percent 0% Time Begin 2019-Mar-05 08:45:28
Time End 2019-Mar-06 20:30:52

R'S/\ NETWITNESS' PLATFORM

For the related procedure, see Monitor Service Details.

This section displays the current generic statistics for the service.
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e o

Capture
Status

Packet
Rate Max

Events Per
Second

Pool
Packet
Capture

Meta Rate

Pool
Packet
Assembler

Meta Rate
Max

Assembler
Packet
Pages

Capture
Dropped

Pool
Packet
Write

Capture
Dropped
Percent

Status of data capture. Valid values are:
e starting - Starting data capture (not capturing data yet).

e started - Capturing data.

e stopping - Stopping data capture (received request to stop data capture, but not
have not stopped capturing data yet).

o stopped - Not capturing data.

e disabled - Not configured as a Log Decoder service.

Maximum per second rate at which the service is writing packets to the
database. Rate is a rolling average sample over a short time period (10 seconds).
After the service stops capturing data, displays the maximum rate during data
capture.

Rate (events per second) at which the Log Decoder is processing events from the Log
Collector.

Number of packet pages available for capture.

Per second rate at which the service is writing metadata objects to the database. Rate
is a rolling average sample over a short time period (10 seconds). After the service
stops capturing data, rate is reset to zero.

Number of packet pages waiting to be assembled.

Maximum per second rate at which the service is writing metadata objects to the
database. Rate is a rolling average sample over a short time period (10 seconds).
After the service stops capturing data, displays the maximum rate reached during data
capture.

Number of packet pages waiting to be assembled.

Number of packets reported by the network card as dropped. After the service stops
capturing data, rate is reset to zero.

Number of packet pages in the PCS pipeline that need to be written to the database.

Packets reported by the network card as dropped as a percentage.
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Description
Time Time when first packet was captured (time when the first packet was stored in the
Begin packet database). This time increases as packets are rolled out of the packet
database.

Time End Time when the last packet was captured (time when packet was written to the
database). The time increases as new packets are captured.

Malware Details View

The Malware Details view provides information for Malware Analysis. The following figure shows
the Malware Details.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN ‘kg:‘l:\admin

Hosts Services Event Sources Endpoint Sources ea nes m  Security

Alarms Monitoring Policies System Stats Browser ~ Event Source Monitoring Settings adminserver malware @

HOST AND SERVICES .
Malware Details

Host
Service

Broker

B CcPU 0.2% Used Memo: 437G
| malware Analysis v
Running Since 2019-Feb-01 00:25:10 Max Process Memory 15.67 GB
Build Date 2019-Jan-30 07:07:47 Version Information 11.3.00
Events M

Number Of Events For Past 24 Hours Average Processing Time 0 milliseconds
Number Gf Files For Past 24 Hours Events In Queue 0
Number Of Events For Past 7 Days Events Processed 0
Number Of Files For Past 7 Days Events Per Second Throughput 0

Number Of Events For Past Month Session Time Of Last Event
Number Of Files For Past Month

MNumber Of Events For Past 3 Months

Number Of Files For Past 3 Months

RS /\ NETWITNESS PLATFORM 113.00

For the related procedure, see Monitor Service Details.

Displays the following event-related statistical information for the Malware Analysis service.
o Number of events for the past 24 hours

o Average processing time

o Number of files for the past 24 hours

o Events in queue

o Number of events for the past 7 days

« Events processed

o Number of events for the past 7 days
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« Events per second throughput

o Number of events for the past month

o Session time of the last event

o Number of files for the past month

o Number of events for the past 3 months

o Number of files for the past 3 months

Warehouse Connector Details View

The Warehouse Connector Details tab provides information for the Warehouse Connector, such as
the date it was built, CPU, and version information. The following figure shows the Warehouse
Connector Details.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN @:}admin @J

Hosts Services Event Sources Endpoint Sources Health & Wellness  System  Security

LE Monitoring Policies System Stats Browser  Event Source Monitoring Settings 113GoldLH &

HOST AND SERVICES ,
Warehouse Connector Details

Host
Service

Concentrator
CPU 0.5% Used Memory

Log Collector
Running Since 2019-Mar-14 15:34:04 Max Process Memory

Log Decoder

g Build Date 2019-Mar-11 07:22:43 Versian Information
I Warehouse Connector
Details
Streams Complete 0 Streams Running 0
Streams Incomplate 0 Streams Stopped 0
Streams Total
RS /\ NETWITNESS  PLATFORM 11.3.0.0

For the related procedure, see Monitor Service Details.
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Policies View

The required permission to access this view is Manage services.

What do you want to do?

Administrator ~ View the policies NetWitness Server and Services Manage Policies

Administrator Add, Edit, Duplicate, and Delete Policies Manage Policies

Quick Look

The figure depicts the Policies view.

RSA RESPOND  INVESTIGATE MONITOR CONFIGURE  ADMIN

@ admin
Hosts Ev es Endpoin es Health lines: em  Security

1 2
Alarms  Monitoing NS  System Stats Browser  Event Source Monitoring  Settings

v v N
Policies Admin Server: Admin Server Monitoring Policy save
+ ZIB X Rules and suppression schedules of Out-of-the-box policies cannot be directly modified. Duplicate the policy ifyou wish to so madify tem

[ Enable Last Modified; 2017-02:20 12:00:00 AM
4 {5 Amin Server o -l
© Admin Server Monitoring Policy Services
» [ Archiver Choose the hosts, services, and groups that your health policy applies to.
» [ sroker +
» [ Cioud Gateway Server Name ~ Group Type
» [ Concentrator A e Group
» [ Config server
Dconte Rules

» [ Content Server Define the conditions under which you want to trigger an alarm for the NetWitness Platform health problems {definition includes severity, statistic the alarm applies to, threshold, and threshold at which the alarm dlears).
After you define the alarm rule, enable or disable the alarm

» [ Contextnub Server

» [ Decoder
0| enable | Name ~ Severity category statistic Threshold
» [JESA Correlation .
®  AdminServerinCriti.  Critical Processinfo Overall Processing Status Indicator Alarm = ERROR for 2 MINUTES <
» i -
[encty Benavior analyrics ®  AdminServerinUnn. High processinto Quersl Prozessing Ststus Indicstor Alarm = PARTIALLY_WORKING for 2 MINUTES
» [ Event Sream Analysis [0 @  AdminServerStopped  Critical Pracessinfa Servize Status Alarm 1= started for 0 MINUTES

» [ Host
Policy Suppression
» [Jintegrenion Server yupp
Define the time periods 1o suporess policles.
» [Jinvestigate Server

» [ Log Collector

Q000 O0OCOOCOOCOOOOOOO

o Dayz Time Fenge
» [ Log Decoder .
. Policy suppression is not allowed E.

https.// 10461 95/admin/appliances

Policies Panel
Policy Detail Panel

1. Goto ADMIN > Health & Wellness.
2. Click the Policies tab.

Policies Panel

In the Policies panel, you can add or delete policies for hosts and services in this panel.

References 206



System Maintenance Guide
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+ - Displays available service types to create a new policy. Select one so that you can
define a policy or policies for it.

- Deletes the selected policy from the Policies panel. You can only delete one policy at
a time.

z Allows you to change the name of the policy.

T:=j Creates a copy of the selected policy. For example, if you select First Policy and
click Tfj, NetWitness Platform creates a copy of this policy and names it First Policy
(.

pie Expands the list of policies under the services and hosts in the Policies panel.

HH Contracts the list of policies under the services and hosts in the Policies panel.
List of:

o Services and hosts for which you have defined policies.

o RSA standard policies that you can apply to hosts and services.

Policy Detail Panel

The Policy Detail panel displays the policy selected from the Policies panel.

e

Save Saves any changes you made in this panel.
Policy Type Displays the type of policy you selected.

Modified Displays the last date this policy was modified.
Date

[] Enable  Enables or disables the policy.

Services

+ & Displays menu in which you select:

o Groups to display the Groups dialog from which you select service groups to this
policy.

o Service/Host to display the Services/Hosts dialog from which you select
services to add to this policy. If the policy type is Host, the menu displays Host
(and not Service). You can select services based on policy type.

- Deletes the selected service or group from this policy.
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Rules

+ Displays the Add Rule dialog in which you define a rule for this policy.
- Deletes the selected rule from this policy.

z Displays the Edit Rule dialog for the selected rule.

Policy Suppression

4= Adds a policy suppression timeframe row.
- Deletes the selected policy suppression timeframe row.

Time Zone Selects the time zone for the Policy from the drop-down list. This time zone applies
to both Policy Suppression and Rule Suppression.

| Selects the checkbox to select a policy suppression timeframe row.

Days Days of the week that you want to suppress the policy according to the time range
specified. Click on the day of the week that you want to suppress the policy. You
can select any combination of days including all days.

Time Time range during which the policy is suppressed for the days selected.
Range
Notification
4= Adds an EMAIL notification row.
- Deletes the selected policy suppression timeframe row.

Notification Opens the Notification Servers view in which you can define the Email notification
Settings settings.

| Selects a policy suppression time frame row.

Output The type of notification defined on the Global Notifications page. Can be email,
SNMP, Syslog, or Script.

Recipient ~ The name of the person receiving the notification.

Notification Selects the EMAIL notification server. See "Configure Notification Servers" in the
Server System Configuration Guide for the source of the values in this drop-down list.
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Template Selects the Template for this EMAIL notification. RSA provides the Health &
Wellness Default SMTP Template and the alarms template. See" Configure
Notification Templates"in the System Configuration Guide for the source of the
other values in this drop-down list.

Note: Refer to Include the Default Email Subject Line if you want to include the
default Email subject line from the Health & Wellness template in your Health &
Wellness Email notifications for specified recipients.

Groups dialog

P peserpn

Groups panel
Name Displays the service groups you have defined. You can select:
o All to display all your services in the Services panel.

o A group to display the services in comprise that group in the Services
panel.

Services panel

Name Displays the name of the service.
Host Displays the host on which the service is running.
Type Displays the type of service.

Rules Dialog

i e

[] Enable Enables or disables the rule for this policy.

Name Describes the name of the rule.

Description Describes the rule. Include the following information in this field.

« Informational description - purpose of the rule and what problem it monitors.

o Remediation - steps to take to resolve the condition that triggers the alarm for this
rule.
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Severity Defines the severity of the rule. Valid values are:
o Critical
o High
o Medium
o Low
Statistic Defines the statistics you want to check with this rule. You can select:
« Statistical category from the left drop-down list.
« Statistic from the right drop-down list.

Note: For Public Key Infrastructure (PKI) policy, select PKI in the category and
statistics as any one of the following:

- NetWitness Server PKI Certificate Expiration - Displays the time left before the
certificate expires.

- NetWitness Server PKI CRL Expiration - Displays the time left before the
Certificate Revocation List (CRL) expires.

- NetWitness Server PKI CRL Status - Displays the current status of the CRL.

Refer to the System Stats Browser View for examples of the statistics you may want
to check with a rule.

Alarm Defines he threshold of the rule that triggers the policy alarm:

Threshold B

Note: For CRL expiry the supported format is ddddhhmm, for example:
- 10000 represents 1 day

- 2359 represents 23 hours and 59 minutes

- 10023 represents 1 day and 23 minutes

- 3650100 represents 365 days and 1 hour

o Time in minutes

Recovery  Defines when to clear the threshold of the rule:

o Operator

¢ Amount

o Time in minutes
Rule Suppression

+ Adds a rule suppression timeframe row.

- Deletes the selected rule suppression time frame row.
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] Selects a rule suppression time frame row.

Time Zone: Displays the Policy time zone. You select the time zone for a policy in the Policy
time-zone  Suppression panel.

Days Defines days of the week that you want to suppress the rule according to the time
range specified. Click on the day of the week that you want to suppress the rule.
You can select any combination of days including all days.

Time Defines the time range during which the rule is suppressed for the days selected.
Range

Threshold Operators

The Alarm Threshold and Recovery Threshold fields in the Rules dialog prompt you for either
numeric or string operators based on the statistic criteria you specify.

Numeric operators drop-down menu: String operators drop-down menu:
= - = -

I= I=

< Contains

<= !Contains

= Regex Match

== IRegex Match

InRange

lInRange

RSA Health & Wellness Email Templates

Note: Please refer to Include the Default Email Subject Line if you want to include the default
Email subject line from the Health & Wellness template in your Health & Wellness Email
notifications for specified recipients.

211 References



System Maintenance Guide

Health & Wellness Default SMTP Template

RSA NetWitness Suite

Health Alarm Notification

File Collection Service is off on HOST1000

State
Active

Severity
High

Host
HOST1000

Service
Log Collector

Alarmid
103-2248-0001

Policy
Check Point

Rule
File Collection Service is off

Statistic
Collection State

Value

stopped

Time

April 13, 2018 10:48:13 PM UTC
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Alarms Template

RSA NetWitness Suite

Health Alarm Notification

File Collection Service is off onHOST1000

State
Cleared

Severity
High

Host
HOST1000

Service
Log Collector

Alarmid
103-2248-0001

Paolicy
BootCamp Notification

Rule
Check Point Collection is off

Statistic
Collection State

Value
Policy-Disabled

Time
April 14, 2018 2:31:21 AMUTC

NetWitness Platform Out-of-the-Box Policies

The following table lists the NetWitness Platform Out-of-the-Box Policies with the rules defined for
each policy.

You can perform the following tasks on any of these policies:

o Change service and group assignments.

o Disable or enable policies.

You cannot perform the following tasks on any of these policies:
o Delete them.

o Edit Policy names.
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Note: Additional information about the Out-of-the-Box Policies can be found in the User Interface
under
Health & Wellness > Policies.

Policy Name Alarm Triggered

Communication Failure Host is down, Network is down, Message
Between Master NetWitness ~ Broker is Down, or Invalid or missing
Server Host and a Remote security certificates for 10 minutes or more.
Host
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Policy Name Alarm Triggered

For var/lib/rabbitmqg, Mounted
Filesystem Disk Usage goes over 75%.

NetWitness
Server
Monitoring Policy

Critical Usage on Rabbitmq
Message Broker Filesystem

Filesystem is Full

High Filesystem Usage

High System Swap Utilization

High Usage on
Rabbitmq Message Broker
Filesystem

Host Unreachable

LogCollector Event Processor
Exchange Bindings Status

LogCollector Event Processor
Queue with No Bindings

LogCollector Event Processor
Queue with No Consumers

Power Supply Failure

RAID Logical Drive
Degraded

RAID Logical Drive Failed

RAID Logical Drive
Rebuilding

RAID Physical Drive Failed

RAID Physical Drive Failure
Predicted

RAID Physical Drive
Rebuilding

RAID Physical Drive
Unconfigured

SD Card Failure

Overall Mounted Filesystem Disk Usage
reaches 100%.

Overall Mounted Filesystem Disk Usage
goes over 95%.

Swap Utilization goes under 5 % for 5
minutes or more.

Mounted Filesystem Disk Usage for
var/lib/rabbitmg goes over 60%.

Host down.

Issue with Log Collection Message Broker
Queues for 10 minutes or more.

Issue with Log Collection Message Broker
Queues for 10 minutes or more.

Issue with Log Collection Message Broker
Queues for 10 minutes or more.

Host not receiving power.

For Raid Logical Drive, Drive State equals
Degraded or Partially Degraded.

For Raid Logical Drive, Logical Drive State
equals Offline, Failed, or Unknown.

For Raid Logical Drive, Logical Drive State
equals Rebuild.

For Raid Physical Drive, Physical Drive
State does not equal Online, Online Spun
Up, or Hotspare.

For Raid Physical Drive, Physical Drive
Predictive Failure Count is greater than 1.

For Raid Physical Drive, Physical
Drive State equals Rebuild.

For Raid Physical Drive, Physical
Drive State contains Unconfigured (good).

SD Card Status does not equal ok.
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Policy Name Alarm Triggered

Archiver Aggregation Archiver Status does not equal started.
Stopped
. Archiver Database(s) Not Database Status does not equal opened.
NetWitness 0
pen

Platform
Archiver Archiver Not Consuming Devices Status does not equal consuming.
Monitoring From Service
Policy

Archiver Service in Bad State  Service State does not equal started or

ready.

Archiver Service Stopped Server Status does not equal started.
NetWitness Broker >5 Pending Queries Queries Pending greater than or equal to 5
Platform Broker for 10 minutes or more.
Monitoring Policy

Broker Aggregation Stopped  Broker Status does not equal started.

Broker Not Consuming From  Devices Status does not equal consuming.
Service

Broker Service in Bad State Service State does not equal started or

ready.

Broker Service Stopped Server Status does not equal started.

Broker Session Rate Zero Session Rate (current) equals 0 for 2 minutes
or more.
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Policy Name Alarm Triggered

NetWitness
Platform
Concentrator
Monitoring Policy

NetWitness
Platform Decoder
Monitoring
Policy

Concentrator >5 Pending
Queries

Concentrator Aggregation
Behind >100K Sessions

Concentrator Aggregation
Behind >1M Sessions

Concentrator Aggregation
Behind >50M Sessions

Concentrator Aggregation
Stopped

Concentrator Database(s) Not
Open

Concentrator Meta Rate Zero

Concentrator Not Consuming
From Service

Concentrator Service in Bad
State

Concentrator Service Stopped
Decoder Capture Not Started

Decoder Capture Rate Zero

Decoder Database Not Open

Decoder Dropping >1% of
Packets

Decoder Dropping >10% of
Packets

Decoder Dropping >5% of
Packets

Decoder Packet Capture Pool
Depleted

Decoder Service in Bad State

Decoder Service Stopped

Queries Pending greater than or equal to 5
for 10 minutes or more.

Devices Sessions Behind is greater than or
equal to 100000 for 1 minute or more.

Devices Sessions Behind is greater than or
equal to 1000000 for 1 minute or more.

Devices Sessions Behind is greater than or
equal to 50000000 for 1 minute or more.

Broker Status does not equal started.

Database Status does not equal opened.

Concentrator Meta Rate (current) equals 0
for 2 minutes or more.

Devices Status does not equal consuming.

Service State does not equal started or
ready.

Server Status does not equal started.
Capture Status does not equal started.

Capture Rate (current) equals 0 for 2
minutes or more.

Database Status does not equal opened.

Capture Packets Percent Dropped (current)
is greater than or equal to 1%.

Capture Packets Percent Dropped (current)
is greater than or equal to 10%.

Capture Packets Percent Dropped (current)
is greater than or equal to 5%.

Packet Capture Queue equals 0 for 2
minutes or more.

Service State does not equal started or
ready.

Server Status does not equal started.
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Policy Name Alarm Triggered

NetWitness ESA Overall Memory Total ESA Memory Usage % is greater than
Platform Event  Utilization > 85% or equal to 85 %.
Steam Analysis
Monitoring ESA Overall Memory Total ESA Memory Usage % is greater than
Policy Utilization > 95% or equal to 95 %.

ESA Service Stopped Server Status does not equal started.

ESA Trial Rules Disabled Trial Rules Status does not equal enabled.

NetWitness IPDB Extractor Service in Service State does not equal started or
Platform IPDB Bad State ready.

Extractor

Monitoring IPDB Extractor Service Server Status does not equal started.
Policy Stopped

NetWitness Incident Management Service Server Status does not equal started.
Platform Incident Stopped

Management

Monitoring

Policy

NetWitness Log Collector Service Server Status does not equal started.
Platform Log Stopped

Collector

Monitoring Log Decoder Event Queue >  Number of events currently in the queue is
Policy 50% Full using 50% or more of the queue.

Log Decoder Event Queue >  Number of events currently in the queue is
80% Full using 80% or more of the queue.

Log Collector Service in Bad  Service State does not equal started or
State ready.
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Policy Name Alarm Triggered

NetWitness Decoder Dropping>10% of Capture Packets Percent Dropped (current)
Platform Log Packets is greater than or equal to 10%
Decoder
Monitoring Log Capture Not Started Capture Status does not equal started.
Poli
otey Log Decoder Capture Rate Capture Rate (current) equals 0 for 2
Zero minutes or more.
Log Decoder Database Not Database Status does not equal opened.
Open
Log Decoder Dropping >1%  Capture Packets Percent Dropped (current)
of Logs is greater than or equal to 1%.
Log Decoder Dropping >5%  Capture Packets Percent Dropped (current)
of Logs is greater than or equal to 5%.
Log Decoder Packet Capture  Packet Capture Queue equals 0 for 2
Pool Depleted minutes or more.
Log Decoder Service Stopped Server Status does not equal started.
Log Decoder Service in Bad  Service State does not equal started or
State ready.
NetWitness Malware Analysis Service Server Status does not equal started.
Platform Stopped
Malware Analysis
Monitoring
Policy
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Policy Name Alarm Triggered

NetWitness
Platform
Reporting Engine
Monitoring
Policy

NetWitness
Platform
Warehouse
Connector
Monitoring
Policy

NetWitness
Platform
Workbench

Reporting Engine Alerts
Critical Utilization

Reporting Engine Available
Disk <10%

Reporting Engine Available
Disk <5%

Reporting Engine Charts
Critical Utilization

Reporting Engine Rules
Critical Utilization

Reporting Engine Schedule
Task Pool Critical Utilization

Reporting Engine Service
Stopped

Reporting Engine
Shared Task
Critical Utilization

Warehouse Connector
Service in Bad State

Warehouse
Connector Service Stopped

Warehouse
Connector Stream Behind

Warehouse
Connector Stream Disk
Utilization > 75%

Warehouse Connector
Stream in Bad State

Warehouse Connector Stream
Permanently Rejected Files >
300

Warehouse Connector Stream
Permanently Rejected Folder
> 75% Full

Workbench Service in Bad
State

Monitoring Policy Workbench Service Stopped

Alerts Utilization is greater than or equal to
10 for 5 minutes or more.

Available disk space is less than 10%.

Available disk space is less than or equal
to 5%.

Charts Utilization is greater than or equal to
10 for 5 minutes or more.

Rules Utilization is greater than or equal to
10 for 5 minutes or more.

Schedule Task Pool Utilization is greater
than or equal to 10 for 15 minutes or more.

Server Status does not equal started.

Shared Task Pool Utilization is greater than
or equal to 10 for 5 minutes or more.

Service State does not equal started or
ready.

Server Status does not equal started.

Stream Behind is greater than or equal to
2000000.

Stream Disk Usage (Pending Destination
Load) is greater than or equal to 75.

Stream Status does not equal consuming or
online for 10 minutes r more.

Number of files in the permanently rejected
files is greater than or equal to 300.

Rejected folder usage is greater than or
equal to 75%.

Service State does not equal started or
ready.

Server Status does not equal started.
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System Stats Browser View

NetWitness Platform provides a way to monitor the status and operations of hosts and services. The
System Stats Browser tab displays key statistics, service system information, and host system
information for a host or service.

You can customize the stats view depending on the parameter you select to filter the data.
To access the System Stats Browser view:
1. Goto ADMIN > Health & Wellness.
The Health & Wellness view is displayed with the Alarms tab open.
2. Click the System Stats Browser tab.

What do you want to do?

Administrator ~ View the System Stat Historical Graph Historical Graph for System Stats

Related Topics

Monitor Service Statistics

Filter System Statistics

Quick Look

The System Stats Browser view is displayed.
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RSA| RESPOND  INVESTIGATE MONITOR CONFIGURE  ADMIN @ admin
nt So Endpt
Alarms  Monitoring  Policies  [SEOUISEISIIGHTRSY  Event Source Monitoring  Settings
Host Companent Caregory Statistic Order By
Any v Ay v Any ~ I cear 2 w
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Host Companent category staustc subem value Last Update Historical Graph ot
I
conc Host Filesystem Error Status 0 2019.03-08 10:46258.. ol =
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Displays System Stats Browser View
Toolbar used to filter and customize the System Stats Browser View

Note: Historical graphs are enabled, and can be displayed, for statistics with numeric values.
However, historical graphs are disabled for statistics with string values, for example, Health
checks (Healthy), and are displayed as gray in the UI.

Filters

This table lists the various parameters you can use to filter and customize the System Stats view.

Parameter | Description

Host Select a host from the drop-down menu to display the stats of the selected host.
Select Any to list all the available hosts.

Component  Select a component from the drop-down menu to display the stats for the selected
component.
Select Any to list out all the components on a selected host.

Category Type the category to display the stats for the required category.
Select Regex to enable Regex filter. It performs a regular expression search
against text and lists out the specified category. If Regex is not selected it
supports globbing pattern matching.
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Statistic Type the statistic to display the required statistic on all the hosts or components.
Select Regex to enable Regex filter. This performs a regular expression search
against text and lists out the specified category. If Regex is not selected it
supports globbing pattern matching.

Order By Select the order in which the list needs to be filtered.
Select Ascending to filter the list it in an ascending order.

Commands
Apply Click to apply the filters chosen and display the list accordingly.
Clear Click to clear the chosen filters.

System Stats View Display

Displays statistics, service system information, and host system information for a host or service.
Access Stats Details

Select one of the stats and click Stats Details on the right hand side of the panel.

The Stats details panel opens with details of the selected stats.
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Stat Details
Hostname
Component ID
Component
Name

Subitem

Path

Plugin

Plugin Instance
Type

Type Instance

Description
Category

Last Updated Time
Walue

Raw Value

Graph Data Key

stat_collector_version

Multi Value

111Conc
messagebus
MessageBus

Mode sockets Used

rabbit@b&19194b-6ba2-4508-95c4-42b33df02eed

messagebus_localhost

ZauUge
rabbit@b&19194b-5ha2-4508-2504-
Aap53dfi2eed _sockets_used

Mumber sockets used by this meszage broker.

MessageBus

2015-02-01 07:31:55 PM
B

8.0

b519194b-6ba2-4508-%5c4d-
4ap53df02eed/meszagebus_localhost/zauge-
rabbit@hb61%19%4b-6ba2-4508-55c4-
4ehs53df0Zeed_sockets_used

b519194b-6ba2-4508-95c4-
deh33df0Zeed/meszagebus_localhost/gauge-
rabbit@bs19194b-6ba2-4508-85c4-
4eh53df02eed_sockets_used

11.3.0.0

false
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System View - System Info Panel

This topic describes the System Information panel, which displays information about the system
version and license status.

The required role to access this view is Manage System Settings.
To access this view, do one of the following:
¢ Goto ADMIN > System.

The System Information panel is displayed by default.

o When you receive a notification that a new version of NetWitness Platform is available in the
Notifications tray, click View.

RSA RESPOND  INVESTIGATE MONITOR  CONFIGURE  ADMIN @ admin

Hosts Services Event Sources Endpoint Sources  Health S8 /s Security

| nfo o - .

Jersion Information
Updates
Licensing

Email

Global Netifications
Legacy Notifications
System Logging
Global Auditing
Jobs

Live Services

URL Integration
Context Menu Actions
Investigation

ESA Analytics

Cloud Gateway
Whois

HTTP Proxy Settings

NTP Settings

RS /\ NETWITNESS' PLATFORM 11300

The Version Information section displays version information about the version of NetWitness
Platform that is currently installed. The following table describes the features of the Version
Information section.
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e

Displays the version of NetWitness Platform that is currently running. The format of the
version is major-relase.minor-release.stability-id. build-number. Possible values for the
stability-id are:

¢ 1 - Development

Current

Version ° 2 - Alpha
¢ 3-Beta
e 4-RC
° 5 - GOld

Current  Identifies the current build revision for use in troubleshooting situations.
Build

Each client host is shipped with the Local Licensing Server (LLS) installed to manage
host licenses. This field indicates whether the LLS is installed for this instance of

ILAOEES NetWitness Platform.
Server
ID o When the LLS is installed, the Licensing Server ID is displayed.
o Unknown indicates that the LLS is not installed.
Indicates whether or not the license is enabled. If the license is:
) « Enabled, Enabled is displayed in this field and there is a Disable button to the right
é:;;?e so you can disable it.

« Disabled, Disabled is displayed in this field and there is an Enable button to the
right so you can enable it.
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System Updates Panel - Settings Tab

System Updates Settings tab describes the interface you use to set up a connection to Live Update
Repository. These settings ensure that the NetWitness Platform can reach the Live Update
Repository and synchronize it with your Local Update Repository.

The required permission to access this view is Apply System Updates.
To access this view:

1. Goto ADMIN > System.
2. Select Updates.

What do you want to do?

Administrator Automatically download  Enable automatic synchronization with the RSA
updates update repository.

Related Topics

Manage NetWitness Platform Updates

Quick Look

The System Updates Settings panel is displayed.

Info

System Updates Settings

I Updates t H Configure Live account (required) l E

Configure proxy settings

Licensing
[ Automatically download information about new updates every day
Email
Appl
Global Notifications
Legacy Notifications

System Logging

T ] e

Displays System Update Setting Tab
Configure Account and Setting for Automatic Updates

Features

This table describes the features in the System Updates Settings panel.
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Fowrs ool

Configure Live account Displays the ADMIN > System > Live Services panel in which you
can configure your Live Account credentials if they are not configured.

Configure proxy settings Displays the ADMIN > System > HTTP Proxy Settings panel in
which you can configure an HTTP proxy if it is not configured.

Automatically download Select to enable automatic synchronization with the RSA update
information about new  repository. If there are new updates available, information will
updates every day automatically be displayed in the ADMIN > HOSTS panel.

Apply Applies the settings in this tab.
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System Logging - Settings View

The RSA NetWitness Platform Settings view in the System Logging panel configures the size of the
log files, the number of backup log files maintained, as well as the default logging levels for the
packages within NetWitness Platform. The "Configure Log File Settings" topic in the System
Configuration Guide provides detailed procedures.

To access the Settings tab:
1. Goto ADMIN > System.
2. In the options panel, select System Logging.
The System Logging panel opens to the Realtime tab by default.

3. Click the Settings tab.

What do you want to do?

Administrator Configure the size of See the "Configure Log File Settings" topic in the
the Log files System Configuration Guide

Related Topics

System Logging - Historical Tab

System Logging - Realtime Tab
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Quick Look
RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN
H
Info
System Logging
Updates Resltme | Historical | Settings <—n
Licensiny - .
& Log Seftings
Email
Max Log Size 4194304
Global Netifications Max # Backup Files o ¢ n
Legacy Notifications [ Show Errer Stack Trace
System Loggin, q—n
Is g Apply

Global Auditing

b - -
L= Package Configuration
Live Services X
Audic -
URL Integration Cesm
Context Menu Actions i Connection
Investigation i Datadceess
E5A Analytics B
[ freemarker
Cloud Gateway
@0 javax
Whois [
HTTP Proxy Settings alerg
NTP Settings Security
i SystemOperation -
Package
Log Level -
[0 Reset recursively

RS\ NETWITNESS' PLATFORM 11.3.00

Displays System Logging Panel
Displays Settings Tab
Configure Log Settings
Configure Packages

Features

The Settings tab has two sections: Log Settings and Package Configuration.

Log Settings

The Log Settings section configures the size of the NetWitness Platform log files and the number of
backup logs that NetWitness Platform maintains.

Description

Max Log Configures the maximum size in bytes of each log file. The minimum value for this
Size setting is 4096,

Max # Specifies how many backup log files are maintained. The minimum value for this
Backup  setting is 0. When the maximum number of log files is attained, and a new backup file
Files is made, the oldest backup is discarded.
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Fors [Desrpion

Displays ERROR, STACK, and TRACE log messages.

Show
Error
Stack
Trace

Apply Puts the settings into effect immediately for all future logs.

Package Configuration

The Package Configuration section shows the NetWitness Platform packages in a tree structure.

o fproien

Package Contains all the packages used within NetWitness Platform. You can drill down into
tree the tree to view the log levels of each package.

The root logging level represents the default log level for all packages that are not
explicitly set. The root level is set to INFO

Package The name of the selected package when you select a package in the Package tree.

field

Log Level If the selected package has a log level explicitly set, the value is displayed in the Log
Level field.

Reset  Resets the log recursively.

recursively

Apply Puts settings into effect immediately for all future logs.

Reset Resets the selected package to the log level of root,
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System Logging - Realtime Tab
This topic describes the features of the System Logging > Realtime tab and the Services Logs view
> Realtime tab.

The Realtime tab is a view of the NetWitness Platform log or a service log. When it is initially
loaded, the view contains the last 10 log entries. As new entries become available, the view is
updated with those entries.

To access the Realtime tab:
1. Goto ADMIN > System.

2. In the options panel, select System Logging.
The System Logging panel opens to the Realtime tab by default.

What do you want to do?

Administrator See details of Log entry Display System and Service Logs

Related Topics

System Logging - Settings View

System Logging - Historical Tab
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Quick Look

The following is an example of the Realtime tab in the System Logging panel.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Hosts s Event Sources Endpoint Sources  Health & Wellness  System  Security
i System Logging
Updates
care H—PR% time | Historical | Settings
Licensing
ALL v ke Search
Email
Timestamp Level Message
Glovaliietications 2019-03-06T23:05:29.124 ERROR  Connect to cms.nepwisness.com:443 [ems.netwiiness.com/s 76.196] failed: connect timed out org apache.htxp.conn.ConnectTimeoutException: ConNect to cmsnetwitness.com:443 [cms.netw.
Legacy Notifications 201 NFO  CMIS authent failure for admin - org.apache. nn.ConnectTimeoutException: CONNECT [0 CMS.NeTWitNess.com:443 [cms. netwitn /522241761 connect timed out

| system Logging 4—“

NFOD Failed to get of ressurces: CMS authentication failure for

imin - org.apache htep.conn ConnectTimeoutException: CONNECt to s, netwitnes:

N lems ansport client RequestTimeos
Global Auditing B

WARN etrieving W slemen: i.sransport client RequestTimeo:
Jobs

WARN 25 ot recely jate, resexting broker
Live Services WARN  Host has not received update, resetting archiver

URL Integration WARN  Conversion to List failed a:

nection to ContextHUD was not establisned

WARN  Host has not receivec

Context Menu Actions ipdste, resetting broker

WARN  Host has not receives

pdate, reseriing archiver
T

vestigation

ESA Analytics

Cloud Gateway

HTTP Proxy Settings

NTP Settings
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Displays System Logging Panel
Displays Realtime Tab

The following is an example of the Realtime tab in the Services Logs view, which is similar.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE MIN

@ admin® | @
nt Sourc Endpoint Sources  Health &\

B sa-Broker |

Historical

ALL v || Key

Broker v Search
Leve Message

WARN  User admin nass

WARN  User admin has
Trusted user admin b

User adrmin (s

60) has logged in

r10.4.61.95 with subject name C = US, ST = ¥4, L = Reston, O = RSA, OU = NetWimess, CN

Trusted user admin has been gran

0QP:QPri:0

User sdm 24997, 1 5:46932] has logge

gnoring grou LEGED_CONNECTION_AUTHORITY, Respor

Trusted user escalateduser has been granted QT: 0 5T- 0 GF: QPri: 0

recuzer (s

5022, 10.4.61.95:46932) has logged in

RS /\ NETWITNESS' PLATFORM

233 References




System Maintenance Guide

Features

The Realtime tab has a toolbar with input fields to allow filtering of the entries, and below the
toolbar is a grid containing the log entries.

Toolbar

Fowrs Dsscipton

Log Level drop- Selects the log level for entries to display in the grid. The Log Level drop-

down down shows the available log levels for the system or the service.
ALL . . System logs have seven log levels.
ALL o Service logs have only six log levels because they do not include the
TRAGE TRACE level.
DEEUG
INFO o The default is ALL log entries.
WARN
ERROR
FATAL

Keywords field Specifies a keyword to use when filtering entries. This field is the same for
system and service log filtering.

Service field Specifies the service type to use when filtering service log entries. Possible
(Service Logs  values are the host or the service.
only)

Search button  Click to activate filtering based on the log level, keyword, and service
selections.

Log Grid Columns

Timestamp This is the timestamp for the entry.
Level This is the log level for the message.
Message This is the text of the log entry.
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System Logging - Historical Tab

The Historical tab provides a searchable view of a NetWitness Platform log or a service log in a
paged format. When initially loaded, the grid shows the last page of the log entries for the system or
the system.

To access the Historical tab:
1. Goto ADMIN > System.
2. In the options panel, select System Logging.
The System Logging panel opens to the Realtime tab by default.

3. Click the Historical tab.

What do you want to do?

Administrator View the Historical Graph Historical Graph for System Stats

Related Topics

System Logging - Realtime Tab

System Logging - Settings View
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Quick Look

The following is an example of the Historical tab in the System Logging panel. It shows the
NetWitness Platform logs.

RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Event Sources  Endpoint Sources  Health & Wellne:

nfo tem Logging
Updates

Realtime | Historical | Settings
Licensing

End Date Bl |ALL d Search ™ Export

ail
. Level | Message

Global Notifications

WARN configuration elements com.rsa.asoc.launch.api transport client RequestTimeoutt erver.any -
WARN ate, resetiing braker
WARN pdate, resetting archiver
WARN Anection t ContextHub was not established
WARN ate, resetting broker
WARN ate, resetting arch
WARN  Hosthas ate, reseniing braker
URL Integration
WARN  Host has not received update, resetting archiver
Context Menu Actions NFO  Pushing hitp config to sms is already done for the 2019-03-06]
nvastization NFO  Pushing ive config to sms s alread for the day. [Last Updated Date : 2015-03.06 ]

figuration changed by admin

ESA Analytics

_ figuration changed by admin
Cloud Gateway

figuration changed by admin

Whois

2015-03-0 56003 received error: Parameter username: Value cannat be empty, uuid

HTTP Proxy Settings 201905

recei

ate, resetting broker

NTP Settings

03

Host nas

received updats, resetting archiver

2019-03-

Failed to rewieve authentication entry

a.util concurrent Reject omman SharedThreadPas

cutionExceptio M rsa nETWITNess Carios.

onfiguration changed by admin

figuration changed by admin

« ( | Page 200 of200 |
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Displays System Logging Tab
Displays Historical Tab

The following is an example of the Historical tab in the Services Logs view. It shows the services
logs.

RSA RESPOND  INVESTIGATE MONITOR  CONFIGURE DMIN () admin ©

Hos Services ent Source: Endpoint Sources  Health & Wellness

% Change Servi logdec-Log Collector | Logs

System Logging

Realtime Historical

Log Collector ¥ | Search ™ Export

Timestamp

<0.31796.50% (10.4.61

5:41345 > 10. Ge7enT

ystem B

ping command, & reply of 51 byte:

HFO on <0.31514.50> (10461 GeTe0T
NFG crion <0.31822.50» (10461

NFO connection 50.31848.50> (10.4.61

NFO on €0.31865.50> (104567

NFO on <0.31506

NFO nnection <0.31892.50> (10461

i & ping command, & reply of 51 by

NFO on 40.31922.50> (104,61
NFO on €0.31932.50> (104,61
NFO 20.31943.50> (10.4.61

50838) has Iogged in

NFO on <0.31579.50> (104619535140 - 1

71): user 'S

5,10.4.61.

NFO

NFO

« ¢ | Page 200

200 | 1c Displaying 9851 - 10000 of 10000
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Features

The Historical tab has a toolbar with input fields to allow filtering of the entries, a grid containing
the log entries, and paging tools.

Fowrs [pescrpton

Start Date The Start Date and End Date range search options limit the log entries to a point in
and End  time. When used, you must provide both a start and end date. The times are optional.
Date The date range is validated to assure that the end date is not before the start date.

Log Level Selects the log level for entries to display in the grid. The Log Level drop-down
drop- shows the available log levels for the system or the service.

down o System logs have seven log levels.

o Service logs have only six log levels because they do not include the TRACE level.

o The default is ALL log entries.

Specifies a keyword to use when filtering entries. This field is the same for system
and service log filtering.

Service  Specifies the service type to use when filtering service log entries. Possible values
field are the host or the service.

(Service
Logs
only)

Search Click to activate a search based on the start and end date, log level, keyword, and
button service selections.

Export  Click to export the currently viewed grid entries to a text file. You can select either
comma-separated or tab-separated format for the entries in the file.

Timestamp This is the timestamp for the entry.
Level This is the log level for the message.
Message This is the text of the log entry.

The paging tools below the grid provide a way to navigate through the pages of log entries.

| Page 1 of16 | » I C
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Search Log Entries

To search the results shown in the Historical tab:

L.

(Optional) Select a Start Date and End Date. Optionally, select a Start Time and End Time.

2. (Optional) For system and service logs, select a Log Level and a Keyword, or both.
3.
4. Click Search.

(Optional) For service logs, select the Service: host or service.

The view is refreshed with the most recent 10 entries matching your filter. As new matching log
entries become available, the view is updated to show those entries.

Show Details of a Log Entry

Each row of the Historical tab Log grid provides the summary information of a log entry. To view
complete details:

L.

Double-click a log entry.
The Log Message dialog, which contains the Timestamp, Logger Name, Thread, Level and
Message, is displayed.

Log Message

Timestamp 2017-09-27T09:22:02.505
Logger Name Index

Thread

Level INFO

Message Indexes are being initialized

2. When finished viewing, click Close.

Page Through the Entries

To view the different pages of the grid, use the paging controls on the bottom of the grid as follows:

o Use the navigation buttons

o Manually enter the page you want to view, and press ENTER.
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Export

To export the logs in the current view:

Click Export, and select one of the drop-down options, CSV Format or Tab Delimited.

The file is downloaded with a filename that identifies the log type and the field delimiter. For
example, a NetWitness Platform system log exported with comma-separated values is named UAP
log export CSV.txt, and an appliance log exported with tab-separated values is named
APPLIANCE log export TAB.txt.
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